Important Information

Avid recommends that you read all the information in this ReadMe file thoroughly before installing or using any new software release.

⚠️ If you are upgrading to this version of the Interplay software, see “Database Changes for Upgrading to v3.1” on page 20.

Also refer to “Important Information in This ReadMe” on page 14.

Revision History

<table>
<thead>
<tr>
<th>Date Revised</th>
<th>Changes Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 14, 2015</td>
<td>Corrected Media Indexer path: “Stopping and Starting Media Indexer on a MacOS X System” on page 107</td>
</tr>
<tr>
<td>April 10, 2015</td>
<td>Updated Supported Software section to point to the compatibility tables on the Knowledge Base. See “Hardware and Software Requirements” on page 11.</td>
</tr>
<tr>
<td></td>
<td>Revised statement on RAM for SR2500 systems. See “Windows Server 2008 R2 Support” on page 12.</td>
</tr>
<tr>
<td></td>
<td>Removed unclear references to installer Part 1 and Part 2 in “Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster” on page 26.</td>
</tr>
<tr>
<td></td>
<td>Added fixed bug UDevC00182455. See “Fixed in v3.1” on page 63.</td>
</tr>
</tbody>
</table>
Added limitation UDevC00185917. See “Limitations for Version 3.1” on page 78.

Additional documentation:

- “Incorrect Cross Reference for configuring AMA in Interplay Installation Guide” on page 51
- “Interplay Engine Error Codes” on page 56
- “Do Not Use an Existing Property Name as a Custom Property Name” on page 57
- “Interplay Streaming Server Removed from Interplay Server Installer” on page 57
- “Custom Path for Backups” on page 57
- “Login for Deletion” on page 57
- “Deleting Restrictions” on page 58
- “Media Creation Workspace and Avid ISIS Authentication Settings” on page 58
- “Media Services Log Files” on page 58
- “Delivery of Sequences with Effects” on page 59
- “Media Service Engine E-mail Notification” on page 59
- “Exclamation Point on Interplay | Access Folders” on page 59
- “Interplay Move and Rendered Effects” on page 60
- “Mob ID Metadata Property” on page 60

July 31, 2014

- Updated information about Transcode Service to refer to updated Interplay Media Services Setup and User’s Guide. See “Configuring Interplay Transcode as an Application” on page 60.
- “Upgrading from Interplay v2.3 or Earlier” on page 20.
- Additional documentation for XAVC-Intra raster sizes. See “Documentation Changes” on page 49.
- Updated description of Media Indexer web services icons. See “Documentation Changes” on page 49.
Date Revised | Changes Made
--- | ---
July 18, 2014 | This ReadMe applies to the release that replaces the limited release.
  - Information about configuring Interplay Transcode as an application. See “Configuring Interplay Transcode as an Application” on page 60.
  - Limitation for Media Composer Cloud and AMA checkins. See “Limitations for Version 3.1” on page 78
  - Additional documentation:
    - Network Locator for Unlicensed Third-Party Storage
    - Maximum Number of Characters for Clip Names, Folders, and Files
    - Maximum Number of Characters for Custom Properties
    - Online Media Shown as Nearline
    See “Documentation Changes” on page 49.
  - Fixed bugs for Interplay Access. See “Fixed in v3.1” on page 63.


Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Interplay may reproduce this publication for the licensee's own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is supplied as a guide for Avid Interplay. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers' losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2015 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:

APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:

Copyright © 1988–1997 Sam Leffler
Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:

Copyright (c) 1989 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright (c) 1989, 1991 by Jef Poskanzer.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1995, Trinity College Computing Center. Written by David Chappell.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.

Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:

© 2010 Nexidia Inc. All rights reserved, worldwide. Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other trademarks are the property of their respective owners. All Nexidia materials regardless of form, including without limitation, software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the exclusive property of Nexidia Inc. or its licensors. The Nexidia products and services described in these materials may be covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA.
The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
"Install-It" is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code
equivalent of "Install-It," including by reverse assembly or reverse compilation. Ray Sauers Associates, Inc. shall in no event be liable
for any damages resulting from reseller's failure to perform reseller's obligation; or any damages arising from use or operation of
reseller's products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller's products or the
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised,
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
"Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with
respect to its merchantability or its fitness for any particular purpose."

"This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this
software will allow "frame accurate" editing control of applicable videotape recorder decks, videodisc recorders/players and the like."

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source
Code:

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The "Interplay" name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.
This product includes portions of the Alloy Look & Feel software from Incors GmbH.
This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
© DevelopMentor

This product may include the JCIFS library, for which the following notice applies:
JCIFS © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection
with Avid Interplay.

Interplay Production Streaming Server includes Live555, which is covered by the GNU Lesser General Public
License. "Live555 is Copyright (c) 1996-2011, Live Networks, Inc. and is licensed under the terms of the GNU
Lesser General Public License, which is included with this product."

This product includes software developed by Indiana University Extreme! Lab (http://www.extreme.indiana.edu)/

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are "commercial computer software" or
"commercial computer software documentation." In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.
Legal Notices

Trademarks


Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.

Avid Interplay Version 3.1 ReadMe • 0130-07648-10 E • Created 4/14/15 • This document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form.
Contents

Legal Notices .......................................................... 3
Hardware and Software Requirements ............................. 11
  Supported Software .................................................. 11
  Products and OS Versions Not Supported on Interplay v3.1 and Later ....... 11
  Products Not Supported on Interplay v3.0 and Later ......................... 11
  Intel SR2400 Servers Not Supported on Interplay v2.6 and Later ............. 12
  SR2500 Windows 7 64-bit image ..................................... 12
  Windows Server 2008 R2 Support .................................... 12
  Compatibility of ISIS Systems for Interplay Copy .......................... 14
Important Information in This ReadMe ............................. 14
Installer Changes ......................................................... 14
International Character Support .................................... 15
Support for AS3000 Servers .......................................... 16
  Updating System Settings on the Factory Image for Interplay Servers ....... 16
Installing and Configuring Interplay Software ..................... 17
Upgrading Interplay Software ....................................... 18
  Best Practices for Performing an Engine Upgrade ......................... 18
  Updating Intel Drivers on Cluster Systems ............................ 20
  Database Changes for Upgrading to v3.1 ................................ 20
  Database Changes for Upgrading Systems Earlier than v2.3 ................. 21
  Upgrading from Interplay v1.x Releases ................................ 22
  Backing Up the Interplay Engine Database ................................ 22
  Updating the Avid Interplay Engine Software ........................... 26
  Additional Information for Avid ISIS .................................. 35
  Increased Monitoring Capacity for Media Indexer ....................... 35
  Additional Information for Interplay Transfer Upgrades ................. 35
  Additional Information About the Server Execution User ............... 36
Additional Information About Pro Tools .................................................. 37
Support for Symantec Endpoint v12.1 ........................................... 37
    Installing on a Non-Cluster Interplay Engine .......................... 38
    Installing on an Interplay Engine Cluster ............................ 38
    Installing on a Streaming Server ........................................ 39
    Limitations for Symantec v12.1 ........................................... 39
Troubleshooting Firewalls and Avid Interplay ................................. 40
Operating Points for Sony XDCAM HD and XDCAM EX ...................... 41
    Operating Points Qualified for Omneon Servers .................... 44
    Operating Points Qualified for AirSpeed Multi Stream .......... 44
Operating Points Qualified for Interplay Transfer Playback ............. 45
New for Interplay v3.1 ............................................................ 48
New for Interplay v3.0 ............................................................ 48
Documentation Changes ............................................................. 49
    Configuring Interplay Transcode as an Application ............... 60
    Split Database No Longer Recommended ............................... 60
    Log File Location for Interplay Transfer ............................ 61
    Removing the Application Server Role ................................ 62
Fixed in v3.1 ................................................................. 63
Fixed in v3.0.5 ............................................................... 63
Fixed in v3.0 ................................................................. 65
Fixed in v2.7 ................................................................. 65
Fixed in v2.6 ................................................................. 66
Fixed in v2.5 ................................................................. 66
Fixed in v2.4 ................................................................. 67
    Fixed in Media Indexer v2.4 .......................................... 67
Fixed in v2.3 ................................................................. 67
Media Indexer Fixes .............................................................. 69
Fixed in v2.2.1 ............................................................... 69
Fixed in v2.2 ................................................................. 72
    Media Indexer Fixes ................................................... 74
Fixed in v2.1 ................................................................. 76
Fixed in v2.0.1 ............................................................... 77
<table>
<thead>
<tr>
<th>Limitations</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limitations for Version 3.1</td>
<td>78</td>
</tr>
<tr>
<td>Using Interplay Copy with ISIS v4.5</td>
<td>80</td>
</tr>
<tr>
<td>Limitations for Version 3.0.5</td>
<td>80</td>
</tr>
<tr>
<td>Limitations for Version 3.0</td>
<td>82</td>
</tr>
<tr>
<td>Limitations for Version 2.7</td>
<td>86</td>
</tr>
<tr>
<td>Macintosh Editors</td>
<td>90</td>
</tr>
<tr>
<td>Limitations for Version 2.6</td>
<td>90</td>
</tr>
<tr>
<td>Limitations for Version 2.5</td>
<td>94</td>
</tr>
<tr>
<td>Limitations for 24p Proxy Resolutions (Version 2.5 and Later)</td>
<td>96</td>
</tr>
<tr>
<td>Limitations for Version 2.4</td>
<td>96</td>
</tr>
<tr>
<td>Limitations for Version 2.3</td>
<td>99</td>
</tr>
<tr>
<td>AVC-Intra Limitations</td>
<td>101</td>
</tr>
<tr>
<td>Assist and Instinct Hardware Support</td>
<td>101</td>
</tr>
<tr>
<td>Ancillary Data Limitations</td>
<td>101</td>
</tr>
<tr>
<td>ISIS Client Bandwidth for Copy Provider</td>
<td>102</td>
</tr>
<tr>
<td>Recording Across Midnight</td>
<td>102</td>
</tr>
<tr>
<td>Limitations for Interplay v2.2.1</td>
<td>103</td>
</tr>
<tr>
<td>Limitations for Interplay v2.2</td>
<td>104</td>
</tr>
<tr>
<td>Media Indexer Limitations</td>
<td>106</td>
</tr>
<tr>
<td>General v2.2 Limitations</td>
<td>107</td>
</tr>
<tr>
<td>Limitations for Interplay v2.1</td>
<td>110</td>
</tr>
<tr>
<td>Changing the Name of the Stream Server Execution User</td>
<td>112</td>
</tr>
<tr>
<td>Limitations found in Interplay v2.0.1</td>
<td>113</td>
</tr>
<tr>
<td>Limitations Found in Interplay v2.0.</td>
<td>115</td>
</tr>
<tr>
<td>Mount Workspaces for Long GOP STP (Assist and Instinct)</td>
<td>115</td>
</tr>
<tr>
<td>Relinking Offline Media for Precomputes</td>
<td>116</td>
</tr>
<tr>
<td>Interplay Access and Force-Delete Locked Media</td>
<td>116</td>
</tr>
<tr>
<td>Changing Source Information for a Clip in Interplay</td>
<td>116</td>
</tr>
<tr>
<td>Automatic Reservation Limitations</td>
<td>117</td>
</tr>
<tr>
<td>Write Permission in Interplay Applications</td>
<td>118</td>
</tr>
<tr>
<td>Viewing Referenced Assets in Assist</td>
<td>118</td>
</tr>
<tr>
<td>General</td>
<td>119</td>
</tr>
</tbody>
</table>
Hardware and Software Requirements

Supported Software

For a list of software supported with Interplay v3.1 and earlier releases, see the Avid Knowledge Base article “Avid Video Compatibility Charts.”

Avid Editing Application Compatibility with Interplay Releases

The following Knowledge Base articles provide information on compatibility between Interplay releases and editor releases:

- See the Knowledge Base article “Interplay and Avid Editor Compatibility.” The document is included on the same Knowledge Base page as all other Interplay V3.0 documentation.
- For details on the operating system (PC and Mac), QuickTime version, and nVidia drivers supported on the different editor releases, see the Avid editing application Readme and the Knowledge Base article “Avid Media Composer Documentation and Version Matrix.”

Products and OS Versions Not Supported on Interplay v3.1 and Later

The following product and operating systems are not supported on Interplay v3.1 and later:

- CaptureManager (use Interplay Capture)
- Windows Server 2003 (see “Windows Server 2008 R2 Support” on page 12)

Products Not Supported on Interplay v3.0 and Later

Interplay v2.7.5 was the final Interplay release that supports the following products:

- 32-bit Media Indexer (64-bit Media Indexer is supported)
- Avid Unity MediaNetwork
- AirSpeed Classic
- Interplay Low Res Encoder
- Avid Interplay ProEncode
Intel SR2400 Servers Not Supported on Interplay v2.6 and Later

The final version of Avid Interplay Production that supports the SR2400 platform is v2.5, released in September 2011. Interplay Production was shipped on the SR2400 from Nov 2006 to Sept 2007; this platform was initially replaced by the SR2500 in 2007 and by the AS3000 in March 2011. Due to the limited capabilities of the SR2400, and the accompanying limited performance of Interplay Production when using a SR2400, the decision has been made to no longer support the SR2400 on Interplay Production v2.6 and later releases.

SR2500 Windows 7 64-bit image

Avid supports the SR2500 WIN7 64-bit server image. See your Avid representative for information about obtaining the image.

The following applications are qualified on this image:

- Interplay Transcode v2.5 and later
- Interplay Transfer Engine v2.4.0.1 and later
- STP Encode v2.5 and later
- Media Services Engine v2.7 and later
- Media Services and Transfer Status tool v2.7 and later
- Copy, Move, and Delivery Providers v2.7 and later
- Interplay Auto Media Services v2.7 and later
- Archive and Delivery Receiver Providers v3.0 and later

Avid recommends upgrading from 2GB to 4GB of RAM for this image.

Microsoft WIN7 64-bit License: It is the responsibility of the customer to source the license for the image.

Windows Server 2008 R2 Support

Support on AS3000 Servers

AS3000 server systems support Windows Server 2008 R2. For additional information, see “Support for AS3000 Servers” on page 16.
Support on SR2500 Servers

Recovery images are available that enable SR2500 servers to support applications that were previously supported on Windows Server 2003. For information on obtaining these images, see your Avid representative. The following Interplay v3.1 server applications and operating systems are supported:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Interplay Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 R2 SP1 Standard 64-bit</td>
<td>Interplay Engine</td>
</tr>
<tr>
<td>part number: 0100-32007-00</td>
<td>Interplay Archive Engine</td>
</tr>
<tr>
<td></td>
<td>Media Indexer</td>
</tr>
<tr>
<td></td>
<td>General Purpose Server (including 64-bit ASF Lookup Service)</td>
</tr>
<tr>
<td></td>
<td>Interplay Capture</td>
</tr>
<tr>
<td></td>
<td>Interplay Stream Server</td>
</tr>
<tr>
<td></td>
<td>Interplay Delivery Service</td>
</tr>
<tr>
<td>Windows Server 2008 R2 SP1 Enterprise 64-bit</td>
<td>Interplay Engine (clustered)</td>
</tr>
<tr>
<td>part number: 0100-32008-00</td>
<td>Interplay Archive Engine (clustered)</td>
</tr>
</tbody>
</table>

Avid recommends up to 16GB on systems running Windows Server 2008. RAM configurations greater than 16GB have not been qualified.

The SR2500 will boot from an image thumb drive only if the latest SR2500 BIOS is installed. This BIOS is labeled S5000.86B.15.00.0101.11092010.

Upgrading an SR2500 Cluster System

For hardware configuration and connections, see Chapter 1 of the Avid Interplay Engine Failover Guide for SR2400 and SR2500 Servers, which is available on the Avid Knowledge Base:


Note the following change:

- Infortrend Gen 1 (A16F-R2221) and the QLogic card are not qualified.

For operating system, cluster, and engine installation, see Chapters 2 and 3 of the Avid Interplay Engine Failover Guide for AS3000 Servers, which is available on the Avid Knowledge Base:

Note the following changes:

- The ATTO configuration utility is no longer installed as part of the image. An installer must obtain this utility.
- The installer should remove the Application Server Role. See “Removing the Application Server Role” on page 62.

Compatibility of ISIS Systems for Interplay Copy

ISIS generally supports one version backward and one version forward when using the Interplay Copy service to copy assets from one workgroup to another. For information on the compatibility between the ISIS Client Manager and the ISIS infrastructure, see the “New in ISIS v.x” section of the Avid ISIS Readme.

ISIS 5000 v4.0 and later supports a 10-Gb connection between the Interplay Copy provider and the Avid ISIS engine.

Important Information in This ReadMe

The following lists some of the important sections of this ReadMe.

- “Installer Changes” on page 14
- “Database Changes for Upgrading to v3.1” on page 20
- “New for Interplay v3.1” on page 48
- “Best Practices for Performing an Engine Upgrade” on page 18
- “Documentation Changes” on page 49
- “Fixed in v3.1” on page 63
- “Limitations” on page 78

Installer Changes

This section covers several changes for the Interplay v3.1 installers.

Interplay Streaming Server Removed from Interplay Server Installer

The Interplay Streaming Server installer is no longer included on the Interplay v3.1 Server Installer. The Streaming Server is still supported on Interplay v3.1 and you can obtain it from the Interplay v3.0 or v3.0.5 Server Installer.
**Items Removed from Interplay Installers**

The following items were removed from the Interplay installers:

- **Removed from Interplay Clients installer**:
  - Avid Interplay Media Services Client Updater for Access
  - Avid Interplay Transfer Client 32 Bit
  - Avid Service Framework Client 32 Bit

- **Removed from Interplay Servers installer**
  - Avid Interplay Adapter
  - Export to Harris
  - Avid Interplay Stream Publish
  - Interplay Streaming Server (see related section above)
  - Avid Interplay Media Services Client Updater for Access

**International Character Support**

Interplay includes international character support (ICS). ICS allows you to display and input characters in languages other than English.

Interplay applications are qualified on an English operating system running locales for the following languages:

- Simplified Chinese and Traditional Chinese
- Japanese
- French, Italian, German, and Spanish

In an Interplay workgroup, all clients and applications must use the same locale, either English or one other locale.

Macintosh systems are not qualified for international character support (ICS) in an Interplay environment.

Multi-byte languages (Simplified Chinese, Traditional Chinese, and Japanese) are not supported by Interplay Media Services, or SGL FlashNet. SGL except as noted below.

FlashNet v6.4.5 and later includes support for Simplified Chinese, which is qualified for use with Interplay Archive and Interplay Restore services V2.6 and later. See also, “International Character Support Limitations” on page 133.
Support for AS3000 Servers

The following table lists the AS3000 configurations that apply to Interplay server applications. All configurations have two processors and 12 GB RAM standard. For information on adding PCIe cards, see the AS3000 Setup Guide. For details on installing Interplay software on an AS3000 see Migrating Avid Applications to AS3000 Servers.

<table>
<thead>
<tr>
<th>Avid Applications</th>
<th>Operating System</th>
<th>Optional PCIe Cards or Optional Kits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Engine cluster, Interplay Archive cluster</td>
<td>Windows Server 2008 R2 SP1 Enterprise</td>
<td>Fibre Channel card: ATTO CTFC-41ES-BR1</td>
</tr>
<tr>
<td>Interplay Engine, Interplay Archive, GPS Lookup Server</td>
<td>Windows Server 2008 R2 SP1 Standard x64</td>
<td>NA</td>
</tr>
<tr>
<td>Interplay Transfer Engine, Interplay Media Services, Interplay Media Services providers: Copy, Move, Transcode, Archive, etc.</td>
<td>Windows 7 Pro SP1 64 Bit</td>
<td>Move and Copy providers: Myricom 10G-PCIE-8B-S 10 Gb Ethernet.</td>
</tr>
<tr>
<td>Interplay Media Indexer (64-bit)</td>
<td>Windows Server 2008 R2 SP1 Standard x64</td>
<td>NA</td>
</tr>
<tr>
<td>Interplay Capture Server, Media Services Enginea Services Server</td>
<td>Windows Server 2008 R2 SP1 Standard x64</td>
<td>Interplay Capture: Timecode w RCA Connector Adrienne Electronics PCIe-LTC/RDR.</td>
</tr>
<tr>
<td>Interplay Streaming Server</td>
<td>Windows Server 2008 R2 SP1 Standard x64</td>
<td>Starting at Interplay v2.4 there is no need for an expansion kit for the Stream Server.</td>
</tr>
</tbody>
</table>

a. Media Services Engine is qualified on both Windows 7 Pro 64 and Windows Server 2008 R2 Standard.

Updating System Settings on the Factory Image for Interplay Servers

See Migrating Avid Applications to AS3000 Servers for details on changes that should be made to the factor image on the AS3000 servers for Interplay. The following table lists the changes that must be made to the factory image.
In particular, you must remove the Web Server IIS Role from the Interplay Engine system before installing the Interplay Engine software. The installation will fail if you leave the server role enabled.

### Installing and Configuring Interplay Software

To install the software and begin the configuration of your Interplay environment, use the *Avid Interplay Software Installation and Configuration Guide*.

#### Installing Media Services

(UDevC00185554) If you install any of the following Media Services providers, you must also install Interplay Access v3.1 on the same system:

- Interplay Transcode v3.1
- STP Encode v3.1
- Interplay Consolidate v3.1 (MediaCentral workflows only)

If you do not install Interplay Access, a job will fail with the error message “Fail to check out moniker.”

#### Interplay Transcode Installed as an Application

(UDevC00184927) Interplay Transcode v3.1 has been changed to run as a Windows application, rather than a Windows service. This addresses a problem transcoding AMA media using third-party storage. See “Configuring Interplay Transcode as an Application” on page 60.
Upgrading Interplay Software

To upgrade the software, see the following topics:

- “Best Practices for Performing an Engine Upgrade” on page 18
- “Updating Intel Drivers on Cluster Systems” on page 20
- “Database Changes for Upgrading to v3.1” on page 20
- “Updating the Avid Interplay Engine Software” on page 26
- “Additional Information for Avid ISIS” on page 35
- “Increased Monitoring Capacity for Media Indexer” on page 35
- “Additional Information for Interplay Transfer Upgrades” on page 35

Best Practices for Performing an Engine Upgrade

This section lists a number of procedures that can help ensure a smooth upgrade. These can be particularly useful for sites with Interplay Engine clusters and large databases. In general, it is useful to get a baseline snapshot of the health of the database and of the Interplay Engine before performing the upgrade. This allows you to fix any problems before the upgrade begins. It also provides a record of the state of the system over time. You can use this information for comparison later if any problems develop after the upgrade.

Back Up the Interplay Database

You use the Interplay Administrator to create backups of the database. However, the Administrator does not back up the complete database folder. Before you perform an upgrade, Avid recommends that you create a backup copy of the complete database folder (AvidWG or AvidAM) and the user database folder (_InternalData). See “Backing Up the Interplay Engine Database” on page 22.

Send the Database to Avid Engineering for Testing

Avid recommends that you contact your Avid representative about sending a copy of your Interplay database to Interplay engineering for testing. This testing provides a report that includes the following type of information:

- An estimation about the duration of the database upgrade/migration
- An analysis of other database characteristics like object count
- Tips for the upgrade if there are any caveats

Your Avid representative can provide details on which files should be provided for the test.
Sending the database for testing is recommended for all version but should be considered mandatory for Interplay versions v1.4 and lower.

Examine Log Files Before Performing the Upgrade

In order to analyze the state of the Interplay Engine, you need the relevant log files and the status of the OS/machine hosting the Interplay Engine or Archive Engine. The easiest way to gather these logs is to use the Collect tool. The Collect tool is typically run by Avid support. See your Avid representative for details.

Your Avid representative can examine the Base Analyzer portion of the Collect tool before the upgrade and determine whether you should make any changes before proceeding with the upgrade. Save the output of the Collect tool. Besides providing troubleshooting information, the Collect tool will provide a baseline of system status information that you can refer back to at a later date.

Restart the Interplay Engine Before the Upgrade

While not required, this is a good test of the health of the system. In particular, it is useful to perform a failover of an Interplay cluster system. This can expose any problems with the cluster services. If there are any problems restarting the system, fix the problems before you begin the upgrade.

Deactivate the Interplay Database During the Upgrade

If the release requires a database upgrade, it is important to control the timing of when the database upgrade occurs. If you deactivate the database before upgrading, the database upgrade will occur when you reactivate the database. See “Database Changes for Upgrading to v3.1” on page 20.

For the recommended upgrade procedure, see “Updating the Avid Interplay Engine Software” on page 26.

Check the Logs During a Database Upgrade

The Interplay Engine displays a status bar during a database upgrade/migration. The status bar appears if you perform the recommended steps and deactivate the database before the upgrade. For a more accurate indication of how the upgrade is progressing, you can use an application such as Notepad to periodically view the bottom of the NXNServer.log file in the following folder:

C:\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine_name>
Examine and Archive the Logs After the Upgrade

If you use the Collect tool, examine the Base Analyzer portion after the upgrade. This portion should run successfully without any errors. Archive the output of the tool as a record of the state of the system after the upgrade.

Updating Intel Drivers on Cluster Systems

Do not install or update Intel® NIC drivers on Interplay Engine cluster systems after the cluster setup is complete. Due to the technical aspects of changing resources and devices on a cluster, this can lead to problems with the cluster software and possible data loss. For additional information, see “Additional Information for Avid ISIS” on page 35.

Database Changes for Upgrading to v3.1

Upgrading from any Interplay v2.x release to Interplay v3.x requires a database upgrade. Make sure you back up your database before the upgrade and lock the database when you perform the upgrade as described in “Updating the Avid Interplay Engine Software” on page 26.

Upgrading from Interplay v3.0 or v3.0.5 to v3.1 does not require a database upgrade.

Upgrading from Interplay v2.3 or Earlier

Upgrading from v2.3 (or earlier) to v3.x involves a schema upgrade which can not be reversed. That means that a full backup of the database must be created before upgrading the Interplay Engine.

Once migrated, the database cannot be loaded by earlier versions of the Interplay Engine. If you need to access the database through an earlier version, contact your Avid representative.

For a very large database, the upgrade process can take up to three hours. For systems earlier than v2.3, an additional upgrade occurs that can take additional time.

For releases earlier than v2.3 there are additional steps you must take after the upgrade to delete unused rendered effects. See “Database Changes for Upgrading Systems Earlier than v2.3” on page 21.

Free Disk Space for a Database Upgrade

The database migration requires a significant amount of free disk space on the drive that hosts the _Database folder. You should have twice the amount of free disk space that the _Database folder occupies on disk.

Database Changes for Upgrading Systems Earlier than v2.3

This section includes important information for upgrading a system earlier than Interplay v2.3.

Upgrade to Interplay v2.3 or Higher Before Upgrading to Interplay v3.x

Before you upgrade a system earlier than Interplay v2.3 to Interplay v3.x, you must first upgrade to a version between Interplay v2.3 and v2.7.x, inclusive. Note that only Interplay v2.7.5 and higher installers are available on the Avid download center.

Avid recommends that before you perform an upgrade you contact your Avid representative about sending a copy of your Interplay database to Interplay engineering for testing. Part of the testing results will include an estimate of the time it will take to perform the database upgrade.

Removing Rendered Effects During the Database Upgrade

The upgrade to Interplay v2.3 required a database upgrade. So if you are upgrading a system earlier than v2.3 to Interplay v3.0, the database upgrade will take effect. The first time you open the database after the upgrade, the Interplay Engine automatically removes links for rendered effects (they are replaced as emulated rendered effects by the client application). No media is deleted.

This process significantly reduces the size of the database. For a very large database, the upgrade process can take up to three hours.

Because the process of removing the links can take a long time, it is important to follow the upgrade procedure described in “Upgrading Interplay Software” on page 18. If you follow the procedure, the database change occurs while you are logged into the Interplay Administrator. During the process, the Interplay Administrator displays a progress bar. Messages are also displayed in the Interplay Engine log file, nxnservletlog. You can periodically open the log file with Notepad to monitor the progress.

During the database upgrade, the Interplay Engine also determines if there are rendered effects that are not currently in use and moves these rendered effects to one or more subfolders in the Orphan Clips folder. An administrator or media manager can then delete these assets and their media. For more information about options for deleting, see “Deleting Unused Rendered Effects After an Upgrade” on page 33.
Upgrading from Interplay v1.x Releases

Before you upgrade to Interplay v3.x you must first upgrade to a version between Interplay v2.3 and v2.7.x, inclusive. See “Database Changes for Upgrading Systems Earlier than v2.3” on page 21.

Upgrading from Interplay v1.1.4 Though v1.1.6

The Interplay v1.1.6 ReadMe instructions for a cluster upgrade required that you create or modify a registry key value during the upgrade to prevent the Interplay Engine from failing over while the system was updating the database. This step is no longer required. You should check whether the registry key exists on both nodes and delete it.

To delete the registry key value:
1. Open regedit on the active node.
2. Delete the following registry key.
   HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\Workgroup\Avid Workgroup Resource DLL
3. Perform the same operation on the non-active node.

   The deletion is effective immediately and does not require a restart.

Backing Up the Interplay Engine Database

You use the Interplay Administrator to create backups of the database (see the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide). However, the Administrator does not back up the complete database folder. Before you perform an upgrade, use the following procedures to create a backup copy of the complete database folder (AvidWG or AvidAM) and the user database folder (_InternalData).

Before you create a backup copy, determine the location of the database folder and whether the database was split between the Interplay Engine and a shared storage workspace.

To determine the location of the database folder:
1. On the Interplay Engine, open a Command Prompt and type the following command:
   net share
   All shares on the system are displayed. By default, WG_Database$ (a hidden administrative share) represents the root folder of the database.
   - For a non-cluster system, the root folder is usually D:\Workgroup_Databases.
   - For a cluster system, the root folder is S:\Workgroup_Databases
2. Navigate to the root folder and double-click the AvidWG folder (or AvidAM folder for an Archive Engine).

By default, this folder includes all database folders and files, as shown in the following illustration:

You need to back up the entire AvidWG folder.

If the AvidWG folder includes only the _Database folder, then the Interplay Engine is using a split database.

For some split databases, the Workgroup_Databases folder might incorrectly include all database folders. To verify if the split database is active, open both _PropertyStore folders and check for recent timestamps. The folder on shared storage should show recent activity. For more information about split databases, see “Split Database No Longer Recommended” on page 60.

To determine the location of the second (split) database folder:
- Navigate to the workgroup.xml file and open it in a text editor.

This file is located in the Interplay Engine installation directory, for example,
- C:\Program Files\Avid\Avid Interplay Engine\Data\Apache\Conf\workgroup.xml (non-cluster systems)
- S:\WorkgroupData\Apache\conf\workgroup.xml (cluster systems).

Both database paths should be listed, for example:
- \InterplayServer\WG_Database$
To make a backup copy of the database on a non-cluster system:

1. Open the Interplay Administration tool.
2. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. Click Lock Database.
3. Click Menu and click Manage Databases.
4. Select the AvidWG database and click Deactivate. Select AvidAM for an Archive Engine.
5. Click Menu and click the Restart Server view.
6. Click Restart Server and close the Interplay Administration tool.
7. Use a backup tool and close the Interplay Administration tool.

Interplay Engine or Interplay Archive Engine

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (Interplay Engine database)</td>
<td>D:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidAM (Archive Engine database)</td>
<td>D:\Workgroup_Databases\AvidAM</td>
</tr>
<tr>
<td>_InternalData (user database if engine is Central Configuration Server)</td>
<td>D:\Workgroup_Databases_InternalData</td>
</tr>
</tbody>
</table>

Interplay Engine (Split Database)

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (_Database folder only)</td>
<td>D:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidWG (all other database folders)</td>
<td>\UnityServer\WorkspaceName\AvidWG</td>
</tr>
<tr>
<td>_InternalData (user database if engine is Central Configuration Server)</td>
<td>D:\Workgroup_Databases_InternalData</td>
</tr>
</tbody>
</table>
Use a backup tool that can handle long path names (longer than 255 characters). For example, perform a backup with Robocopy (from the Microsoft Windows Resource Kit) or use a tool such as 7-ZIP (free download) to zip the folder.

Depending on the size of your database, this kind of backup can take a long time. To save time you can temporarily move the _Backups folder from within the AvidWG (or AvidAM) folder, to another location. After you perform the copy you can move the folder back under AvidWG.

**To make a backup copy of the database on a cluster system:**

1. Open the Interplay Administration tool.
2. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. Click Lock Database.
3. Click Menu and click Manage Databases.
4. Select the AvidWG database and click Deactivate. Select AvidAM for an Archive Engine.
5. Close the Interplay Administration tool.
6. Click Start and select Programs > Administrative Tools > Cluster Administrator.
7. Open the Groups folder.
8. Select the Avid Workgroup Server group.
9. Select the Avid Workgroup Engine Monitor resource and take it offline.
10. If you performed the previous step correctly, drive S: should still be accessible within the Windows environment. If it is not available, use the Cluster Administration tool to put drive S: online by clicking on the disk resource within the “Avid Workgroup Server Group” and selecting online.
11. Use a backup tool to make a copy of the following folders and record their location.

**Interplay Engine or Interplay Archive Engine**

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (Interplay Engine database)</td>
<td>S:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidAM (Archive Engine database)</td>
<td>S:\Workgroup_Databases\AvidAM</td>
</tr>
<tr>
<td>_InternalData (user database if engine is a Central Configuration Server)</td>
<td>\S:\Workgroup_Databases_InternalData</td>
</tr>
</tbody>
</table>
Interplay Engine (Split Database)

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (_Database folder only)</td>
<td>S:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidWG (all other database folders)</td>
<td>\UnityEngine\WorkspaceName\AvidWG</td>
</tr>
<tr>
<td>_InternalData (user database if engine is a Central Configuration Server)</td>
<td>S:\Workgroup_Databases_InternalData</td>
</tr>
</tbody>
</table>

- Use a backup tool that can handle long path names (longer than 255 characters). For example, perform a backup with Robocopy (from the Microsoft Windows Resource Kit) or use a tool such as 7-ZIP (free download) to zip the folder.

- Depending on the size of your database, this kind of backup can take a long time. To save time you can temporarily move the _Backups folder from within the AvidWG (or AvidAM) folder, to another location. After you perform the copy you can move the folder back under AvidWG.

12. Before you perform the upgrade, bring all of the resources inside the cluster resource group online. Right-click the resource group and select Bring Online.

   For more information on the Cluster Administration tool, see the Avid Interplay Failover Guide.

**Updating the Avid Interplay Engine Software**

The following topics describe how to update the Interplay Engine and Interplay Archive Engine software:

- “Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster” on page 26
- “Checking the Server Execution User Account on a Cluster System” on page 28
- “Upgrading a Non-Cluster Interplay Engine or Interplay Archive Engine” on page 29
- “Activating the Database” on page 30
- “Verifying the Upgrade” on page 32

**Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster**

The process described here is similar to a rolling update as documented in the Interplay Engine Failover Guide, except that the database is locked and deactivated before you begin.
If the Interplay Engine includes the /3GB switch in the boot.ini file, the Interplay Engine installer displays a message that this switch is obsolete and asks if you want to remove it. Click Yes. If the boot.ini file contains more than one /3GB string in the same boot.ini line, the switch is not removed and you need to edit the boot.ini file by hand. Changes to the Interplay Engine have made use of the /3GB switch obsolete.

To upgrade an Interplay Engine cluster or Interplay Archive Engine Cluster:

1. Verify that you have a valid backup as described in “Back up the Interplay Engine Database” on page 22.

2. If you took the Avid Workgroup Engine Monitor resource offline when you performed a backup, bring all of the resources inside the cluster resource group online. Right-click the resource group and select Bring Online. For more information, see the final steps in “Back up the Interplay Engine Database” on page 22.

3. Check the Server Execution User account. See “Checking the Server Execution User Account on a Cluster System” on page 28. Check the Avid Workgroup TCP COM Bridge service login, the Cluster service login, the Avid Workgroup Engine Monitor service login, and the registry key value that the installer uses. All four values should match.

If you deactivated your database when backing it up in Step 1, proceed to Step 7.

4. Open the Interplay Administrator tool on the Active node.

5. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. Click Lock Database.

6. Use the following steps to deactivate the database:
   a. Click Menu in the Interplay Administration tool and click Manage Databases.
   b. Select the AvidWG database and click Deactivate. For an archive database, select AvidAM.

7. Use the Interplay v3.1 Server Installer to update the Interplay Engine or Interplay Archive Engine software. Use the following procedure:
   a. Determine which is the active node (first node).
   b. Use the following procedure to move all resource groups to the active node:
      In the Cluster Administrator, open the Groups folder and check the owner column for the following groups: Avid Workgroup Server group, Cluster group, and the MSDTC group. If they are not on the active node, right-click the group entries under the Groups folder and select Move Group for each entry.
c. Run the Interplay Installer on the non-active node (second node). Select the Custom install option. Select the defaults but make sure you supply the correct Server Execution User values when prompted. See “Checking the Server Execution User Account on a Cluster System” on page 28. Restart as requested and continue with the installation. The installer will ask you to restart again after the installation is completed.

d. Perform the installation on the first node while it is online. Use the Custom install option and specify the correct Server Execution User when prompted.

e. During the installation, the installer displays a dialog box that asks you to move the Avid Workgroup Server group to the second node. Move the group, then click OK in the installation dialog box to continue. Restart as requested and continue with the installation. The installer will ask you to restart again after the installation is completed.

f. After you move the group, bring the Interplay Engine online by right-clicking the “Avid Workgroup Server” group and selecting “Bring Online.”

    After completing the previous steps, both nodes in the cluster are updated to the new software version.

8. After you update both nodes, follow the procedure in “Activating the Database” on page 30.

Checking the Server Execution User Account on a Cluster System

The Server Execution User is a Windows operating system user account that is used to run the Interplay Engine process. The account was set up when the Interplay Engine software was initially installed. If the NXNServerUser.exe tool has never been used to change the Server Execution user on your cluster system, you can skip this section. If you aren’t sure whether the account was ever changed, use the procedure in this section to check the values.

If the three values in this section do not match and you accept the default Server Execution User during the upgrade, the cluster will not fail over after you complete the upgrade.

For additional information, see “Additional Information About the Server Execution User” on page 36.

To determine the Server Execution User name on a cluster system:

1. On either node, right-click My Computer and select Manage.
2. Select Configuration > Services.
3. Right-click Avid Workgroup TCP COM Bridge and select Properties.
4. Click the Log On tab.

    The Log On tab contains the name of the Server Execution User (value 1).
5. Right-click Avid Workgroup Engine Monitor, select Properties, and click the Log On tab.
The Log On tab displays the Windows user account that is running the Avid Workgroup Engine Monitor (value 2).

6. Check the following registry key value on each node:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\Workgroup\Avid Workgroup Server
```

Check the ExecutionUser value. The Interplay Engine installer uses this value as the default value for the Server Execution User (value 3).

If all three values match, then either the Server Execution User was never changed at this site or the cluster-aware version of the NXNServerUser.exe tool was used to change the user. In this case you can either use the Typical install option or use the Custom install option and accept the Server Execution user value that the installer displays.

If the account names are different, it means that the Server Execution User has been changed at some point since the original Interplay Engine installation. Use the Custom install option when you upgrade the Interplay Engine software and decide if the displayed user is the name you want to use, or supply a different name and password. Use a regular domain name, such as “MYDOMAIN\ServerUser” and not the fully qualified domain name, such as “MYDOMAIN.com\ServerUser.”

If you don’t know the correct password for the Server Execution User account, use NXNServerUser.exe to change the user and password before you perform the upgrade. See “Changing the Server Execution User in a Clustered Environment” on page 36.

**Upgrading a Non-Cluster Interplay Engine or Interplay Archive Engine**

⚠️ If the Interplay Engine includes the /3GB switch in the boot.ini file, the Interplay Engine installer displays a message that this switch is obsolete and asks if you want to remove it. Click Yes. If the boot.ini file contains more than one /3GB string in the same boot.ini line, the switch is not removed and you need to edit the boot.ini file by hand. Changes to version 2.3 of the Interplay Engine make use of the /3GB switch obsolete.

To update the Avid Interplay Engine software:

1. Verify that you have a valid backup as described in “Backing Up the Interplay Engine Database” on page 22.

If you deactivated your database when backing it up in Step 1, proceed to Step 5.

2. Open the Interplay Administrator tool.

3. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
c. (Option) Type a Lock comment explaining why you are locking the database.

d. Click Lock Database.

4. Use the following steps to deactivate the database:

a. Click Menu in the Interplay Administration tool to see the display of Administration tool views.

b. Click Manage Databases.

c. Select the AvidWG database and click Deactivate. For an archive database, select AvidAM.

5. Use the Interplay v3.0 Server Installer to update the Interplay Engine software. Follow the onscreen instructions. For additional information, see the *Avid Interplay Software Installation and Configuration Guide*.

6. After you update the software, follow the procedure in “Activating the Database” on page 30.

### Activating the Database

After you perform the upgrade, you must activate the database. The Interplay Engine software performs any necessary database updates when you activate the database.

1. Use the Interplay Administrator tool to activate the database and perform the database upgrade as follows:

a. Open the Interplay Administrator tool on the system running the Interplay Engine.

b. Click Manage Databases.

c. Type the following in the “Database (.pro) file to activate” text box.

   \engine_name\WG_Database$\AvidWG\AvidWG.pro
   \engine_name\WG_Database$\AvidAM\AvidAM.pro (for an archive engine)

   For a split database, type:

   \Avid_Unity_server_name\workspace_name\AvidWG\AvidWG.pro

   where *Avid_Unity_server_name* is the File Manager for Avid Unity MediaNetwork or the System Director for Avid Unity ISIS.

> You can also browse to the appropriate .pro file and then click Activate. On a cluster you must browse from the network, not from the mount.

   d. The following example shows the pathname on a system that does not have a split database. The system name is wgb-ab.
e. Make sure the option “Load Database on Activation” is checked.

f. Click Activate.

The upgrade begins. The system displays a dialog box with a progress bar that bounces from side to side while the database is being updated.

---

For an accurate indication of how the database upgrade is progressing, you can use an application such as Notepad to periodically view the bottom of the NXNServer.log file in the following folder:

\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine_name>

---

The system will automatically unlock the database if you have Load Database on Activation selected.

---

g. The database upgrade can take up to several hours, depending on the size and complexity of the database. It is important not to interrupt or stop the Interplay Engine or perform a failover during the upgrade process. This could result in problems with the database. To recover from a failed or interrupted upgrade, you need a valid backup of the old database.

---

2. To verify that you can log onto the database, do the following:

a. Click Menu in the Interplay Administration tool.

b. Click Manage database Roles. The Manage Database Roles view opens.
c. Click the AvidWG icon (AvidAM for archive database).

d. You can tell that you have successfully logged onto the database when the database icon displays a green check mark and the users and roles are displayed as shown in the above illustration.

If you do not deactivate the database before the software upgrade, any automatic database upgrades begin on your first login to the Interplay Engine after you update the software. This occurs the first time you log onto the database with any client (for example, Interplay Access or Interplay Assist). After you type your username and password at the login screen, the system stays at a “Connecting” status while it performs the upgrade. In this case, the system does not display any messages indicating that the upgrade is in progress. Do not exit the application, shut down the system, or fail-over the Interplay Engine while the upgrade is being performed.

Verifying the Upgrade

To verify the upgrade:

1. Navigate to the following location:
   C:\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine name>

2. Open the NXNServer.log file in Notepad.

3. Search for the text “success”. There should be a message similar to the following:

   Database AvidWG has been successfully updated from version xxxxx to yyyyy

   where xxxxx and yyyyy are the old and new releases, respectively. The message could also say “successfully corrected”. Messages such as the following are part of the upgrade process and can be ignored.

   Can't open file 'S:\Workgroup_Databases\AvidWG\_Database\Avidxxx.xxx' for reading
Deleting Unused Rendered Effects After an Upgrade

Starting at Interplay v2.3, the Interplay Engine does not include rendered effects as links in the database. Instead, they are displayed as emulated rendered effects in Interplay Access. For more information, see *What’s New for Interplay v2.3* or the Interplay Help.

The first time you open the Interplay database after an upgrade from a version earlier than v2.3, the Interplay Engine automatically removes links for rendered effects. In a large database, this can take several hours (see “Activating the Database” on page 30). During this process, the engine also determines if there are rendered effects that are not currently in use and moves these rendered effects to one or more subfolders in the Orphan Clips folder. An administrator or media manager can then delete these assets and their media.

Each numbered subfolder contains 2,000 rendered effects each (except for the last subfolder, which can contain less). The resulting folder structure looks like the following:

```
Orphan Clips
  \ Upgrade - Rendered Effects
    \ 001
    \ 002
```

An administrator or media manager has two options for deleting the unused rendered effects:

- Using the standard deletion procedure in Interplay Access.
- Using a Windows command-line tool, which deletes both metadata and media. This tool has two advantages compared to deleting in Interplay Access:
  - Deletion is faster (for example, there are fewer client-server round-trips with the tool and no need to refresh the user interface)
  - You can run the tool as a scheduled task. This is especially useful if there are a large number of unused rendered effects (several thousand or more).

The Windows command-line tool (delete_obsolete_rendered_effects.exe) is located in the following folder:

```
drive:\Program Files\Avid\Avid Interplay Engine\Server
```
The syntax of the tool is described in the following in-line help:

***********************************************************************
delete_obsolete_rendered_effects - Deletes obsolete rendered effects.
delete_obsolete_rendered_effects [user:] [psw:] [maxAssets:] [maxTime:]
This tool automates the deletion of rendered effects (including media) that
were moved to the Orphan Clips folder during the database upgrade from
versions prior to Interplay 2.3.
Options:
user:<user name>   Name of the user to logon to AvidWG with
psw:<password>     Password of the user to logon to AvidWG with
maxAssets:<number> (optional) Maximum number of rendered effects
to delete
maxTime:<minutes>   (optional) Maximum run time in minutes; tool will
stop deletion when this period is exceeded
The maxAssets: and maxTime: options are useful if this tool is run as a
scheduled task, e.g. using Windows Task Scheduler.
***********************************************************************
To run the delete tool:
1. On the Interplay Engine system (or for a cluster system, on the online node), open a
   Windows Command Prompt.
2. Navigate to the location of the tool. For example, type
cd C:\Program Files\Avid\Avid Interplay Engine\Server
3. Type the command line for the tool and press Enter, using the following syntax:
delete_obsolete_rendered_effects [user:] [psw:] [maxAssets:] [maxTime:]
If you want to direct the output of the tool to a file, append the following to the command:
>> output_file.txt
For example, to run the program for one hour and print the output in a file named results.txt,
type the following and press Enter:
delete_obsolete_rendered_effects user:administrator psw:admin
maxTime:60 >>results.txt
If you want to schedule the tool to run at a particular time, use a program such as Windows Task
Scheduler.
Additional Information for Avid ISIS

This section includes important information about Avid ISIS.

NIC Drivers, Upgrades, and Mounting Drives

The following information applies to Avid ISIS:

- Do not install or update Intel NIC drivers on Interplay Engine cluster systems after the cluster setup is complete. Due to the technical aspects of changing resources and devices on a cluster, this can lead to problems with the cluster software and possible data loss.

  The ISIS Readmes recommend that you update the Intel Pro MT/PT drivers on ISIS clients. This statement does not apply to Interplay Engine cluster systems. The Intel drivers on cluster systems do not require updating for this release. Doing so could compromise the integrity of the cluster. In general, do not update the hardware drivers on a cluster system unless instructed to do so by Avid Customer Support.

- The Avid Unity ISIS Setup Guide includes an appendix titled “Avid Unity Upgrade Guidelines”. Refer to that guide before you upgrade to ISIS.

- For information on mounting drives, see the Avid Interplay Software Installation and Configuration guide.

Increased Monitoring Capacity for Media Indexer

Starting at Interplay v3.0, a Media Indexer application running on an AS3000 server with 36 GB of RAM can index up to 10 million data sources. An AS3000 with the standard 12 GB of RAM can index up to 5 million data sources.

The term data source is more accurate than file count. A data source can be defined as follows:

- There is usually one data source per mxf file.
- For multitrack audio, there is one data source per audio track in the audio mxf file.
- For AMA media there is one data source per track.

For information on Media Indexer features, see What’s New for Interplay v3.1, the Interplay Best Practices Guide, or the Interplay Help.

Additional Information for Interplay Transfer Upgrades

Before you upgrade Interplay Transfer to a new release: If your configuration includes playback and ingest through a third-party DHM, you must check with the third-party vendor to determine if an updated DHM is required. Existing third-party DHMs might need to be rebuilt using the latest DHM SDK for compatibility with the latest version of the Interplay Transfer Engine and the Interplay Transfer Client.
Additional Information About the Server Execution User

The Server Execution User is a Windows operating system user account that is used to run the Interplay Engine processes. The Server Execution User is set up the first time that you install the Avid Interplay Engine software and has the following features:

- The account must have local administration rights on the operating system for the Interplay Engine Server (both nodes on a cluster). The Interplay Engine installation software asks you for a user name and password and automatically adds the account to the Administrator Group. Usually this is a domain account that has already been created. The account must have the following local security policy settings:
  - Act as part of the operating system
  - Back up files and directories
  - Restore files and directories
  - Adjust memory quotas for a process
  - Log on as a service
  - Increase scheduling priority

On a cluster system the account must have these permissions on both nodes. The account must be a local Administrator on both nodes.

Ideally this should be an account that human users do not use to log onto the system. This will prevent accidental changes to the Server Execution User user account during normal administration duties. For example, if someone changes the password by mistake, users may not be able to access the Interplay database.

- An account with an identical user name and password must have read/write access to the Avid Unity workspaces that contain media. You use the Avid Unity ISIS or Avid Unity MediaNetwork Administration tool to create this account.

In order to prevent accidental changes to the Server Execution User account during normal administration duties, Avid recommends that you use a dedicated Windows user account such as “Incompensation” as a Server Execution User and cluster service user. This account should not be used for administrative logins to the Interplay engine hardware.

Changing the Server Execution User in a Clustered Environment

To change the Server Execution User account in a clustered environment:

1. Create the domain user and assign the following local security policies for that user on each node of the cluster:
   - Act as part of the operating system
   - Back up files and directories
- Restore files and directories
- Adjust memory quotas for a process
- Log on as a service
- Increase scheduling priority

You can view and set these rights at All Programs > Administrator Tools > Local Security. Click on Local Policies and click on User Rights Assignment. Add the user to each of the above user rights assignments. The user must be a local Admin on both nodes.

2. Make sure that a matching Unity account exists that has read/write access to the Avid Unity workspaces.
3. Shut down the offline node two.
4. Run the NXNServerUser.exe tool on the active node (node one). The tool is located in the following directory on the Avid Interplay Installer:
   Installers\AssetMgr\Tools
   Select Custom, follow the on screen prompts, and restart node one.
5. Shut down node one and start up node two.
6. Run the NXNServerUser.exe tool on node two and then restart node two.
7. Start up node one.

For more information on the NXNServerUser.exe tool, see the *Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide*.

**Additional Information About Pro Tools**

The Pro Tools Plug-Ins for Interplay on the Interplay Client Installer may not be required. For the latest information about using Pro Tools with Interplay, go to the Knowledge Base page titled “Avid Interplay Requirements With Pro Tools.”

**Support for Symantec Endpoint v12.1**

Interplay v2.x supports the Antivirus and Spyware components of Symantec™ Endpoint v12.1 on servers and clients.

Interplay **does not** support the following components:

- Proactive Threat Protection
- Network Threat Protection

When you perform an installation, enable and disable the installation options as shown in the following illustration. An X means that the Symantec installer will not install the component.
The following Knowledge Base article describes how to install and configure Symantec Endpoint v12.1 in an Interplay environment:

*Using Antivirus Software in an Interplay Environment, Support for Symantec Endpoint v12.1*

**Installing on a Non-Cluster Interplay Engine**

On an Interplay Engine you must disable real-time scanning of the following folders:

D:\Workgroup_Databases

This is represented by the hidden administrative share \<Servername>\WG_Database$.

Configure the exclusion folders before Symantec runs the first scan.

**Installing on an Interplay Engine Cluster**

You can install Symantec v12.1 on a cluster. Exclude the following locations from the virus scanning:

- Q:\ (Quorum disk)
- C:\Windows\Cluster
Support for Symantec Endpoint v12.1

- S:\Workgroup_Databases (database)
- R:\ (MSDTC disk)

Use the following guidelines for installing on a cluster:
- Perform the Symantec installation when the node is offline.
- Bring the node online to configure Symantec and identify the exclusion folders as listed above.

⚠️ Configure the exclusion folders on both nodes before Symantec runs the first scan.

Installing on a Streaming Server

If you are installing Symantec on an Interplay Streaming Server v2.4 and later, exclude the folder C:\Program Files (x86)\Avid\Avid Interplay Streaming Server from scanning by virus protection software. Scanning for virus protection could cause disruptions to the Interplay Streaming Server and could cause it to shut down. For additional information on the Streaming Server, see the Interplay Software Installation and Configuration Guide.

Limitations for Symantec v12.1

The following limitations exist for installing Symantec v12.1 in an Interplay environment.

**Upgrading from Symantec 11.x**

There is a known issue with upgrading from Symantec EndPoint v11.x to v12.1. After the upgrade, the “Disable Symantec Endpoint Protection” option is grayed out on the Symantec Endpoint Protection icon in the system tray. Refer to TECH169398 on Symantec’s support web page for additional information.

To avoid this problem, uninstall Symantec v11.x before you install Symantec v12.1. Before you perform the uninstall, open the Symantec application and take note of the exclusion folders. You will need to set up these same exclusion folders after the installation.

**On an Interplay Engine identify the Exclusion folders before the first scan**

On Symantec v12.1, if you fail to exclude the Workgroup_Database folders before the first scan, the scan can create conflicts between Symantec and the Interplay database. The result is that you cannot log into Access or the Interplay Admin tool and the system displays an error message including the text “Class not registered”.

39
If this problem occurs you must reinstall the Interplay Engine software. You can reinstall the Interplay Engine software over the existing installation.

**Installing Symantec on ISIS Clients Running Windows Vista**

If you install the Advanced Download Protection option on a Vista system, you may have to disable “Download Insight” before updating the ISIS client from the ISIS Management Console. Download Insight protects your system against files that are downloaded or executed from web browsers. On a Windows 7 system, Symantec displays a dialog box asking whether you want to allow the ISIS client installer to run. However, on a Vista system, Symantec may simply block the installer.

*This problem does not occur if you run the ISIS Client installer from the ISIS installation kit.*

To solve the problem on a Vista system you can disable Download Insight before installing the ISIS client. Then you can turn it back on after the installation. The option is available via the Change Settings > Virus and Spyware Protection portion of the Symantec interface. See the Symantec documentation for details.

**Troubleshooting Firewalls and Avid Interplay**

Firewalls on client machines interfere with Avid Interplay’s TCP/IP communications.

**Symptoms**

- The list of servers does not appear, for example, when you are connecting to a new database.
- Connection establishment to the server fails.

**Cause**

These problems can be caused by personal firewalls installed on the client machine. A typical example for such a firewall is ZoneAlarm® from ZoneLabs™ or the Windows XP, Windows Vista, or Windows 7 firewall.

These applications intercept all outgoing and incoming network traffic and decide whether to let the traffic go through or block it. The effect is that applications like Avid Interplay fail to connect to their servers.

Typically when the client looks for available Avid Interplay Engines in the network, no servers can be retrieved. When the client is looking for servers, a UDP broadcast is sent out on port 8321.
Solution

Usually these personal firewalls can be configured to allow all network traffic for specific applications. This should be done for Avid Interplay locally or for Internet access depending on which servers Avid Interplay should connect to.

For information about ports used by Avid Interplay, see “Avid Interplay Port Usage” in the Interplay Help and the Interplay Software Installation and Configuration Guide.

Operating Points for Sony XDCAM HD and XDCAM EX

The Interplay Best Practices Guide describes the end-to-end workflow for Sony XDCAM HD and Sony XDCAM EX Long GOP material. This section lists the operating points that are supported for this Interplay release.

The supported MPEG-2 operating points are based on the Sony XDCAM and XDCAM EX systems. For the end-to-end workflow, Interplay supports 14 operating points that are the basic rates for broadcast applications. Any additional XDCAM or XDCAM EX resolutions are supported in a standalone editor configuration only.

Interplay supports all 14 operating points. However, not all of the operating points have been qualified on video servers. See “Operating Points Qualified for Omneon Servers” on page 44 and “Operating Points Qualified for AirSpeed Multi Stream” on page 44.
The following table shows all of the operating points supported by Interplay. Audio is as specified in XDCAM HD/XDCAM EX: PCM uncompressed audio sampled at 48 kHz. Bit widths can be either 16 bit and 24 bit. The audio is encoded as monaural tracks (not stereo pairs).

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VB 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VB 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>18</td>
<td>VB 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VB 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VB 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>18</td>
<td>VB 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VB 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VB 4.2.0</td>
<td>XDCAM EX</td>
</tr>
</tbody>
</table>
The following table lists how these operating points are displayed in different applications:

<table>
<thead>
<tr>
<th>Video Format</th>
<th>Frame Rate</th>
<th>Bit Rate</th>
<th>Avid Editing Application Name</th>
<th>AirSpeed Multi Stream Record Template Name (Service Framework)</th>
<th>Interplay Media Services Profile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 1080i</td>
<td>XDCAM-HD 50mbps 1080i 60</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>35</td>
<td>XDCAM HD 35Mbits MXF</td>
<td>XDCAM-HD 35mb 1080i</td>
<td>XDCAM-HD 35 60i</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 1080i</td>
<td>XDCAM-EX 35mbps 1080i 60</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>25</td>
<td>HDV 1080i MXF</td>
<td>HDV 25mb 1080i</td>
<td>HDV 1080i 60</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>18</td>
<td>XDCAM HD 17.5 Mbits MXF</td>
<td>XDCAM-HD 17.5mb 1080i</td>
<td>XDCAM-HD 17.5 60i</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 1080i</td>
<td>XDCAM-HD 50mbps 1080i 50</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>35</td>
<td>XDCAM HD 35Mbits MXF</td>
<td>XDCAM-HD 35mb 1080i</td>
<td>XDCAM-HD 35 50i</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 1080i</td>
<td>XDCAM-EX 35mbps 1080i 50</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>25</td>
<td>HDV 1080i MXF</td>
<td>HDV 25mb 1080i</td>
<td>HDV 1080i 50</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>18</td>
<td>XDCAM HD 17.5Mbits MXF</td>
<td>XDCAM-HD 17.5mb 1080i</td>
<td>XDCAM-HD 17.5 50i</td>
</tr>
<tr>
<td>720p</td>
<td>59.94</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 720p</td>
<td>XDCAM-HD 50mbps 720p 60</td>
</tr>
<tr>
<td>720p</td>
<td>59.94</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 720p</td>
<td>XDCAM-EX 35mbps 720p 50</td>
</tr>
<tr>
<td>720p</td>
<td>50</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 720p</td>
<td>XDCAM-HD 50mbps 720p 50</td>
</tr>
<tr>
<td>720p</td>
<td>50</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 720p</td>
<td>XDCAM-HD 35mbps 720p 50</td>
</tr>
</tbody>
</table>

a. For Avid editing applications, the video format and rate are determined by the project settings.
b. For AirSpeed Multi Stream record templates, the frame rate is determined by the channel configuration.
### Operating Points Qualified for Omneon Servers

The following table lists the operating points qualified for Omneon servers in an Interplay environment.

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
</tbody>
</table>

### Operating Points Qualified for AirSpeed Multi Stream

The following table lists the operating points qualified for AirSpeed Multi Stream in an Interplay environment.

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VB R 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VB R 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>18</td>
<td>VB R 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
</tbody>
</table>
Operating Points Qualified for Interplay Transfer Playback

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VB</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VB</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>18</td>
<td>VB</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR</td>
<td>XDCAM HD Phase III</td>
</tr>
</tbody>
</table>

**Operating Points Qualified for Interplay Transfer Playback**

Due to variations in FTP servers, Avid cannot guarantee that the GENERIC_FTP and OP1A_EXPORT profiles will work with all FTP servers. In addition to specific playback devices, we have also tested with FileZilla and Linux Vsftpd FTP servers.

Note that the GENERIC_FTP_PROFILE and the OP1A_EXPORT_PROFILE expect that the files on the FTP server will have an ".mxf" extension, and that these profiles will not work with servers that don't.

The Grass Valley K2 does not use MXF extensions and the OP1A_EXPORT_K2 profile was created to handle that and other differences with that server. This profile may work with other servers that don't use the extension, but this cannot be guaranteed and it is best to try it first.
The following table lists the operating points qualified for Interplay Transfer Generic FTP playback.

For Interplay v2.5, Avid has not qualified AVC-Intra FTP for any specific video servers. Support is for Generic FTP only.

**Generic_FTP_Profile - DHM Workflows**

<table>
<thead>
<tr>
<th>Format</th>
<th>Ingest</th>
<th>Playback</th>
<th>W</th>
<th>H</th>
<th>Interlaced / Progressive</th>
<th>Frame Rate NTSC/PAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV 25</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>480/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>DV 50</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>480/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>IMX 30</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>486/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>IMX 40</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>486/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>IMX 50</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>486/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>DNxHD 145</td>
<td>Yes</td>
<td>Yes</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
</tr>
<tr>
<td>DNxHD 120</td>
<td>Yes</td>
<td>Yes</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
</tr>
<tr>
<td>DNxHD 444</td>
<td>Yes</td>
<td>Yes</td>
<td>1920</td>
<td>1080</td>
<td>Progressive</td>
<td>23.976, 24, 25, 29.97</td>
</tr>
<tr>
<td>*XDCAM HD Phase III</td>
<td>Yes</td>
<td>No</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>4:2:2 50Mbps CBR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>Yes</td>
<td>Yes</td>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>AVC-Intra 50</td>
<td>Yes</td>
<td>Yes</td>
<td>960</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>Yes</td>
<td>Yes</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>AVC-Intra 100</td>
<td>Yes</td>
<td>Yes</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>*XDCAM HD Phase III</td>
<td>Yes</td>
<td>No</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>4:2:2 50Mbps CBR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*XDCAM HD EX</td>
<td>Yes</td>
<td>No</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>35Mbps VBR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Playback of XDCAM HD formats cannot be performed with GENERIC_FTP_PROFILE.
Avid has qualified the supported XDCAM HD formats with the Omneon Spectrum and Grass Valley K2 servers. OP1A_EXPORT profile was used for Omneon playback, OP1A_EXPORT_K2 was used for K2 playback, and GenericFTP was used for ingest.

Avid has qualified the OP1A_EXPORT profile with the Omneon server and the OP1A_EXPORT_K2 Profile with the Grass Valley K2 server. These profiles may work with other devices that play and record Sony compliant media, but variations have been found and these are the only servers that we can guarantee will work. Deviations from the Sony XDCAM HD specification may result in clips not being recognized as the correct format, longer splicing and encoding times on export, or failure to work.

### OP1A_Export - DET Workflows to Omneon and Other FTP Servers

<table>
<thead>
<tr>
<th>Format</th>
<th>Ingest</th>
<th>Playback</th>
<th>W</th>
<th>H</th>
<th>Interlaced / Progressive</th>
<th>Frame Rate NTSC/PAL</th>
<th>Profile and Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>XDCAM HD Phase III 4:2:2 50Mbps CBR</td>
<td>No</td>
<td>Yes</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
<td>422@HL</td>
</tr>
<tr>
<td>XDCAM HD Phase III 4:2:2 50Mbps CBR</td>
<td>No</td>
<td>Yes</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
<td>422@HL</td>
</tr>
<tr>
<td>XDCAM HD EX 4:2:0 35Mbps VBR</td>
<td>No</td>
<td>Yes</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
<td>MP@ML</td>
</tr>
</tbody>
</table>

The following table lists the K2 media server playback formats available when setting up an FTP Server profile using Server Type: OP1A_EXPORT_K2. For information about working with a K2 server, see the document *Working with a Thompson Grass Valley K2 Media Server*.

### OP1A_Export_K2 - DET Workflows to Grass Valley K2

<table>
<thead>
<tr>
<th>Format</th>
<th>Ingest</th>
<th>Playback</th>
<th>W</th>
<th>H</th>
<th>Interlaced / Progressive</th>
<th>Frame Rate NTSC/PAL</th>
<th>Profile and Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>XDCAM HD Phase III 4:2:2 50Mbps CBR</td>
<td>Yes</td>
<td>Yes</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
<td>422@HL</td>
</tr>
<tr>
<td>XDCAM HD Phase III 4:2:2 50Mbps CBR</td>
<td>Yes</td>
<td>Yes</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
<td>422@HL</td>
</tr>
<tr>
<td>XDCAM HD EX 4:2:0 35Mbps VBR</td>
<td>Yes</td>
<td>Yes</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
<td>MP@ML</td>
</tr>
</tbody>
</table>
New for Interplay v3.1

For information about the new features in Interplay Production version 3.1, see *What’s New for Interplay v3.1* on the Knowledge Base and in the Interplay Help. Note that the information on the Knowledge Base is more up to date than the information in the Help.

New for Interplay v3.0

For information about the new features in Interplay Production version 3.0, see *What’s New for Interplay v3.0* on the Knowledge Base and in the Interplay Help.

---

**Supported Formats for Sony XDCAM Profile - used only with Sony XDCAM Decks**

<table>
<thead>
<tr>
<th>Format</th>
<th>Ingest</th>
<th>Playback</th>
<th>W</th>
<th>H NTSC/PAL</th>
<th>Interlaced / Progressive</th>
<th>Frame Rate NTSC/PAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV 25</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>480/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>DV 50</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>480/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>IMX 30</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>486/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>IMX 40</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>486/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>IMX 50</td>
<td>Yes</td>
<td>Yes</td>
<td>720</td>
<td>486/576</td>
<td>Interlaced</td>
<td>29.97, 25</td>
</tr>
<tr>
<td>HD 1080i 17.5 Mbps</td>
<td>Yes</td>
<td>No</td>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>HD 1080i 25 Mbps</td>
<td>Yes</td>
<td>No</td>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>HD 1080i 35 Mbps</td>
<td>Yes</td>
<td>No</td>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>HD 1080p 17.5 Mbps(^a)</td>
<td>Yes</td>
<td>No</td>
<td>1440</td>
<td>1080</td>
<td>Progressive</td>
<td>23.976</td>
</tr>
<tr>
<td>HD 1080p 25 Mbps(^a)</td>
<td>Yes</td>
<td>No</td>
<td>1440</td>
<td>1080</td>
<td>Progressive</td>
<td>23.976</td>
</tr>
<tr>
<td>HD 1080p 35 Mbps(^a)</td>
<td>Yes</td>
<td>No</td>
<td>1440</td>
<td>1080</td>
<td>Progressive</td>
<td>23.976</td>
</tr>
<tr>
<td>XDCAM HD Phase III 4:2:2(^a) 50Mbps CBR</td>
<td>Yes</td>
<td>No</td>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94, 50</td>
</tr>
<tr>
<td>XDCAM HD Phase III 4:2:2(^a) 50Mbps CBR</td>
<td>Yes</td>
<td>No</td>
<td>1280</td>
<td>720</td>
<td>Progressive</td>
<td>59.94, 50</td>
</tr>
</tbody>
</table>

\(^a\) Half height clips (1440x540) are not supported for 1080p formats.
Additional 64-Bit Support

Interplay v3.0 introduces support for 64-bit versions of the following software, on the following servers:

<table>
<thead>
<tr>
<th>Interplay Component</th>
<th>Qualified Server and Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay Engine</td>
<td>AS3000 Dual-Processor 12 GB RAM, running Windows Server 2008 R2 SP1 Standard 64-bit</td>
</tr>
<tr>
<td>Interplay Archive Engine</td>
<td>AS3000 Dual-Processor 12 GB RAM, running Windows Server 2008 R2 SP1 Standard 64-bit</td>
</tr>
<tr>
<td>Interplay Engine Failover Cluster</td>
<td>AS3000 Dual-Processor 12 GB RAM or 36 GB RAM, running Windows Server 2008 R2 SP1 Enterprise 64-bit</td>
</tr>
<tr>
<td>Interplay Archive/Restore</td>
<td>AS3000 Dual-Processor 12 GB RAM, running Windows 7 Professional SP1 64-bit</td>
</tr>
<tr>
<td>Interplay Transfer</td>
<td>AS3000 Dual-Processor 12 GB RAM, running Windows 7 Professional SP1 64-bit</td>
</tr>
<tr>
<td>Interplay Delivery Receiver</td>
<td>AS3000 Dual-Processor 12 GB RAM, running Windows 7 Professional SP1 64-bit</td>
</tr>
</tbody>
</table>

Documentation Changes

This section describes information that will be added to the next revision of the Interplay documentation.

Also see the following sections:

- “Split Database No Longer Recommended” on page 60
- “Configuring Interplay Transcode as an Application” on page 60
- “Log File Location for Interplay Transfer” on page 61
- “Removing the Application Server Role” on page 62

Network Locator for Unlicensed Third-Party Storage

In Interplay Access, the network locator (file path) for an asset that is stored on unlicensed third-party storage is shown by a path that uses the following format:

```
//UNAVAILABLE/nnnn/filename
```
where \textit{nnnn} is a variable four-digit number. The following illustration shows an example of how this path is displayed in the Object Inspector.

\begin{table}[h]
\centering
\begin{tabular}{|lllll|}
\hline
\textbf{Object Inspector} & \\ 
\hline
\textbf{Properties} & \textbf{Relatives} & \textbf{Associations} & \textbf{Frame Locators} & \textbf{Restrictions} & \textbf{Categories} & \textbf{Reservations} & \textbf{File Locations} \\
\hline
\hline
\end{tabular}
\end{table}

\textbf{Media Indexer Storage Location Icons}

The icons used for MI storage locations depend on the storage type (ISIS or licensed 3rd party) and whether the storage location is used for AMA or for non-AMA media. ISIS Storage types are further delineated by the ISIS family. For example, ISIS 7500 is defined as Realtime and ISIS 2500 is defined as Nearline.

The following table shows the Media Indexer web interface icons for Interplay v3.1 and later.

\begin{table}[h]
\centering
\begin{tabular}{|lll|}
\hline
\textbf{MI Web Interface icon} & \textbf{Description} & \textbf{Comments} \\
\hline
\text{AMA Realtime Storage} & This includes AMA media stored on ISIS 7500, 7000, 5500, and 5000. \\
\text{AMA Nearline Storage} & This includes AMA media stored on ISIS 2500, ISIS 2000, and licensed 3rd party storage. \\
\text{Realtime Storage, non-AMA} & This includes non-AMA media stored on ISIS 7500, 7000, 5500, and 5000. These locations are actively indexed by Media Indexer. \\
\text{Nearline Storage, non-AMA} & This includes non-AMA material stored on ISIS 2500, ISIS 2000, and licensed 3rd party storage. These locations are actively indexed by Media Indexer. \\
\hline
\end{tabular}
\end{table}
Incorrect Cross Reference for configuring AMA in Interplay Installation Guide

The *Interplay Production Software Installation and Configuration Guide for v3.1* has an unresolved cross reference on page 54. It references a topic “Configuring the Interplay | Media Indexer to Index AMA” but that topic is not in the installation guide. The topic is in the *Interplay Best Practices Guide v3.1*.

Interplay Help and Third Party Storage Licenses

The process for setting up third party (3rd party) storage licenses is described in the Interplay Help. The license you use on the Interplay Administrator is a Key-CI license. The Help incorrectly lists the license as Key-C. Note that the descriptions in the *Interplay Best Practices Guide v3.1* and *What’s New for Interplay v3.1* documents on the Knowledge Base are correct.

Using Interplay Access and Java on Mac OS X Systems

For Interplay v3.0.5 and later, Mac OS X systems running Interplay Access require Java v1.6 on the system level. You cannot use Java v1.7 at the system level. This is because Access is a 32-bit application and Java v1.7 is only available for 64-bit applications. It doesn’t matter which specific version of Java v1.6 is used. For example, Java v1.6.0_29 and Java v1.6.0_51 both work.

You can obtain the latest version of Java v1.6 for your Mac OS X system on the following Apple support page:

http://support.apple.com/kb/DL1572

Install this version before you install Interplay Access.

<table>
<thead>
<tr>
<th>MI Web Interface icon</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI Cannot Access this Folder</td>
<td>Media Indexer cannot access the storage location. For AMA Storage locations, this might not be a serious problem because Media Indexer does not index the AMA media directly. It indexes the related .spaaf files. The X symbol could indicate that the folder was mistyped or that the Storage location is not accessible. It does not necessarily mean that Media Indexer is not granted permission to access the storage.</td>
<td></td>
</tr>
</tbody>
</table>
Using Java on Mac OS X Editing Systems

In Interplay v3.0 and earlier, it was important to use a specific version of Java v1.6 (Java v1.6.0_29) on your Mac OS X editing system. If you had a different version of Java v1.6 on your system, the editor was not able to connect to the Media Indexer server. This was due to a problem with the way that ASF was working with Java versions. This problem has been fixed in ASF v1.7.0 and later. ASF is no longer dependent on a specific Java version. ASF v1.8.0 is available with Interplay v3.1.

Transcode Dongle Includes Support for Multiple Instances

The Media Services Setup and User’s Guide will be updated to state that an Interplay Transcode application key (dongle) includes support for up to four instances of Interplay Transcode on a single system.

SQL Express Version

Microsoft SQL Server 2012 Express is automatically installed with Media Services Engine v3.x. If you are upgrading the Media Services Engine, existing databases are automatically updated.

MediaCentral Distribution Service Installer Available on Interplay Servers Installer

MediaCentral Distribution Service (MCDS) v3.1 is available from the Interplay v3.1 Servers installation media. Open the Installers folder at the top level, open the CentralDistributionService folder, double-click setup.exe and follow the installation instructions. For more information, see the MediaCentral Platform Services Installation and Configuration Guide.

The MCDS coordinates and monitors send-to-playback and mixdown operations for Interplay Central. It determines if there is any preprocessing required. If it determines an audio mixdown is required, it submits a Transcode Mixdown request. If Long GOP media is required, it submits an STP Encode request. You can configure your workgroup for more than one MCDS.

Media Indexer HAG members should reside in the same subnet

If you have more than one Media Indexer in the High Availability Group (HAG), they should reside in the same subnet.

AMA Material and Dynamic Relink

The chapter “Using AMA Material in Interplay” in the Avid Interplay Best Practices states that you need to consolidate AMA material that you transcoded to an Avid resolution before using it in an Avid editing application. Starting with Interplay v3.0.5, this is no longer necessary. You can now use Dynamic Relink without the need to first consolidate the transcoded material.
Interplay Servers in Zone 3

All Interplay Production servers are qualified for use with Zone 3 connections.

Renaming Shared-Storage Workspaces

Renaming a shared-storage workspace after it has been scanned, mounted, and used by Interplay hosts is not supported.

Installing Interplay Transfer Client on Windows 8

Interplay Transfer client and Interplay Transfer Standalone are supported on Windows 8. The Interplay Transfer application requires .Net Framework v3.5. The application is automatically installed on Windows 8 systems but it is not turned on by default. Use the following procedure to turn on .net v3.5:

1. Navigate to Control Panels > Programs > Programs and Features
2. Select the .NET Framework 3.5 as shown in the following illustration.
3. Click OK. Now .NET Framework v3.5 is enabled.
**Upgrading an Interplay Transfer System to Interplay Transfer v3.x**

Interplay Transfer v3.x is a 64-bit application and stores profile information in .xml files. In previous releases the information was stored in registry settings. Interplay Transfer v3.x includes a tool to convert the older profiles to Interplay v3.0 profiles. Use the following procedure:

1. Install Interplay Transfer. It doesn’t matter if you uninstall the v2.7 version first or not. The settings will remain in the registry.

2. Before you start Interplay Transcode, navigate to the following folder:

   C:\Program Files\Avid\Utilities\FTPProfilesTool

3. Execute the tool.

The system stores the FTP profiles in an .xml file. Now you can start Interplay Transcode and use the profiles. The following shows the path to the new profiles file:

C:\ProgramData\Avid\GenericFTP\FtpProfiles.xml

**Media Indexer AMA Media Files and .spaaf Files**

The Interplay documentation incorrectly states that the unique media files in the AMA statistics section on the web UI reflects the .spaaf file count. The AMA statistics section actually reflects the AMA media count. Note that the .spaaf files count against the number of files/data sources that the Media Indexer can monitor. One .spaaf file is created for each track in the AMA media file. For this release the web interface does not display the total number of .spaaf files. Since the .spaaf files are all in one workspace, you can use Windows OS tools to determine the number of .spaaf files that the Media Indexer is monitoring and add that to the number of unique media files in the AMA statistics view. This will give an accurate total of the number of AMA-related data sources being monitored by the Media Indexer.

For a description of .spaaf files, see the *Interplay Best Practices Guide* or *What’s New for Interplay v3.0*. For a description of data sources, see “Increased Monitoring Capacity for Media Indexer” on page 35.

**Partitioning the Drives for a Media Indexer**

When setting up a Media Indexer (MI) server, Avid recommends that you change the partitioning to increase the size of the C drive. This is particularly important if you use the image used for the Interplay Engine. The C drive on that image is small relative to the D drive.

It is important to increase the size of the C drive because the MI uses the C drive for storing log files. The MI can save logs with lots of data, especially when set to finer logging levels for troubleshooting. Increasing the partition size avoids the problem of filling up the C drive.
Application Key (Dongle) Requirements

In the *Avid Interplay Software Installation and Configuration Guide*, the section “Required Application Keys” contains outdated information. An application key (dongle) is required for the following Media Services: Archive, Restore, Transcode, Delivery, Delivery Receiver, Copy, Move, STP Encode.

Also, Avid editing systems now use software licensing rather than hardware application keys.

Multiple ISIS Workgroups

In the *Avid Interplay Software Installation and Configuration Guide*, the section “Understanding Multiple ISIS Workgroups” contains outdated information. Playback of a sequence with clips from multiple ISIS 7000s, multiple ISIS 5000s, or a combination of the two systems is now qualified. Playback of a sequence with clips from an ISIS 2000 and an ISIS 5000 or ISIS 7000 is not qualified. For information on supported resolutions, see the *ISIS Performance and Redistribution Guide*.

This section also states that Interplay Central is not supported in a multiple ISIS workgroup. Interplay Central version 1.5 or later is supported in a multiple ISIS workgroup running Interplay 3.0 or later.

Maximum Number of Characters in Interplay Path

The maximum number of characters you can have in a path on the Interplay Engine is 32,767, based on the Windows operating system limit.

Maximum Number of Characters for Clip Names, Folders, and Files

Avid recommends adhering to a best practice of a 255 character limit for clip names. While it is technically possible for clip names to be longer, folders and files are hard set at this 255 maximum and using it as guideline may be easier to enforce over time across staff or teams.

Maximum Number of Characters for Custom Properties

The Interplay Engine and Interplay Archive Engine Administration Guide lists the maximum number of characters for custom properties as 31. The maximum number of characters is 29.

Online Media Shown as Nearline

Media located on an ISIS 2000 or third-party storage might be shown as online in the Interplay Access Object Inspector and as nearline (yellow circle) in the Assets list.
XAVC-Intra Raster Sizes

The V3.1 Best Practices Guide includes a table listing the supported XAVC-Intra resolutions. Only one raster size was listed. The following table includes the correct raster sizes.

<table>
<thead>
<tr>
<th>Project</th>
<th>Edit Rate</th>
<th>Resolution Name in Interplay Access</th>
<th>Video Bit Rate (Mbit/Sec)</th>
<th>Raster Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>50</td>
<td>XAVC Intra 50 1080i 50</td>
<td>50 Mbit</td>
<td>1440x1080</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XAVC Intra 100 1080i 50</td>
<td>100 Mbit</td>
<td>1920x1080</td>
</tr>
<tr>
<td></td>
<td>59.94</td>
<td>XAVC Intra 50 1080i 60</td>
<td>50 Mbit</td>
<td>1440x1080</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XAVC Intra 100 1080i 60</td>
<td>100 Mbit</td>
<td>1920x1080</td>
</tr>
<tr>
<td>1080p</td>
<td>23.976</td>
<td>XAVC Intra 50 1080p 23.976</td>
<td>50 Mbit</td>
<td>1440x1080</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XAVC Intra 100 1080p 23.976</td>
<td>100 Mbit</td>
<td>1920x1080</td>
</tr>
</tbody>
</table>

Interplay Engine Error Codes

The following error codes will be added to the Interplay | Engine and Interplay | Archive Engine Administration Guide.

<table>
<thead>
<tr>
<th>Code</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>89990179</td>
<td>A backup is already in progress.</td>
</tr>
</tbody>
</table>
**Do Not Use an Existing Property Name as a Custom Property Name**

An Interplay administrator can create custom properties. Do not use an existing system property name when creating a custom property name, which can cause problems when managing properties. System property names are listed in the “System Metadata Properties” appendix in the Interplay | Engine and Interplay | Archive Engine Administration Guide.

**Folders Not Version Controlled in Interplay | Access.**


**Interplay Streaming Server Removed from Interplay Server Installer**

The Interplay Production v3.1 documentation contains several references to installing the Interplay Streaming server. Beginning with Interplay v3.1, the Interplay Streaming Server installer is no longer included on the Interplay Server Installer. The Streaming Server is still supported on Interplay v3.1 and later. You can obtain the installer from the Interplay v3.0 or v3.0.5 Server Installer.

**Custom Path for Backups**

(Interplay Administrator) If you create a custom path for a backup, do not use a final backslash in the path name. Using this backslash can prevent backups from being deleted. For example, enter the following:

```
\My_Server\Interplay\Backups
```

The Interplay | Engine and Interplay | Archive Engine Administration Guide refers to a Browse button for creating a custom backup location. This button is no longer available.

**Login for Deletion**

The “Deletion Guidelines” section of the Interplay | Production Best Practices Guide, the chapter “Developing an Interplay Delete Strategy” includes the following incorrect information:

<table>
<thead>
<tr>
<th>Code</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>89990183</td>
<td>The last partial or full backup time is not available. This message is displayed when an incremental or differential backup was attempted, but could not run because there is no previously created full backup or incremental/differential backup (in case of an incremental backup).</td>
</tr>
</tbody>
</table>
“In order to perform an extended search on a workspace, your Interplay Access login must also have a corresponding login in Avid ISIS. To delete from the workspace, the login must also have delete rights on Avid shared storage.”

An Interplay Access user’s login does not need a corresponding login in Avid ISIS.

**Deleting Restrictions**

A user can view restrictions in Interplay Access, Interplay Assist, Media Composer, and MediaCentral UX, but can create, delete, or modify restrictions only in Interplay Assist and MediaCentral UX. An administrator sets permission to create and modify restrictions in the Interplay Administrator Instinct/Assist User Settings Permission to modify restrictions includes permission to delete restrictions.

**Media Creation Workspace and Avid ISIS Authentication Settings**

The Media Creation Workspace setting (located on the Editing Settings Tab in the Interplay Administrator) lets the Interplay administrator select the ISIS workspace used for media clips created by users. If you list shared-storage servers for Avid ISIS Authentication in the User Authentication view of the Interplay Administrator, the servers that you specify determine which workspaces are displayed.

If the Media Creation setting is grayed out, make sure that the ISIS server names are correctly entered. For more information, see the topic “Setting Avid ISIS Authentication” in the Interplay | Engine and Interplay | Archive Engine Administration Guide.

The setting might also be grayed out if the user logged in to the Interplay Administrator does not have a matching account on the ISIS system.

**Media Services Log Files**

The log file locations listed in the “Troubleshooting Interplay Media Services” chapter in the Interplay | Media Services Setup and User’s Guide are outdated. The correct paths were changed for Interplay Production v3.1. They are listed in the same guide, in the topic “Configuring a Provider for the Media Services Engine” and in the following table:

<table>
<thead>
<tr>
<th>Service</th>
<th>Path for .ini File and Log Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interplay</td>
<td>Archive</td>
</tr>
<tr>
<td>Interplay</td>
<td>Consolidate</td>
</tr>
<tr>
<td>Interplay</td>
<td>Copy</td>
</tr>
<tr>
<td>Interplay</td>
<td>Delivery</td>
</tr>
</tbody>
</table>
Delivery of Sequences with Effects

The topic “Understanding the Delivery Service and Delivery Receiver Service” in the Interplay | Media Services Setup and User’s Guide refers to delivery of cuts-only sequences and shotlists. Interplay Delivery can deliver sequences and their effects without limitation. Partially delivered assets need to be dynamically relinked on the remote editing system after delivery. For more information, see the Interplay Media Services Setup and User’s Guide.

Media Service Engine E-mail Notification

The topic “Configuring the Media Services Engine” in the Interplay | Media Services Setup and User’s Guide describes how to set up the Media Service Engine to send e-mail notifications. The Media Services Engine sends a notice for successful job completion when a Media Composer user selects “Notify me of job completion by email” in the Media Services Settings dialog box and supplies an e-mail address.

If an administrator creates a new user on the User’s Tab of the Media Services and Transfer Status Tool, a dialog box includes a field for an e-mail address. This field is for information only and is not used for Media Services e-mail notification.

Exclamation Point on Interplay | Access Folders

An exclamation point on an Interplay Access folder indicates that the connection has been lost and is reconnecting. If this situation occurs, it usually affects complete DBs. It might affect a folder and a set of subfolders, which could be caused by timing of the reconnection, cache status, or access rights of the logged-in user.
Interplay Move and Rendered Effects

The Interplay Move service does not move media for rendered effects (precomputes). If you attempt to move a folder with only rendered effects, you might receive an error message “Could not find any Avid clip for Move.”

Mob ID Metadata Property

The list of System Metadata Properties in the Interplay / Engine and Interplay / Archive Engine Administration Guide should include Mob ID (media object ID), which was introduced in Interplay Access 3.0.6. This property is not displayed by default; an administrator can enable it in the Property Layout view of the Interplay Administrator.

Configuring Interplay Transcode as an Application

Interplay Transcode v3.1 is installed, configured, and run as a Windows application, in the same way as Interplay Transcode v3.0.x.

⚠️ A Windows service named “Avid Interplay Transcode Service” is installed with Interplay Transcode v3.1. This service is installed with Startup Type as Manual by default and is not currently supported. Do not run this service.

An earlier version of the Interplay Media Services Setup and User’s Guide V3.1 describes how to configure Interplay Transcode as a service. This is not currently supported. The current version of this guide describes how to configure Interplay Transcode as an application. Click the following link to download the guide:

http://resources.avid.com/SupportFiles/attach/InterplayMediaServices_SetupUG_V3_1.pdf

Split Database No Longer Recommended

A split database refers to a configuration in which only the metadata database is stored on the Interplay Engine. All other database files and folders are stored on an Avid shared-storage workspace. The Interplay / Engine and Interplay / Archive Engine Administration Guide describes how to create and manage a split database to allow for a large number of file assets. This configuration is no longer recommended. Storing many small files on ISIS workspaces is an
inefficient use of ISIS storage and can lead to performance problems. Customers with existing split databases can continue to use them but Avid does not recommend creating new split databases.

For information on reuniting a split database, see the Interplay | Engine and Interplay | Archive Engine Administration Guide.

Log File Location for Interplay Transfer

Starting at Interplay v3.0, Interplay Transfer creates a separate background process for each DET, send to playback (STP), and ingest job. These background processes are also referred to as workers or “out of proc” (out of process). See the Interplay Transfer Setup and User Guide for details.

The log files for workgroup to workgroup transfers as well as the usual logging information for the Interplay Transfer Engine are stored in the same log file in the following folder:

C:\ProgramData\Avid\Temp\TMServerLog

A new log file is created each time you restart the Interplay Transfer Engine.

The log files for DET, STP, and ingest jobs are stored in the following folder:

C:\ProgramData\Avid\Temp\TransferEngine\TmWorkerLogs

A separate log file is created for each background process. This means that each time you send a job, a new log file is created.

Log File Naming Conventions

The log files for the DET, STP, and ingest jobs are named as follows:

<file type>-<job type>-<unique identifier>

where:

file type is the tape ID for STP or DET jobs. For ingest jobs, file type represents the clip name from the recording device.
job type is one of the following: TMP = send to playback, TMD = DET, TMI = ingest
unique identifier is a string of characters that gives the log file a unique name
Limiting the Number of Log Files for Background Processes

Because a new log file is created each time you send a DET, STP, or ingest job, there is the potential for a large number of files to accumulate in the TMWorkerLogs folder. In order to control the number of files in the folder, use the “Purge Worker Log Files Older Than” option as shown in the following illustration.

The default value is 1 day which instructs the system to delete the log files every 24 hours. You can adjust the value as needed.

Note that if you turn on debug logging for Interplay Transfer, information is stored for each frame that is processed during the job. Only use the debugging option when instructed by Avid support.

Removing the Application Server Role

This procedure is now recommended when preparing an SR2500 or AS3000 for Windows Server 2008 and an Interplay Engine cluster.

To remove the Application Server role:

1. Click Start > All Programs> Administrative Tools > Server Manager.
2. Click Roles on the left side of the window.
3. Click Remove Roles.
   The Remove Roles dialog box opens. Click Next.
4. Uncheck Application Server.
5. Click Next, then click Remove.
6. Follow the system prompts to remove the role. After you click the Close command, the server restarts and displays a confirmation window that reports the successful removal.

Fixed in v3.1

The following bugs are fixed in Interplay Access v3.1:

➤ **Bug Number:** UDevC00185698. Checking in mixed AMA and “not AMA” assets does not create SPAAF files.

➤ **Bug Number:** UDevC00185718. Check-in does not filter out AMA filemobs with empty or missing network locators.

➤ **Bug Number:** MPI-12615. The head frame of a checked-in clip is from the shortest, transcoded span. and not from the first span.

➤ **Bug Number:** UDevC00182455. Media Services install fails if system is not connected to the Internet. (Microsoft. NET Framework v4 is now installed through the Interplay Media Services installer.)

For information about a change to third-party storage network locators, see “Network Locator for Unlicensed Third-Party Storage” on page 49

Fixed in v3.0.5

**Installing the Interplay Engine on a New Server**

When you installed Interplay Engine v3.0 for the first time on a new server, the following message was displayed four times:

“The program can’t start because mfc100.dll is missing from your computer.”

This bug has been fixed in the Interplay Engine V3.0.5 installer.

➤ **Bug Number:** UDevC00174012. Mac OS X Java version: In Interplay v3.0 and v2.7, it was important to use a specific version of Java v1.6 (Java v1.6.0_29) on your Mac OS X editing system. If you had a different version of Java v1.6 on your system, the editor was not able to connect to the Media Indexer server. This was due to a problem with the way that ASF was working with Java versions. This problem has been fixed in ASF v1.7.0. ASF is no longer dependent on a specific Java version. ASF v1.7.0 is available with Interplay v3.0.5 and Interplay v2.7.5. Also see “Using Interplay Access and Java on Mac OS X Systems” on page 51.
Bug Number: UDevC00180248. Restored OMFI media files were not scanned by Media Indexer. Once the restore was complete and you updated the Media Indexer, the clip was offline. This has been fixed.

Bug Number: UDevC00180379. During some AMA Workflows, the backup Media Indexer in the HAG failed to mirror AMA locations. When this happened, the primary MI stopped accepting new connections. This has been fixed.

Bug Number: UDevC00180172. Registration Files Configuration settings in the Media Indexer Web user interface were reset to default after reinstalling Media Indexer software. This has been fixed.

Bug Number: UDevC00179954. (Media Indexer: When configuring the storage locations for a Media Indexer, if you added a sub folder to the configuration and the parent folder was already indexed, the MI might ignore both folders. This has been fixed.

Bug Number: UDevC00178544. The Remote Mode button has been grayed out on the Media Indexer Configure Storages interface. This button is intended for a future release and could cause problems if selected for a Sphere workflow.

Bug Number: UDevC00172084. (Interplay Archive and FlashNet) For a configuration in which a FlashNet client is directly connected to ISIS shared storage, job status in the Media Services and Transfer Status Tool is consistently accurate. (Fixed in currently supported versions of SGL FlashNet.)

Bug Number: UDevC00180266. (Interplay Access) You can now enable the referenced assets filter (by disabling the Referenced Assets option in the Filter Settings tab) without login problems.

Bug Number: UDevC00173822. (Media Services Engine) If you click the Help button in the Media Services Engine window, only one Help topic is displayed.

Bug Number: UDevC00180238. (Web Services installer) The final screen of the Web Services Installer no longer contains a check box without accompanying text.

Bug Number: UDevC00171474, UDevC00173048. (Avid editing systems) You can now dynamically relink to DNxHD 100 or DNxHD 85 media. (Fixed in v3.0)

Bug Number: UDevC00170276. (Standalone Interplay Transfer and Airspeed Multi Stream) Interplay Transfer includes an option “Allow Ancillary Data Tracks” when creating a profile for Send to Playback. This option is now working correctly. (Fixed in v3.0)
Bug Number: UDevC00170424. (Interplay Transcode) If you send a stereoscopic sequence with more than one track to Interplay Transcode for Full Stereoscopic mixdown, all tracks are displayed in the Avid editing application. (Fixed in v2.7)

### Fixed in v3.0

- **Bug Number:** UDevC00173522. A limitation in Interplay V2.7 required you to configure the Microsoft SQL Server 2005 Express for the Media Services Engine. This configuration is now done by the Media Services installation program, as it was previous to V2.7.
- **Bug Number:** UDevC00168988. (Interplay Access on Macintosh) In Interplay V2.6 and V2.7 you could not install Interplay Access on a Macintosh system if Media Composer was installed first. This has been fixed.
- **Bug Number:** UDevC00176137. Partial restore of a sequence that contained a single track of a master clip caused the rest of the tracks in the same master clip to be fully restored. This has been fixed.
- **Bug Number:** UDevC00171152. Media Indexer v2.6 and higher ignores files or folders for indexation when the path name is longer than 256 Characters on Windows. In earlier releases the Media Indexer crashed when it encountered a long path name. Now it ignores the files.
- **Bug Number:** UDevC00174705. The Profiles tab for Interplay Copy includes a selectable option labeled File Asset, which is now supported.

### Fixed in v2.7

- **Bug Number:** UDevC00170548. (Interplay Access) 16 tracks are available for setting the default local mixing in the Preferences > Options > Audio Settings tab.
- **Bug Number:** UDevC00171686. (Interplay Administrator) Custom backup paths that use the long UNC format (for example, \/?\d:\backup) are now accepted.
- **Bug Number:** none. Media Indexer: The ordering of found media file locations for Media Indexer lookup results are now consistent. The Media Indexer consistently searches for media files according to the order of the storage locations you define in the Configure Storage dialog box.
Bug Number: UDevC00170599. Media Indexer: The Media Indexer web user interface no longer interprets Nearline storage as pulldown and vice versa. Nearline is a term associated with ISIS 2000 systems.

Bug Number: UDevC00170454. (Interplay Access) If you use Interplay Access to copy a folder that contains emulated rendered effects on an Interplay v2.3 or later database, the copying process copies the emulated rendered effects correctly.

Fixed in v2.6

Bug Number: UDevC0016879. Using View > Show Shared/Unshared Clips in Access. The system returned zero results for “show shared clips” in the “Shared/unshared clips in folder” dialog box. The “show unshared clips” option also returned zero results. This has been fixed.

Bug Number: UDevC00164682. (Avid editing systems) You can now send a 1080i 59.94 sequence to playback if it contains a DNxHD 444 1080p clip.

Bug Number: UDevC00165757. QuickTime files that you import in a 720p/23.976 project on an Avid editing system can now link to partially restored media.

Bug Number: UDevC00165498. Interplay Access now supports streaming play of up to 16 tracks of MPEG1 Layer 2 audio.

Bug Number: UDevC00155898. Media Indexer: Previously, when the MIs in the HAG were indexing, changes made to the HAG leader did not apply to the secondary MI until the secondary MI finished indexing. This has been fixed.

Bug Number: UDevC00163256. (Interplay Assist) An Interplay user whose login name uses Simplified Chinese characters can now log in to Media Services in Interplay Assist.

Bug Number: UDevC00163736. If you send a Transcode provider job from a Media Composer, and the profile contains Chinese characters, the job now processes.

Fixed in v2.5

Bug Number: UDevC00164495. The Interplay Engine uninstaller on a failover cluster node now completely removes Interplay Engine services, including the Avid Workgroup Monitor Service.
➤ **Bug Number:** UDevC00163591. The Resync command in Interplay Access now correctly checks orphan media in to the Orphan clips folder as expected.

➤ **Bug Number:** UDevC00158050. (Interplay Engine on Windows Server 2008 R2 systems) When you use the Manage Databases view in the Interplay Administrator to activate a deactivated database, you can now click the Browse button to browse for the .pro file.

### Fixed in v2.4

### Fixed in Media Indexer v2.4

➤ **Bug Number:** UDevC00151863. Media Indexer: Due to a problem in a third party library, all or some communication to and from Media Indexers can become blocked. This can result in media offline for all media on the node. This has been fixed.

➤ **Bug Number:** UDevC00155050. Media Indexer: If a resync occurs while an initial scan is in progress, the Media Indexer may not finish indexing the storage space. This has been fixed.

➤ **Bug Number:** UDevC00154624. Media Indexer: Some folders are not deleted during nightly resync. This has been fixed.

➤ **Bug Number:** UDevC00153191. Media Indexer: Occasionally on startup, Media Indexer stops any indexing activity. The result is that new material does not come online. This has been fixed.

➤ **Bug Number:** UDevC0051869. Media Indexer: MI Client requests such as client lookups may hang temporarily during a Remove Workspace operation. This has been fixed.

➤ **Bug Number:** UDevC00150060. Media Indexer, Interplay Service Configuration tool: The right-hand side pane does not display scroll bars in specific cases. This can be a problem when configuring a Media Indexer from a KVM with a resolution of 1024x768. You cannot access the Configure button at the bottom of the window. This has been fixed.

### Fixed in v2.3

➤ **Bug Number:** UDevC00142012. AVC-Intra resolutions are now supported for send to playback with Generic FTP profile. Note that Avid has not qualified AVC-Intra FTP for any specific videos servers. Support is for Generic FTP only.
Bug Number: UDevC00149596. Interplay Transfer logs into Interplay for each Checkin. This has been fixed.

Bug Number: UDevC00149598. Workgroup-to-workgroup transfer generates duplicate media files. This has been fixed.

Bug Number: UDevC00149677. Interplay Transfer reports false licensing error. This has been fixed.

Bug Number: UDevC00149682. FTP DHM transfers createMXF OP1a files with duplicate Package UIds. This has been fixed.

Bug Number: UDevC00149851. Interplay Transfer quits unexpectedly when performing multiple workgroup-to-workgroup transfers. This has been fixed.

Bug Number: UDevC00149535. Transfer Engine ingest of XDCAM HD does not handle precharge (Origin > 0) in MXF. This has been fixed.

Bug Number: UDevC00149548. Transfer Engine start time code and mark in are incorrect for 720p60 XDCAM HD media. This has been fixed.

Bug Number: UDevC00149626. Transfer Engine cannot ingest non-D10 wrapped IMX from Omneon. This has been fixed.

Bug Number: UDevC00149574. Assist: Video ID does not populate in original sequence while sending to playback. This has been fixed.

Bug Number: UDevC00146890. Audio Popping in Assist when playing back grouped track. This has been fixed.

Bug Number: UDevC00133597. Assist: Runtime Error on launch. This has been fixed.

Bug Number: UDevC00149583. Archive provider: Unable to Archive assets that do not contain a Headframe. This has been fixed.

Bug Number: UDevC00149099. Stream Publish error's on IPV chunked clips. This has been fixed.

Bug Number: UDevC00142655. ICS: If you were working with French characters, and you added text to the Notes and Comments fields in Capture Manager, these comments were not displayed in Interplay Access. This has been fixed.
Bug Number: UDevC00131380. Interplay Administrator: In the Interplay Administrator, if you applied new values to a folder in the Editor Export Settings for Pro Tools or the Pro Tools Import settings, the root folder or another folder on the same level of the database might have shown incorrect values if it was selected afterwards. This has been fixed.

Bug Number: none. Interplay Access: If you drag an Avid asset from Interplay Access to an editor bin, the cursor no longer changes to a “no-entry” icon.

**Media Indexer Fixes**

For additional information, see “Documentation Changes” on page 49.

Bug Number: none. Changed the locking concept of the internal database access. The service is now able to handle multiple read requests in parallel instead of just one reader.


Bug Number: none. Getting file attributes and modification times together with a folder enumeration in one step. This decreases the network traffic and increases overall performance.

Bug Number: none. Add the ability to recover from a stalled ummdworker process. In previous releases, the Media indexer could hang if ummdworker process was blocked. This has been fixed.

Bug Number: UDev144576. Consolidated P2 material was being indexed properly in DS standalone, but showed offline in Interplay Media Indexer. This has been fixed.

Bug Number: none. Improved logging: Log warning message when folders are found with more than 5,500 and 10,000 files. For details on the improved logging and for recommendations on limiting the number of files in a folder, see the Interplay Best Practices Guide.

Bug Number: none. New configuration option added to ignore delete notifications on a global or workspace basis. See the Interplay Best Practices Guide.

**Fixed in v2.2.1**

Bug Number: UDevC00145803. Standalone Interplay Transfer: Users were unable to send to AirSpeed Classic from a Standalone Transfer Engine on a Standalone editor. This has been fixed.
This fix also requires a separate AirSpeed IOPeripherals application installer that contains fixes to the Airspeed IO Apps. The release version for the AirSpeed IOPeripherals installer is v2.7.2. Contact your Avid representative for the location of the IOPeripherals installer.

Note that you must specify port 6535 when defining the Playback Device name in the Interplay Transfer Configuration file. The following illustration shows the correct naming convention `<TMHostname>:6535/<AirSpeed hostname>`.

Note that you cannot use AirSpeed Classic to send to playback with Ancillary data tracks.

➤ **Bug Number:** UDevC00146093. Cannot Restore sequences from archive if they contain Boris effects. This has been fixed.

➤ **Bug Number:** UDEVC00145461. Pro Tools Interplay Option: Version comment fields added during a Checkin to Interplay were not displayed in the Interplay Window. This has been fixed.
Bug Number: no number. At Interplay v2.2 for cluster installations, you had to manually install the Microsoft Runtime C++ Library 2008 as part of the upgrade from Interplay v1.6 or v2.0. This problem is fixed in Interplay v2.2.1.

Bug Number: UDevC00143516. Interplay Engine: Folder property "CumulChildCountUpperBound" not working correctly. This caused some searches to run very slow. This problem is fixed.

Bug Number: UDevC00144173. Interplay Engine: Upgrade from v1.6.4 DB with overlapped objects to v2.1 not possible. In some cases the database upgrade from v1.6 did not work. This problem is fixed.

Bug Number: UDevC00145151. Assist Restrictions: Restrictions disappeared after modifying restriction text. This problem is fixed.

Bug Number: UDevC00145758. AMA Consolidated clips showed as offline in Access after performing Update from Media Indexer. This problem is fixed.

Bug Number: UDevC00146152. Interplay Engine: Some searches did not return correct results. This problem is fixed.

Bug Number: UDevC00142459. Omneon: Performing a Generic FTP Send to Playback with a DNxHD sequence containing Ancillary data to an Omneon Media server fails. The job fails in the editor's Transfer Status window. This has been fixed.

Bug Number: UDevC00141099. When deleting the Data track from a bin, you get an error "deleting shared media". This has been fixed.

Bug Number: UDevC00141602. Shotlists created on Assist do not contain the D track when checked into Interplay and then checked out into an Avid editing application such as NewsCutter. This has been fixed.

Bug Number: UDevC00141737. Editor generated clips containing a D Track fail Workgroup to Workgroup transfers. This has been fixed.

Bug Number: UDevC00139908. Send To Playback (STP): Encode fails to complete jobs containing sequence with D-track masterclips from K2 and Omneon. This has been fixed.

Bug Number: UDevC00141941. Playing back currently ingesting Edit While Capture (EWC) AirSpeed Multi Stream XDCAM 50mbps clips in an editor generates an AncDataPacetCvtr error. This has been fixed.
Bug Number: UDevC00141657. Editor/Restore: Restoring ancillary data tracks: If you restore a D track from Archive and reload the clip in the editor, the data may not be visible until you use the "Reset Offline Info" command or restart the editor. The D track appears online in Access but the Ancillary data does not appear in the decoder on the monitor. This has been fixed.

Bug Number: UDevC00141945. Sequences with Ancillary Data previously sent to playback from an editor to K2 cannot transfer masterclip back to Interplay. This has been fixed.

Bug Number: UDevC00141985. Partial Restores of sequences containing Ancillary Data media, restore without the D-track. This has been fixed.

Bug Number: UDevC00141996. Full Restores of Sequences containing Ancillary Data do not restore the D Track. This has been fixed.

Bug Number: UDevC00141634. Ancillary Data captures with Interplay Capture do not contain Ancillary Data or are offline. This has been fixed.

Bug Number: UDevC00141643. Capture Manager gives checkin failed with Dual Res Ancillary Data captures. This has been fixed.

Bug Number: UDevC00141969. In Assist, sequences and shotlists with Ancillary Data cannot be sent to playback with XDCAM/Long GOP profiles. This has been fixed.

Bug Number: UDevC00142014. 720p60 media ingested from Omneon via TM is corrupt when played in editor. This has been fixed.

Bug Number: UDevC00141922. Sequences consisting of Omneon Ingested media gets Assertion failed: numBytes error when sent to Omneon and AirSpeed Multi Stream. This has been fixed.

Fixed in v2.2

Bug Number: UDevC00135003. (Interplay Access). Previously, under some circumstances, if you use the Media Services Transcode service from Interplay Access, the wrong resolution dot might be displayed when you check in a clip. This has been fixed.

Bug Number: UDevC00137711. In previous releases, if a user ran Interplay Assist or Avid Instinct as an Administrator and later ran the application as a non-Administrator, the Interplay Transfer client could not download an updated send-to-playback device list (Windows Vista and Windows 7 only). This problem resulted occurred because the TMclient.ini file was not writable by a non-Administrator user. This problem has been fixed in the current release.
However, the problem remains if the upgraded Assist or Instinct system still has a TMclient.ini file that is not writable by a non-Administrator user. In this case, the following dialog box is displayed after you log in to Interplay.

![Avid Interplay Assist](image)

You can change the permissions on the file so that the current user has write permission or simply delete the file. The file will be recreated the next time you log in to Interplay.

➤ **Bug Number:** UDevC00139527. Transcode Provider: Mixdown jobs run by the Transcode provider throw "Ampi Subsystem" errors when the Transcode provider is running on the same system as Media Service Engine or other providers. This has been fixed.

➤ **Bug Number:** no number. You can now create AVC-Intra material using Interplay Media Services transcode features.

➤ **Bug Number:** no number. You can now keep Dynamic Relink on while importing AVC-Intra material.

➤ **Bug Number:** UDevC00or , UDevC00139728. Previously, a Macintosh editing system that you disconnected from the network hung when starting, and you needed to run a Console command or script to start it. This has been fixed. Now a message is displayed and asks if you want to run in disconnected mode."

➤ **Bug Number:** UDevC00135147. Previously, the OK and Cancel buttons did not work correctly in the Workgroup Properties view in the Interplay Administrator. These buttons are not needed and have been removed.

➤ **Bug Number:** UDevC00086641. Interplay Assist: Previously Assist/Instinct on launch set a default audio level in the Windows volume control. Now it will not change the level you have already established.
Note: This fix will not work on Windows XP if you are running the application and an Avid editing application on the same machine, unless you select "Use Windows Mixer" in the Avid editing application. Use the following steps:

- Open the Avid editing system.
- In the Settings list, open the Sound Card Configuration settings.
- Select "Use Windows Mixer."

➤ **Bug Number:** UDevC00135003. Previously, if you used the Media Services Transcode service from Interplay Access, the wrong resolution dot might have been displayed when you check in a clip. This has been fixed.

➤ **Bug Number:** UDevC00132253. (Interplay Window, Assist, Instinct) Previously, if a clip was checked in without a name, and the clip was returned as a search result in the Interplay Window, Interplay Assist, or Avid Instinct, the search stopped with an error. This has been fixed.

➤ **Bug Number:** UDevC00134578. Previously, on Macintosh editing systems running Mac OSX 10.6.2 (Snow Leopard), double-clicking the Interplay Access or Interplay Administrator icon in the doc displayed Java error messages. This has been fixed.

### Media Indexer Fixes

The following problems were fixed in Media Indexer v2.1.1 and v2.1.2 and are also incorporated into this release.

➤ **Bug Number:** No number. The following changes are made to Media Indexer:

- Media Indexer now indexes ancillary data files
- Media Indexer now distinguish between "updated" and "new" files found during resync
- Media Indexer now supports extended "bounds" attributes on the DigitalImageDescriptor object

➤ **Bug Number:** UDevC00139146. MI Election tests causing THROWs in diagnostic tools

➤ **Bug Number:** UDevC00143116, UDevC00142835, UDevC00142835. Fixes for deadlock issues, causing media offline.

➤ **Bug Number:** UDevC00142484. Mac: Fixed a problem causing utest crash/hang on Snow Leopard.

➤ **Bug Number:** UDevC00142482. Mac: Multiple instances of MI could run on the MAC; A change was made to prevent this situation.
Bug Number: UDevC00142483. Mac: MI can now be manually started and stopped on Mac.

Bug Number: UDevC00139146. Fixed a problem where Media Indexer flagged new media as NEARLINE (showing yellow dots in Access) when an adapter was moved in the MI configuration or when a backup MI in the HAG copied the configuration of the primary.

Bug Number: UDevC00136961. Fixed a span issue that occurred with some 3rd party MXF audio files coming from tape.

Bug Number: UDevC00117937. Fixed "Unable to find key" errors that could occur on elections MI config changes. The problem caused missing items in the Health Monitor.

Bug Number: UDevC00140781. Fixed a deadlock that could occur in the HealthProducer thread when removing an MI from the HAG.

Bug Number: UDevC00138985. Improved MI logging capabilities to hide useless messages and increase the level of important messages.

Bug Number: UDevC00136806. Implement audit trail for handling of file system operations.

Bug Number: UDevC00136802. Fixed a race condition that could cause file count discrepancies between the Media Indexers in a HAG.

Bug Number: UDevC00137718. Health Monitor could get stuck on the Media Indexer health page in some situations when no workers were running. This has been fixed.

Bug Number: UDevC00136765. Local storage Media Indexer. Previously, if you started a local Media Indexer that contained a HAG entry in its configuration, the MI could get stuck in its initial scanning state. This has been fixed.

Bug Number: UDevC00135821. Added some logging to help find a number of files discrepancy in a HAG.

Bug Number: UDevC00134692. UMMDWorker handshake failures can block all media indexing. This has been fixed.

Bug Number: UDevC00135197. Fix deadlock in MI shutdown.

Bug Number: UDevC00135301. Fixed a problem that caused Media Indexer to spend too much time performing a getFileAttributes() call during scanning. This fix improves MI scanning performance.
Fixes for Discrepancies in File Count Between MIs in the HAG

➤ **Bug Number:** UDevC00138589. Fixed a problem where the MI ignored listFiles I/O exceptions in the scan folder thread (causing file count discrepancy).

➤ **Bug Number:** UDevC00136805. Fixed a race condition between file system and folder monitor scans (serialized scanning). The problem caused file count discrepancy.

➤ **Bug Number:** UDevC00137614. Fixed a race condition between add datasource and commit that caused an inaccurate file count in the Health Monitor.

➤ **Bug Number:** UDevC00139325. Fixed a problem where the Health Monitor media files count was inaccurate when removing storages with duplicate files.

Fixed in v2.1

➤ **Bug Number:** UDevC00111255. If an Interplay Administrator edits a property list for a custom column (by importing a new file in the Custom MetaData tab of the Property Layout view), an Interplay Access user needs to close and restart Interplay Access to view the updated property list. This has been fixed. Press F5 to see the changes immediately.

➤ **Bug Number:** UDevC00113396. In an Interplay environment, if an Avid editor mounts the workspaces using UNC, and you used the Move service to move files from one workspace to another workspace, the Avid editing application’s bin did not show the new location of the moved files. This has been fixed.

➤ **Bug Number:** UDevC00132085. Third party search (also known as Federated search) did not work in Interplay Access. This has been fixed.

➤ **Bug Number:** UDevC00132324. Folder names that are assigned a color in Interplay Access did not display colored text in Interplay Assist, Avid Instinct, or the Interplay Window. This has been fixed.

➤ **Bug Number:** UDevC00132328. Streamable properties are removed from sequences and clips, after performing a Send to Playback to Airspeed Studio. The assets are not streamable and they lose the green triangle indicating that they are streamable. The sequence also shows no masterclip or subclip relatives. This has been fixed.
Bug Number: UDevC00126946. In Interplay Assist, if you create a shotlist, switch to Source mode, load a clip with a different resolution from the current clip, then select Send Shotlist to Playback while you are in Source mode, the operation might fail with the error message "One or more segments are not available in the target resolution." This has been fixed.

Bug Number: UDevC00126315. Selecting Help > Documentation Website on Server does not open the Interplay User Assistance Center. This has been fixed.

Bug Number: UDevC00130269. Setting many locators on a large shotlist can create FileNotFound exceptions in workgroup.log. This has been fixed.

Bug Number: UDevC00130379. Clips that are transcoded to MPEG-4 video and published, but do not include audio, do not play back in the Monitor. A clip might play for a few seconds and then stop. Workaround: If a clip contains audio, transcode and publish both the video and the audio. This has been fixed.

Bug Number: UDevC00131838. If you want to reinstall the same version of the Interplay Stream Server, selecting Repair results in error 1722 and the installation fails. This has been fixed.

Bug Number: UDevC00130133. Performing Update Status from Media Indexer does not update the filemobs. This has been fixed.

Bug Number: UDevC00130670. Performing an AAF Export of non published clip in Access generated a Null Pointer Exception error. This has been fixed.

Bug Number: UDevC00133240. Manager allowed you to duplicate clips in the Archive Manager. This has been fixed. You can no longer duplicate clips in the Archive Manager.

Bug Number: UDevC00121434. 64-Bit Media Indexer Install: Updating the 64-Bit Media Indexer software does not remove the previous version. This has been fixed.

Fixed in v2.0.1

The following problems are fixed in Interplay v2.0.1.

Bug Number: UDevC00129418. Extended searching for published media ("Streamable media is published") returned only master clips and to filter out other media types. This has been fixed by renaming the search expression to “Streamable Masterclips”. It is still not possible to search for streamable sequences and subclips.
➤ **Bug Number:** UDevC00130335. The shortcut for deleting locators (Ctrl+Shift+Delete in Windows, or Shift+Command+Delete in Mac OSX) did not work when the keyboard focus was on the Monitor. This has been fixed.

➤ **Bug Number:** UDevC00130501. Versions of Interplay Access earlier than V2.0 might not display timecode for locators in a clip that is checked into an Interplay V2.0 database. This has been fixed.

➤ **Bug Number:** UDevC00130711. Applying settings for Pro Tools Import on folders other than the root resulted in an error message. This has been fixed.

➤ **Bug Number:** UDevC00130852. An audio-only clip in Access could be used a subclip or as the first shot in a shotlist only if the In mark is on the first frame. This has been fixed.

➤ **Bug Number:** UDevC00130229. If you double-clicked a published clip, the clip loaded in the Monitor but did not play. This has been fixed.

➤ **Bug Number:** UDevC00130850. Opening a shotlist in Media Composer that was created in Interplay Access from subclips created in Media Composer or Interplay Assist resulted in an exception (Sequence refers to non-existent track in clip). This has been fixed.

---

**Limitations**

This section describes existing limitations and problems.

For International Character Set (ICS) limitations, see “International Character Support Limitations” on page 133.

For 24p proxy limitations, see “International Character Support Limitations” on page 133.

**Limitations for Version 3.1**

➤ **Bug Number:** UDevC00185554. If you install any of the following Media Services providers, you must also install Interplay Access v3.1 on the same system:

- Interplay Transcode v3.1
- STP Encode v3.1
- Interplay Consolidate v3.1 (MediaCentral workflows only)

If you do not install Interplay Access, a job will fail with the error message “Fail to check out moniker.”
➤ **Bug Number:** UDevC00185832. Interplay Transcode v3.1 has been changed to run as a Windows application, rather than a Windows service. This addresses a problem transcoding AMA media using third-party storage. See “Configuring Interplay Transcode as an Application” on page 60.

➤ **Bug Number:** UDevC00185502. Spanned AMA media appears as partially offline. When you are working with spanned AMA media on an Avid editing application in an Interplay environment, the clip may appear as partially offline after you perform an AMA link. Only the first span you linked to will be online.

**Workaround:** Check the clip into the Interplay database. The remainder of the spans will now be online.

Background: When you perform an AMA link for media that is on either an ISIS workspace or licensed third-party storage, the system automatically creates .spaaf files for the clip and checks the clip into “Unchecked in Avid Assets” folder on the Interplay database. For a spanned clip, the system only creates .spaaf files for the first span you select. When you check the clip into Interplay, the system creates the .spaaf files for the remaining spans and the clip appears online.

➤ **Bug Number:** UDevC00183684. Update Status from Media Indexer: A subclip with fewer tracks than its relative masterclip will display as partially online (BlueDot) after "Update Status from Media Indexer".

**Workaround:** Check the subclip back into the Interplay database. The clip will no longer appear as partially offline.

➤ **Bug Number:** UDevC00185484. Access extended search: The extended search criteria “AMA Media Status” does not work correctly with assets checked in with Interplay v3.0.5 and greater and Interplay v3.1. The following results are returned:

- “has AMA linked” and “has only AMA Media linked” do not return any search results
- “has native Media linked: returns all master clips regardless of what media is linked.

➤ **Bug Number:** UDevC00185719. If you are a Media Composer Cloud client in remote mode, working with local AMA clips, and you attempt to check these clips in to Interplay while they are linked to AMA media, you might get the following error message: "Error saving composition to Asset mngr. Failed to copy SPAAF and OMAAF to MI index folder!"

If you upload these clips or edit them into a sequence and upload the sequence, you might also get this error, but in this case the upload succeeds, the objects check in correctly, and are usable by other users.

**Workaround:** For uploads, dismiss the errors and ignore them. To check in AMA clips, upload them instead of checking them in.
Limitations

➤ **Bug Number:** UDevC00185917. If you use Interplay Administrator to open the Avid Service Configuration utility, then edit settings for an Auto Production service, an error message is displayed: “Apply failed.” However, the setting was applied and persists.

**Workaround:** Open the Avid Service Configuration utility from the Start menu.

**Using Interplay Copy with ISIS v4.5**

Starting at ISIS v4.5, the default behavior is to perform data verification for Copy operations. When data verification is active, ISIS verifies each file write operation by performing a read after the write is finished. This causes a problem for Edit While Copy operations for Interplay v2.x and v3.0.x. The Copy server can’t read the file because the file is open for write only. The workaround is to turn off ISIS data verification on the Copy server using the following procedure.

**To turn off data verification on the Copy server:**

1. On the Copy server, quit the Copy Server application
2. Run regedit and modify the following registry key as shown:
   
   ```
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\AvidFos\Parameters]
   "FastCopyCtlFlags"=dword:00000000
   ```
3. Re-start the Copy Server.

   This turns off data verification on the Copy server and allows you to use the Edit While Copy feature.

**Limitations for Version 3.0.5**

➤ **Bug Number:** UDevC00182045. Dynamic Relink to “1:1 MXF” in an editor HD project may not work if the clip was transcoded to 1:1 MXF using Interplay Transcode or Sphere. The reason is that Interplay Transcode uses the 1:1 MXF profile option to create an SD resolution.

**Workaround:** If you want to be able use Interplay Transcode and then relink to “1:1 MXF” in the editor, transcode to “8bit HD Uncompressed X”, where X = 1080i, 1080p, or 720p.

➤ **Bug Number:** UDevC00181285. SGL FlashNet client v6.1.52 does not support the 2012 SQL Native Client, which is installed with Media Services Engine v3.0.5. If you want to run Interplay Archive/Restore with the FlashNet client on the same system as Media Services Engine v3.0.5, you must obtain and install 2008 SQL Native Client. 2012 SQL Native Client and 2008 SQL Native Client can co-exist on the same server.

If the FlashNet client software is already installed when you install 2008 SQL Native Client, re-install the FlashNet client software.
Installation of Interplay Archive/Restore and FlashNet client v6.1.52 on a standalone server requires 2008 SQL Native Client.

- **Bug Number:** UDevC00181901. Dynamic Relink and spanned AMA material: If you use Dynamic Relink to link to spanned P2 files, the system displays an “assertion failed” error message and relinking to the AMA material does not occur.

  **Workaround:** Use AMA to link to the original AMA file as follow:
  - In the editor application, select File > AMA Link
  - Navigate to the workspace that contains the AMA source file and link to the file.

- **Bug Number:** UDevC00174958. (Interplay Administrator) The maintenance task “Remove Duplicated Locators” might list sequences that do not have duplicated locators. This can happen because the task checks all checked-in versions of a sequence, not only the most recent version.

- **Bug Number:** UDevC00171149. Limitation: The Media Indexer does not report indexed file locations properly when they contain international characters in their file or folder names and are indexed on a Mac OS X system. The reported path to the file does not match the path on the files system. Non-standard characters replace the international characters and the resulting path cannot be used to located the media.

- **Bug Number:** UDevC00170453. (Interplay Administrator) In versions prior to v3.0, if a Metadata Only backup was executed on a new database without previous backups, an exception message was displayed and the backup was not listed in the Backup History. An exception is no longer displayed, but the backup is still not listed in the Backup History.

- **Bug Number:** UDevC00183030. The utility program LicenseKeyInfo.exe is not included in the Interplay Engine v3.0.x installer. **Workaround:** Obtain the utility from an earlier version of the Interplay Engine. The utility is located in one of the following folders:
  - C:\Program Files (x86)\Avid\Avid Interplay Engine\Server
  - C:\Program Files\Avid\Avid Interplay Engine\Server

- **Bug Number:** UDevC00184269. Copying files during ingest (chained ingest) with Interplay Copy v3.0.5 fails when using a v4.6 or v4.6.1 ISIS client. **Workaround:**
  1. Quit the Interplay Copy service.
  2. Open regedit.exe, and create the following key:
      
      [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\AvidFos\Parameters]
      
      "FastCopyCtlFlags"=dword:00000000
  3. Restart the Interplay Copy service.
Limitations for Version 3.0

➤ **Bug Number:** UDevC00179322. When connecting to the Media Indexer server from an editor system, the editor system must be able to resolve the hostname of the Media Indexer server via DNS. If the editor system cannot resolve the hostname of the MI server, the MI server will not be added to the local MI configuration.

This problem can occur if the MI server is identified via IP address in the Interplay Administrator tool. In this case if the editor systems can’t resolve the IP address to the server name, the MI server will not be added to the local MI configuration. Note that it is not sufficient that you can ping the IP address of the MI server. You must be able to ping the MI server hostname from the editor system.

➤ **Bug Number:** UDevC0018081. If the audio track of a sequence is linked to AMA material and the video is linked to MXF material, you cannot check the sequence into Interplay. This same problem exists for AMA video and MXF audio.

**Workaround:** Link both the audio and video to either AMA or MXF and you can check the sequence into Interplay.

➤ **Bug Number:** UDevC00179996. If you load an AMA-linked clip into a monitor, then enable Dynamic Relink and set the Preferred media format in the Dynamic Relink Settings dialog box to “Any native media,” the media displays as offline. This is as designed. If there is no native MXF or OMF media to display, the AMA-linked clips only display when you select AMA as the preferred media format.

➤ **Bug Number:** UDevC00177046. (Assist) In some circumstances, subclips and sequences transferred through Interplay Delivery do not retain restrictions in the target workgroup.

1. Add a restriction to a master clip, and create a subclip or sequence from the master clip.
   
   Do not shut down or restart Assist. Do not do any searches or load anything else in the monitor or timeline.

2. Start Interplay Access, and use Interplay Delivery to send the subclip, but not the master clip, to another workgroup.

   In the receiving workgroup, the restriction icon (red triangle) is displayed until the subclip is loaded. No restriction information is displayed.

This limitation also applies to other Media Services.

**Workaround:** Shut down or restart Assist before delivering or using another Media Service.
Bug Number: UDevC00173783. (Assist) 1080p/23.976 sequences converted to 1080i/60 fail when attempting to send to playback (STP).

1. Create a sequence created in a Media Composer 1080p 23.97 project.
2. Open a new 1080i/60 project, and load the sequence in the Timeline. Render the sequence and check it in to Interplay.
3. In Interplay Assist, check out the sequence and try to perform an STP. The process fails with an error stating that assets are not available in the target resolution.

Workaround: Send the sequence to playback using Media Composer or NewsCutter.

Bug Number: UDevC00180264. Interplay Access on Mac requires the Avid Service Framework (ASF) for the Update Status from Media Indexer command. Starting at Interplay v3.0, a Mac OS X editing client can connect to the Media indexer HAG without installing ASF. However, if you plan to use the command Update Status from Media indexer on Access on the Mac client, you must configure ASF. There are two ways to do this:

- If your Interplay environment has only one Lookup Service, you can run the configure.sh script to add the workgroup name and the name of the Lookup Service.
- If your system has two Lookup services, you must run the Interplay Administrator tool as root to add both Lookup services. The configure.sh command only configures for one Lookup service.

For details on using these tools, see What’s New for Interplay v3.0 or the Interplay v3.0 Installation and Configuration Guide.

Bug Number: UDevC00180039. Media Indexer limitation: When you check in an AMA file, the system does not create .spaaf files if the workspace for .spaaf files is not mounted correctly on the ISIS client.

Before you begin to check the AMA files into Interplay, you must manually create the top level folder for the .spaaf files and configure the Media Indexer to index that folder. Avid recommends that you dedicate a specific workspace for the spaaf files.

The spaaf workspace on ISIS must be mounted and accessible by the editing user on the editing machine. On a Mac OS X system, the workspace must be mounted using the same name as the workspace. The checkin will fail if this condition is not met.

The following shows mount point examples for a workspace named “spaafFiles”:

- Correct: /Volumes/spaafFiles
- Incorrect: /Volumes/spaafFiles1
The incorrect mount point can occur if you have duplicate workspace names. The ISIS client adds a digit to a workspace name if it encounters a duplicate name. This can happen if you have two ISIS systems. Avoid duplicate workspace names.

➤ **Bug Number:** UDevC00177304, UDevC00177598. Subclips created from group clips, group clips composed of subclips, and multigroup clips are not supported by Interplay Transfer or Interplay Media Services.

➤ **Bug Number:** UDevC00176256. (Interplay Access) If you play a multi-resolution clip that includes multiple streamable segments, only the longest streamable segment is played. This is as designed.

➤ **Bug Number:** UDevC00171337. (Interplay Access) Interplay Access lets you set Mark In and Mark Out on offline regions of a clip and then create a subclip or add the segment to a shotlist. If you then save the subclip or sequence, the offline region is removed from the subclip or sequence, but there is no warning or message.

➤ **Bug Number:** UDevC00171342. (Interplay Access) If two different Access clients are playing the same master clip, and one client deletes the clip and media files, playback on the second client stops after a brief delay and the Play button blinks intermittently. No message is displayed until the user on the second client reloads the clip.

➤ **Bug Number:** UDevC00169913. (Interplay Access) In the Assets pane, you can drag and drop an asset on an unused part of a tab. An error message appears telling you it is an invalid destination.

➤ **Bug Number:** UDevC00135065, UDevC00150388. Airspeed Multi Stream Studio -HD configurations: When configuring an AirSpeed Multi Stream Studio -HD target for Instinct or Assist users, if the Interplay Transfer Settings view does not contain a Transfer Engine, then Instinct and Assist users will not see the studio-HD target in the Send to Playback menu.

**Workaround:** In the Interplay Administrator, open Site Settings > Interplay Transfer Settings, and specify a Transfer Engine or AirSpeed Multi Stream as the “Primary Transfer Engine for Editors,” as shown in the following illustration.
Then restart Instinct or Assist.

➤ **Bug Number:** UDevC00172995. (Interplay Administrator) Deleted rendered effects are not included in the Deletion Statistics tab of the Database Information view in the Interplay Administrator. Deleted rendered effects are not listed in the AvMetaDataDelete.log.

➤ **Bug Number:** UDevC00175692. (Interplay Administrator) In the Site Settings > Interplay Transfer Settings view, if you edit the “Cache Hostname” field with new characters, the Apply button remains grayed out, so that you cannot save your changes.

**Workaround:** Click in a white field on the page to activate the Apply button.

➤ **Bug Number:** UDevC00180685. (Interplay Access, Macintosh) The following keyboard shortcuts do not work as documented:
Limitations

These commands also do not work as documented in Access v2.7.

➤ **Bug Number:** UDevC00176670. (Interplay Access) If you set In and Out marks on a clip while it is being captured (in-progress EWC clip), and there is not sufficient material captured within the marks, you cannot create a subclip. The UI displays a tooltip that you can’t create a subclip while capturing, but it displays the wrong In and Out timecode values.

**Workaround:** Mark In and Out for already captured material.

➤ **Bug Number:** UDevC0018027. You can no longer preview Deko File types in Interplay Access. In Interplay v3.0, *.dko files can still be checked into the Interplay database as file assets. However, you can no longer preview the graphic in Interplay Access.

➤ **Bug Number:** UDevC00180359. (Avid editing systems) A user on a Media Composer or NewsCutter system can delete media for checked-in rendered effects, even if the user does not have deletion rights to the asset in the Interplay database. Although user rights are not checked for assets, media reservations (marked by red dots in Interplay Access) are active and not affected by this bug.

**Limitations for Version 2.7**

➤ **Bug Number:** UDevC00172604. Interplay Sphere install option for Delivery Receiver: If you perform an upgrade of the Delivery Receiver software, the installer does not upgrade or install Web Services (required for Sphere support).

**Workaround:** When upgrading Delivery Receiver software to include Sphere support, uninstall Delivery Receiver first and then perform the installation.

➤ **Bug Number:** UDevC00175371. (Interplay Engine) The Interplay Engine includes a default set of licenses for installation use, which is visible when you install a new Interplay Engine and open the Interplay Administrator Licenses view. This default set includes Key-EA, which is not currently used. If this license key is displayed, unneeded settings are also displayed, on the Server Hostname Settings View page, under Interplay Integration Service.
After you install the customer’s licenses, this license key and the unneeded settings no longer appear.

*Under some circumstances Key-CI might be displayed. This license is not currently used.*

➤ **Bug Number:** UDevC00171161. The Media Indexer reports an error situation if there is less than 10 GB of space left on the drive that hosts the log files. This is usually the C: drive. This is not a critical error but the MI will only keep the current day’s log files when this occurs.

Starting at Interplay v2.6, the MI automatically zips and stores its log files. If there is less than 10 GB free space on the drive that stores the log and cache files, the MI starts removing zip files, oldest first, until more than 10 GB is free. Note that the current day’s archive is not removed. For additional information, see *What’s New for Interplay v2.6* on the Avid Knowledge Base.

➤ **Bug Number:** UDevC00172309. Interplay Sphere: After you upload a clip, the original clip may not show the local media path in Access.

**Workaround:** After you perform a remote upload of a clip, check the original clip into Interplay from the editor and then check it out. Now when you view the clip in Access the clip will show the local media path in the Access Object Inspector.

➤ **Bug Number:** UDevC00158274, UDevC00157438. STP with Studio can fail if one TM in the Studio stops running. This problem can occur if you send one of the following jobs to an AirSpeed Multi Stream Studio:
  - Any sequence sent as a foreground encode job
  - STP Encode of an XDCAM HD sequence

If the Interplay Transfer service on any of the AirSpeed Multi Stream systems in the Studio stops, the job will fail with either a “kCancel” or “Transfer Failed” error. This happens even if the Interplay Transfer service on the system processing the job is still running.

➤ **Bug Number:** UDevC00170420. Interplay Access: The Help menu is not active until you select an item in the Access window.

**Workaround:** Select a database in the tree view and the Help menu becomes active.

➤ **Bug Number:** UDevC00161587. (Telestream Flip Factory) On an AS3000 running Windows 7, Flip Factory v7.2 fails to start the Flip Engine if Gold Disk policies are enabled. This blocks operation of Flip Factory.
Bug Number: UDevC00163110. If you uninstall any of the Media Services Auto Services, then open the Avid System Framework Workgroup Properties, an error message is displayed, saying that the auto services are not properly registered. Workaround: Use regedit to delete the following registry keys:

- HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\autoarchive
- HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\avidinterplayautomediaservices
- HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\autoarchive
- HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\avidinterplayautomediaservices

Bug Number: UDevC00170654. (Avid editing systems) You might receive an error “Unable to delete database node” when trying to delete a resolution for a dynamically relinked clip.

1. If a clip is associated with several resolutions, dynamically relink to resolution A.
2. Right-click the clip and select Reveal File, then delete the media file that is associated with resolution A.
3. Dynamically relink to resolution B.
4. Transcode the clip to resolution A and check it in.
5. Right-click the clip and select Reveal File, then attempt to delete the media file that is associated with resolution A.

An error “Unable to delete database node” is displayed. This occurs because the editor is trying to delete media using the old file location that is offline. Workaround: use Interplay Access to delete the media file.

Bug Number: UDevC00174511. (Avid editing systems) Markers (locators) added to a Data track are not preserved when checking the clip into Interplay.

Bug Number: UDevC00171248. (Capture Manager) If a folder name in Capture Manager contains more than 25 characters, the folder name is trimmed to 25 characters after the folder is checked into Interplay. This occurs because Capture Manager limits folder names to 25 characters.

Bug Number: UDevC00171874. (Interplay Archive/Restore) A duplicated clip (new metadata that points to the same media as another clip) that has not been archived cannot be restored.
Workaround: Archive the duplicate clip.

➤ **Bug Number:** UDevC00172883. (Interplay Archive and FlashNet) Archiving or restoring jobs with a large number of media files (5,000 or more) might fail with a bad descriptor error.

Workaround: Disable the HSS setting.

➤ **Bug Number:** UDevC00172470. When sending clips with Chinese characters in the .mxf filename or workspace name, the job fails with a third-party error from the FlashNet client. This occurs when the Interplay Archive provider is set to Simplified Chinese in the “Language for non-Unicode programs” setting in the Administrative tab of the Region and Language Control Panel. This is the correct method for the provider configuration.

Workaround: Set the “Language for non-Unicode programs” to English and retry the job.

➤ **Bug Number:** UDevC00172934. (Interplay Assist and Avid Instinct) Assist and Instinct might not launch after a clean install and might display the error “InitializedAME () failed.”

Workaround: Check for NVIDIA driver version 275.89. If you still get an error, reinstall the NVIDIA driver.

*Interplay Assist and Avid Instinct must be installed and launched for the first time by a user with Administrator rights.*

**To check the NVIDIA display driver version:**

1. Right-click the desktop and select NVIDIA Control Panel.
   
   You can also open the Windows Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.
   
   The version number is listed in the Graphics card information section on the ForceWare version line.

**To install the NVIDIA display driver:**

1. Navigate to Program Files\Avid\Utilities\nVidia.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions to unzip the file and install the driver.

4. When the installation is finished, restart your system.
Macintosh Editors

➤ **Bug Number:** UDevC00144800. You cannot perform Send to Playback to an AirSpeed Studio on a Mac editor. If you add an AirSpeed Studio to the Mac editor’s transfer settings, the Studio does not appear in the Send to Playback dropdown menu. Note that this limitation also applies to AirSpeed Multi Stream.

➤ **Bug Number:** UDevC00132571. Macintosh editors on Interplay: If you open Workgroup Properties on a Macintosh system, the Services tab does not include options to view the status of the Avid services running on the local computer, or to start, stop, restart, enable, or disable local services. Currently, the only service running on the Macintosh client is Media Indexer.

**Workaround:** In Workgroup Properties, click the Lookup tab. Click edit, then click Apply. The service is stopped and restarted.

➤ **Bug Number:** UDevC00142838. Mac editors and MPEG4 media: Mac editors cannot use Dynamic Relink to link to MPEG4 media captured from a dual ingest. The system displays an Assertion error. You can continue through the error dialog but the MPEG4 media does not link.

Limitations for Version 2.6

➤ **Bug Number:** UDevC00168989. (Avid editing applications and Interplay on Macintosh) If you try to change the name of the Lookup Server (LUS) listed in the Workgroup Properties on an Apple Macintosh system, the following error is displayed after you click the Apply button:

“unexpected failure to store workgroups”

To change the name of the LUS:

1. Uninstall Media Indexer. See the *Avid Interplay Installation and Configuration Guide* or the Interplay Help for instructions.
2. Delete the following file:
   
   /Library/Preferences/avid.workgroups.avid technology incorporated.plist
3. Reinstall Media Indexer as described in the documentation listed in step 1. Make sure you enter the correct name of the LUS.

➤ **Bug Number:** UDevC00167507. (Avid editing systems) In Media Composer v6.1, when the user right-clicks an object in a bin and selects Media Services > service_name, if the Interplay workgroup includes a large number of Media Services profiles, some profiles could be offscreen.

**Workaround:** Drag the bin to a different location, then try the operation again. Alternatively, select the bin object, then select File > Media Services > service_name.
➤ **Bug Number:** UDevC00168120. (Avid editing systems) Stereoscopic clips created from a simultaneous left/right capture do not load in an editing system if dynamic relink is enabled. An error message is displayed. As a workaround, disable dynamic relink. Note: Clips created manually or from QuickTime movies load and play correctly.

➤ **Bug Number:** UDevC00170490. (Interplay Assist) If you add a restriction with a comment to a stereoscopic clip in Interplay Assist and save the file, then open the file again in Assist or an Avid editing application, the restriction markers are displayed but the comment is not displayed.

➤ **Bug Number:** UDevC00170817. (Documentation) The following keyboard shortcuts are incorrectly documented in the *Avid Interplay Access User’s Guide* and the Interplay Help.

   - With focus in the monitor: “Enter” starts playback from beginning instead of adding a locator.
   - With focus in the monitor: “5” edits the timecode overlay instead of starting playback
   - With focus in the monitor: Up Arrow causes jump to previous locator instead of next one and Down Arrow causes jump to next locator instead of previous one.

➤ **Bug Number:** UDevC00170515. Archive Engine upgrade install problem: If you cancel an upgrade installation of the Archive Engine, the existing Archive Engine will have problems starting and you will not be able to import your Interplay licenses. The problem occurs if you cancel the installation at the Welcome screen for the installer.

**Workaround:** Reinstall the Archive Engine and reboot as usual.

➤ **Bug Number:** UDevC00163110. Auto Media Services: After you uninstall Auto Media Services, the Avid Service Framework displays a message that the application is still registered. This is because the uninstaller leaves the following four registry keys behind:

   HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\autoarchive

   HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\avidinterplayautomediaservices

   HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\autoarchive

   HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\avidinterplayautomediaservices
Limitations

**Workaround:** Ask an administrator or your Avid representative to remove the four registry keys.

➤ **Bug Number:** UDevC00169950. Workgroup to Workgroup Transfers occasionally fail and leave media files in the following temp directory on the sending workgroup:

<drive>:\Avid MediaFiles\MXF\<TM_Name>\temp

➤ **Bug Number:** UDevC00170653. When you click on the Pro Tools Interplay Client installer, the system displays the following error:

On Preload, Line10: attempt to concatenate global_PTGUID

**Workaround:** Click OK and continue with the installation. The problem is only related to starting the installer.

➤ **Bug Number:** UDevC00165058. Interplay Transfer: When configuring FTP servers, you must edit the Interplay Transfer Configuration tool as an Administrator. Otherwise the registry keys created from the FTP servers will be placed in the wrong directory and Transfer Manager will be unable to use them.

➤ **Bug Number:** UDevC00149462, UDevC00166857. FTP Media Browse strips ICS characters from the name when sending to a K2 server. The problem occurs for both single byte and multi byte characters.

➤ **Bug Number:** UDevC00161489. Send to Playback of an XDCAM HD sequence fails if it contains either 8 or 16 audio tracks. The problem also occurs for XDCAM HD sequences with a surround sound track.

**Workaround:** For the 8 or 16 track sequences, mixing down two or more for a total of 7 or 15 works. For the surround sound track, if you split the surround sound track to mono (6 tracks), you can send the sequence successfully.

➤ **Bug Number:** UDevC00168889. The Interplay Transfer Status window in Access does not show the correct status for a transferred clip. It shows as offline status even though the job transfers successfully.
Media Indexer Limitations for Interplay v2.6

➤ **Bug Number:** UDevC00171147. The UTest Tabledump report is missing some entries and other entries are duplicated. The UTest tool is typically used by Avid Customer Support as a diagnostic tool. The following problems exist for the Interplay v2.6 version of UTest:

- Information about media files in the indexed workspace subfolders is duplicated.
- The reports don’t include information about files in the root of the indexed local workspace.

➤ **Bug Number:** UDevC00171148. Media Indexer web user interface: In the Storage Browser panel, the Quality Description popup does not display details about the Quality ID when you right-click the entry in the list. Instead it displays “Undefined”.

➤ **Bug Number:** UDevC00171161. Media indexer Archived Log Files: The What’s New for Interplay v2.6 guide describes how Media Indexer automatically archives log files to a separate folder. If there is less than 10 GB free space on the drive that hosts the log files, Media Indexer reports an error situation and will only retain the current day’s log.

➤ **Bug Number:** UDevC00169997. Avid editing applications: You cannot delete local media from a bin after the clip was consolidated to an ISIS workspace in Interplay.

**Workaround:** The media can be deleted using the Avid editing application Media tool and the media can be deleted from the bin if you are in disconnected mode.

➤ **Bug Number:** UDevC00170600. Avid editing applications: Media can become offline in the Avid editing application when moving media files between different ISIS workspaces (same or different ISIS) when the path information of source and target file below the workspace folder is the same. Media will come online again when reopening the project in the editing application after the move operation.

➤ **Bug Number:** UDevC00171149. Media Indexer does not report indexed file locations properly when they contain international characters in their file or folder names and are indexed locally on a Macintosh system.

➤ **Bug Number:** UDevC00171162. You cannot use the Media Indexer web user interface to manage the order of priority for Storage Locations.

**Workaround:** Use the Avid Service Framework Service Configuration tool for this operation.

➤ **Bug Number:** UDevC00171168. Media Indexer: The Media Indexer logs Java runtime garbage collector output to a file at the following location:

%Program Files%/Avid/AvidMI/bin/garbage-collector.log
Limitations

For Interplay v2.6, the file will keep on growing in size as long as the MI process is running. Upon restart, the file will be set back to zero length (0 bytes) and start growing again. When the MI process is running for a very long time, this could fill up the local drive.

**Workaround:** If you restart the Media Indexer at the recommended intervals (once a month) the file will be automatically deleted. In an emergency situation, do the following:

- Open the file in a text file editor such as Notepad.
- Delete the content in the text file editor
- Save the file.

Note that moving the file is not possible while the Media Indexer is running.

**Limitations for Version 2.5**

For 24p proxy limitations, see “International Character Support Limitations” on page 133.

➤ **Bug Number:** UDevC00145287. After sending a sequence with an ancillary data track to a K2 Media Server, if you bring the sequence back to Interplay via FTP Media Browse, the sequence no longer contains VANC data in the D-track.

➤ **Bug Number:** UDevC00161432. Using EWC on a Mac editor: After an EWC clip completes recording you must select it and choose Update from Interplay in order to display the completed clip icon in the bin. If you do this on a Mac editor, the system may display an "Exception: MXF DIDMapper" error. If this happens, the clip will not play.

**Workaround:** Do one of the following and the clip should appear correctly in the bin:

- Close and reopen the bin:
- Close and restart the editing application.

➤ **Bug Number:** UDevC00149861. If you perform a Send to Workgroup operation and specify "Other" workgroup option, only the first clip will transfer correctly. The remainder of the clips will return an error stating that the TM doesn't have information for the specified device.

**Workaround:** Send one clip at a time using the "Other" option or define a specific device for workgroup Transfers and specify that device.

➤ **Bug Number:** UDevC00161485. Interplay Access on Mac OS 10.7 does not have an uninstaller.
Workaround: Do the following to remove the Access application:

- Delete the entire Interplay Access folder from the following location:
  Applications\Avid\Avid Interplay Access
- Delete the Access shortcut from the Dock.

Bug Number: UDevC00149984. If you link to the low res proxy during an EWC and use the JKL keys to move across the edge of the recording, the system may become stuck on the Capture in Progress slide. If this happens you cannot recover until you reload the clip.

Workaround: Do one of the following:

- If the recording is still in progress, link to the high res media and then switch back to low res. Or toggle the video monitor on and off.
- If the recording has completed you may receive Assertion Failed or Decomp errors when you attempt to use Update from Interplay. In this case, restart the editing application.

Bug Number: UDevC00164931. Windows 7: Can't locate Media Indexer on Avid editor after first install. After an initial installation of the editor and Interplay support software, the editing application may fail to locate the Media Indexer. This can happen if some of the Avid Service Framework services have not started correctly.

Workaround: Open the Workgroup Properties tool on the editor and check whether any of the services are not running. Restart any services as required. Then restart the Avid editing application again. You may have to do this the first few times that you start the editor. After a few times the services will begin starting automatically, even after a reboot.

Bug Number: UDevC00164639. Partial Restore and Partial Delivery do not support DNxHD 444 resolutions. A partial restore or partial delivery restores the entire clip.

Bug Number: UDevC00157027. In some cases, an online audio clip is displayed as partially online (blue dot). This might occur with audio clips that were imported into an editing system from a CD. If you play the clip and check it in to the Interplay database, it is displayed as fully online (green dot). After you select “Update Status from Media Indexer” the clip appears partially online. The audio plays correctly in either case.

Bug Number: UDevC00163282. Interplay Assist cannot play sequences created in an Avid editing system that contain surround sound clips if the Audio Monitoring Mix Mode is set to Direct Out.

Workaround: Set the Audio Monitoring Mix Mode to Mono or Stereo.

Interplay Assist can play surround sound clips as Direct Out, and can create and play shotlists that contain surround sound clips.
Limitations for 24p Proxy Resolutions (Version 2.5 and Later)

➤ **Bug Number:** UDevC00163299. Clips and sequences that use 720p/23.976p proxy media cannot be streamed in the Interplay Access monitor. These clips and sequences can be played in Avid editing systems.

➤ **Bug Number:** UDevC00163297. Proxy media created from clips imported into a 720p/23.976 project on an Avid editing system (such as an .mov file) is not fully streamable in Interplay Access.

**Workaround:** Import the file into a 1080p/23.976 project, transcode the clip to 720p/23.976 HD, and then transcode it to 720p/23.976 proxy.

➤ **Bug Number:** UDevC00165576. 1080i /59.94 clips that you transcode to 720p/23.976 on an Avid editing system do not support multirez or dynamic relink. Media Services Transcode fails to transcode the 720p/23.976 media to a different resolution. In an Avid editing system, you can transcode to a different resolution but you can only link to the newly created resolution.

**Workaround:** Use a Media Services Transcode CROSSRATE profile to transcode the 1080i/59.94 clips to 720p/23.976.

➤ **Bug Number:** UDevC00165842. AMA clips that you transcode in a 720p/23.976 project on an Avid editing system cannot link to partially restored media. For example, in a 720p/23.976 project, transcode a P2 or XDCAM clip to DNxHD 60, use Interplay Transcode to transcode to H.264, archive the DNxHD media, delete the DNxHD media, and dynamically relink to the H.264 media. If you then create a sequence using the clip and do a partial restore of the DNxHD media, the sequence does not dynamically relink to the restored DNxHD media.

**Workaround:** Do a full restore of the clips.

➤ **Bug Number:** UDevC00165784. You receive errors if you try to render a sequence converted from 720p/23.976 to 1080i/59.94. For example, in a 720p project on an Avid editing system, create a sequence from AMA clips converted from 1080i, change the format of the sequence to 1080i/59.94, and open the sequence in a 1080i/59.94 project. If you then try to render the sequence, the render fails and displays an assertion failure message.

Limitations for Version 2.4

➤ **Bug Number:** UDevC00161315. Ancillary data monitoring in the timeline is not supported while editing with Edit While Capture (EWC) clips. To disable Ancillary data monitoring, deselect the D track monitor icon in the timeline. Note that the data track will work correctly once the EWC clip is completed and updated from Interplay.
➤ **Bug Number:** UDevC00158050. (Interplay Engine on Windows Server 2008 R2 systems)
When you use the Manage Databases view in the Interplay Administrator to activate a deactivated database, you cannot browse for the .pro file. If you click the Browse button, the Open dialog is not displayed. An error message with the headline “0xC00000BB” is displayed at the bottom of the view.

**Workaround:** Type the full UNC path. For more information and an example, see “Activating the Database” on page 30.

➤ **Bug Number:** UDevC00157069. (Streaming Server, Macintosh) For Mac OS X 10.5, streaming playback is supported only on Macintosh Intel Core 2 Duo systems that are capable of running Java 1.6.

➤ **Bug Number:** UDevC00158418. If you are using Interplay Access v2.4 to browse the database of an Interplay v2.4 workgroup that uses an Interplay v2.3 Stream Server, a stream-while-capture clip might stop and display “Not enough media. Capture in Progress.” The clip loads again, but does not play until you click the Play button (or use a keyboard command). You might have to click the Play button more than once.

➤ **Bug Number:** UDevC00158403. If you are using Interplay Access v2.4 to browse the database of an Interplay v2.4 workgroup that uses an Interplay v2.3 Stream Server, all MPEG-4/H.263, H.264, and MPEG1 Level 2 clips display a green icon to indicate that they are playable. However, if you try to play a clip that is not published as a QuickTime reference movie, the following message is displayed: “Streaming server or share is not registered.” Publishing the clip lets you to play the clip correctly.

➤ **Bug Number:** (no number). Do not install the STP Encode service provider and the Interplay Transcode service provider on the same server. These providers cannot run on the same server.

➤ **Bug Number:** UDevC00155898. Media Indexer: If you remove a workspace from the primary MI, the workspace may not be immediately removed from the secondary MI. This can happen if you delete a workspace from the primary MI while the secondary MI is busy indexing newly added workspaces or is performing a startup index.

➤ **Bug Number:** UDevC00149804. Media Indexer: The number of Unique Media Files and Duplicated Files shown in the Health Monitor may vary between different MIs in the same HAG. This is due to an error in the way the duplicated media files are counted. Usually the sum of Unique Media Files and Duplicated Files together on each system match correctly. However, this is not always guaranteed, especially if there are file system changes combined with moving and deleting files and/or folders.
Limitations

➤ **Bug Number:** UDevC00155897. Media Indexer: An MI might sometimes show a negative heartbeat time value in the Health Monitor, especially when the system did not yet issue a heartbeat operation. The Heartbeat is a new feature for Interplay v2.4. See What's New for Interplay v2.4 or the Interplay Help for information on the Heartbeat value.

➤ **Bug Number:** UDevC00156697. Media Indexer: The "Duplicate assets count" value in the Media indexer log files can sometimes show a negative value for the per workspace file count.

➤ **Bug Number:** UDevC00156698. Media Indexer: During an upgrade or uninstall of Media Indexer, the Event log may show the following error: "StartServiceCtrlDispatcher failed".

➤ **Bug Number:** UDevC00153537. (Avid editing systems, Macintosh) If you drag an asset from a bin into a folder in the folder tree (the left pane of the Interplay Window), the following error is displayed: "Error moving asset: An internal client error has occurred. java.lang.illegalArgumentException:invalid object moniker." The error message appears because you cannot drag an asset into a folder in the folder tree. You can click OK in the error dialog and correctly drag an asset to a folder in the right pane of the Interplay Window.

➤ **Bug Number:** UDevC00157373. (Avid editing systems) Sequences with rendered video transition effects might become unrendered when selecting "Update from Interplay." The following actions will cause this problem:

1. User on system 1 creates a sequence with rendered video transition effects and checks it into Interplay.
2. User on system 2 checks out the sequence, adds an additional rendered video transition effect, and checks it into Interplay.
3. User on system 1 opens the sequence in the Timeline, right-clicks the sequence in a bin, then selects Update from Interplay.

The first rendered effect in the sequence becomes unrendered. In complex sequences, this unrendered effect could cause other rendered effects to become unrendered.

**Workaround:** On system 1, close the bin that holds the sequence, open a new bin, and check out the sequence from the Interplay window. This version of the sequence should have all effects correctly rendered.

➤ **Bug Number:** UDevC00151575. (Avid editing systems) If a user of an Avid editing application transcodes a clip, deletes the transcoded media, transcodes again to the same resolution, and again deletes the media, the editing application reports the following error: "Error deleting shared media (path to .mxf file). Unable to delete database node (0x89901a5)." However, the media is correctly deleted.

98
Bug Number: UDevC00147601. (Avid editing systems) If you send an XDCAM sequence to an AirSpeed Multi Stream server, the audio might be noticeably hotter on the AirSpeed Multi Stream server. This problem could affect sequences sent from Media Composer v5.0, Symphony v5.0, and NewsCutter v9.0 and later, because the default setting for mono tracks changed from Alternating L/R to All Tracks Centered.

Workaround: In the Audio settings, set the default pan as Alternating L/R.

Bug Number: UDevC00158375. (Avid editing systems) If you create a sequence that includes clips with mixed audio bit rates, you cannot use STP Encode to send the sequence to a LongGOP playback device. For example, a sequence includes clips with 16-bit audio and 24-bit audio. If you select Send to Playback, and then select STP Encode, the following error is displayed: "Sequence contains clips with mixed audio bit depth. Send to Playback will not continue."

Workaround: Do one of the following:
• Select Send to Playback but do not select STP Encode.
• Transcode the sequence to one audio rate, select Send to Playback, and select STP Encode.

Bug Number: UDevC00154920. (Avid Instinct) If you use a USB headset microphone to record a voice-over on a Windows XP system, the recording is garbled. This is not a problem on Vista or Windows 7 systems.

Workaround: Use a microphone that connects through the computer’s microphone connector.

Bug Number: UDevC00142814. DNxHD clips that are ingested from an Omneon server during an edit-while-capture ingest from Omneon do not display a separate Data (D) track in Avid editing applications or in an Interplay environment. To display the D track, you must use the Extract DNxHD Data command in the Avid editing application.

Limitations for Version 2.3

Bug Number: no number. In an ISIS environment, Media Indexer v2.3 servers require the ISIS v2.3 or greater client.

Bug Number: UDevC00149782. (Avid editing applications) On an 8400 dual-quad system, playback of H.264 proxies is very choppy when you view them in a different format project. The following are examples:
• Transcode an HD master clip (1080i 59.94 DNxHD) to create SD proxy media (H.264 800Kbs Proxy 525) and load the clip into a 1080i 59.94 HD project.
• Ingest HD proxy media (H.264 800Kbs Proxy 1080i 29.97) from an AirSpeed Multi Stream system and load the clip into an NTSC 30i project.
Then, with the Quality Menu set to Full Quality (green), play the clip. The playback is choppy and sometimes is not responsive to user control. If you let the choppy playback continue, you eventually see the following error: Exception:StreamingPlayConsumer::ExecutePass TIMEOUT....

(The same problem results on a faster system (such as a Z800) with the Quality Menu set to Full Quality 10-bit).

**Workaround:** For Media Composer and Symphony, set the Quality Menu to Draft Quality (green/yellow) or Best Performance (yellow/yellow). For Symphony Classic, change the project format.

➤ **Bug Number:** UDevC00132305. (Avid editing systems) In a workflow that includes MultiRez and Dynamic Relink, if you consolidate a clip that is associated with more than one resolution, and check in the clip, Interplay Access is aware of only the resolution that was linked to the consolidated clip when you checked it in. This limitation can prevent you from publishing the clip for streaming. For example, if you transcode a high-res clip to MPEG-4 low-res media while the working resolution is set to the high-res media, and check in the clip, Interplay Access displays only the high-res media. If you run a Stream Publish job on the clip, Stream Publish fails with the error message "Internal Error: no valid media tracks are found or proxy media files are offline."

**Workaround:** In the editor, dynamically relink the clip to each resolution and then check in the clip while it is linked to that resolution.

➤ **Bug Number:** UDevC00147992. On a Mac OS X system, if you open the Avid Service Configuration application from Interplay Access or the Interplay Administrator, the Hosts tree might not show any entries.

Workaround: Do not select the option “Automatically Join the Preferred Workgroup.” You can clear this option in the Login tab of the Avid Workgroup Properties.

➤ **Bug Number:** UDevC00149466. (Interplay Access, Interplay Window) Subclips of audio-only master clips do not show a headframe and use the subclip icon, instead of a smaller version of the audio-only master clip icon.

➤ **Bug Number:** UDevC00142955. (Avid editing systems) Locators (markers) on data-only mixdowns checked out to an editing system appear on the Timecode track, not the D track. For example, if you create a mixdown of a track that contains only ancillary data, add a locator, check it into Interplay, then check it out again, the locator does not appear on the D track, but instead appears on the Timecode track.

➤ **Bug Number:** UDevC00144301. On Mac OS X systems, there is no uninstaller for the Interplay Transfer client.
Workaround: Delete the following file:

/Library/Application Support/Avid/xfermgrapi.bundle

Then reboot your system.

➤ **Bug Number:** UDevC00099531. (Interplay Assist) If you want to send a source clip or sequence to playback, the STP operation uses the target resolutions of the loaded shotlist or, if there is no loaded shotlist, the target resolutions set on the database root folder. If the target resolutions displayed are not the target resolutions you want to use, you must create or open a shotlist in a folder that is set with the desired target resolutions.

➤ **Bug Number:** UDevC00151810. (Interplay Access) If you right-click on a clip while it is being ingested, you cannot open the clip in Interplay Assist (the command Open in Assist is not displayed). Workaround: Open the clip in an Avid editing application, or wait until the clip stops ingesting, then open the clip in Interplay Assist.

**AVC-Intra Limitations**

➤ **Bug Number:** UDevC00116685. Interplay v2.x supports capture, import, playback, transcode, and consolidation of AVC-Intra resolutions. The following limitations apply:

- You cannot export a QuickTime movie using the Same as Source option with AVC-Intra material

➤ **Bug Number:** UDevC001137818. (Interplay Assist, Avid Instinct, Avid editing systems) AVC-Intra media will not play or will stutter when playing on systems less capable than an HP xw8600.

**Assist and Instinct Hardware Support**

For a list of qualified workstations and video cards, see the Avid Knowledge Base at [http://www.avid.com/onlinesupport](http://www.avid.com/onlinesupport) and search for “Qualified PC Workstations Assist.”

**Ancillary Data Limitations**

The following limitations pertain to using Ancillary Data with Interplay v2.2.
**Limitations**

- **Bug Number:** UDevC00161432. Ancillary data monitoring in the timeline is not supported while editing with Edit While Capture (EWC) clips. To disable Ancillary data monitoring, deselect the D track monitor icon in the timeline. Note that the data track will work correctly once the EWC clip is completed and updated from Interplay.

- **Bug Number:** UDev00145071. Ancillary Data: Problems working with Edit While Capture feature during ingest of 1080i 60 XDCAM HD that contain ancillary data. The following error is generated:

  AncDataPacketCvtr::ExecuteRequest - ANC Essence Data Key not found at expected sample

  **Workaround:** Allow the ingest to complete. Then right-click the clip in the editing application and select Update from Interplay. Now the clip should have a complete icon and it should be ready to work with.

- **Bug Number:** UDevC00140395. (Interplay Access) Limitation: Resync will not recreate the D-track if the metadata is lost or overwritten. If an editor uses the Extract DNxHD Data feature with a clip or sequence, and checks the clip or sequence into Interplay, the D track is preserved in the local bin. If the clip or sequence is deleted in the local bin, or the metadata in the database is lost through a failure, Resync will not recreate the D track.

  **Workaround:** Extract the D track again in the editing application.

**Omneon, K2 and Ancillary Data**

- **Bug Number:** UDevC00142013. D Track gets stripped off 720p60 XDCAM editor sequences sent to Omneon via TM.

**ISIS Client Bandwidth for Copy Provider**

- **Bug Number:** no number. Copy Provider: Intermittent read timeout errors on Copy Provider jobs.

  **Workaround:** To prevent read timeout errors on a Copy Provider, set the ISIS bandwidth on each Copy Provider to 250 MB per second. You can set the value in the Devices list in the Avid ISIS management Console..

**Recording Across Midnight**

- **Bug Number:** UDevC00133312. Ingest recordings that begin at midnight report media offline errors in Access and editing applications.
Limitations

**Workaround:** Begin recordings one or more minutes before or after midnight. It is preferable to begin the recording after midnight because you can have problems if you consolidate a sequence that contains clips recorded over the midnight boundary. If the portion of the clip you are using was recorded after midnight but the beginning of the clip is before midnight, Dynamic Relink may determine that the clip is offline.

➤ **Bug Number:** no number. Partial restore of media recorded across midnight can cause media offline errors in Access and editing applications. This can happen if you attempt to restore a portion that was recorded after midnight.

**Workaround:** If you have a clip that was recorded across midnight and you want a partial restore of a portion that occurred after midnight, you must specify a beginning timecode that starts before midnight.

**Limitations for Interplay v2.2.1**

➤ **Bug Number:** UDevC00143638. To use Interplay Transfer from an Avid editing system, you need to configure settings in Transfer Settings dialog box. In the TMClient.ini tab, make sure you use the correct case when you enter the server name and workgroup name. Server names are typically lower case. Workgroup names can use a mix of upper case and lower case. The name you enter must match the name entered in the Avid Service Framework.

➤ **Bug Number:** UDevC00145564. Avid Editing Applications on Macintosh: If you uninstall both Interplay components from a Mac OS X system, you still receive a message when starting the Avid editing application that asks if you want to run in disconnected mode.

**Workaround:** Delete the following file:

/Library/Preferences/avid.workgroups.avid technology incorporated.plist

➤ **Bug Number:** UDev00144835. SGL Archive to Disk: Partial restore of a sequence from disk may fail. The job fails with a third party software error. The problem is related to the position of the clip in the sequence. If you encounter the problem for a particular clip in a sequence you will not be able to partially restore that clip from the sequence.

**Workaround:** To restore that particular clip, restore the entire sequence.

➤ **Bug Number:** UDevC00133312. Ingest recordings that begin at midnight report media offline errors in Access and editing applications.
**Workaround:** Begin recordings one or more minutes before or after midnight. It is preferable to begin the recording after midnight because you can have problems if you consolidate a sequence that contains clips recorded over the midnight boundary. If the portion of the clip you are using was recorded after midnight but the beginning of the clip is before midnight, Dynamic Relink may determine that the clip is offline.

➤ **Bug Number:** UDevC00144241. Macintosh Editor Bins limitation: Opening a bin that displays video resolution dots column can cause a Macintosh editor application to crash.

**Workaround:** Do not display columns for video resolution dots in a Macintosh editor bin. Note that you can view video columns in Access.

➤ **Bug Number:** UDevC00145562. Send to Playback to XDCAM SD devices may fail with write permission errors when using profile names.

**Workaround:** Change the FTP and Playback configurations in Interplay Transfer to be the actual hostname of the device. A device can be given a "hostname" by adding its IP address and name to the Window's hosts file residing on the Transfer Manager server.

➤ **Bug Number:** UDevC00145468. Occasionally a 32-bit Media Indexer server may fail to launch and may fail during use. The system displays a "Faulting application AvidMI.exe" error message. This is usually related to an incorrect version of Avid Service Framework or to a problem with the Media Indexer cache files.

**Workaround:** Do the following:

• Check the version of Avid Service Framework on the Media Indexer (should be v1.3.8.1)

• If the framework version is correct, delete the Media Indexer cache files and restart the Media Indexer. Note that this will cause the Media Indexer to rescan all of its storage locations. This can take a long time if the Media Indexer is monitoring a large number of work spaces.

**Limitations for Interplay v2.2**

**RED Camera Support**

Currently, workflows that use media captured from RED cameras are not supported in an Interplay environment.

**MediaStream Server Support**

The Avid MediaStream Server (also known as Media Stream server) is not supported for Interplay Transfer v2.2 and later. If your workflow requires a MediaStream server, use Interplay Transfer v2.1 in your Interplay v2.2 environment.
Limitations

Because the MediaStream server is no longer supported, the “Long GOP transfer enabled” check box has been removed from the Interplay Transfer Configuration window for Interplay v2.3.

Check in to Interplay for Pro Tools

The following limitations apply to the Check in to Interplay for Pro Tools command that is available in the Avid editing application:

- Pro Tools v9.0 adds support for multi-channel audio tracks created in the Avid editing application. If you are using an older version of Pro Tools, use the Split to Mono command in the editor command to break the multi-channel audio files into mono files.
- Pro Tools v9.0 supports RTAS effects created by Avid editing applications. Older versions of Pro Tools ignore RTAS effects created by the Avid editing applications.
- If you are working with Multicam or group clips, before you perform the Check in to Interplay for Pro Tools command, right-click the sequence in the bin and select “Commit Multicam Edits”. If you don’t use the Commit command, Pro Tools will accept the sequence but when the Pro Tools editor attempts to check the sequence back into Interplay, the check in will fail.

Copy Provider and ISIS Versions

You can use the Media Services Copy Provider to copy to an equal or later version of ISIS, but you cannot copy to a lower version of ISIS. For example, you can copy from an Interplay environment running ISIS v1.6 to an environment running ISIS v2.1 but you cannot copy from the ISIS v2.1 system to ISIS v1.6.

Multi-Channel Audio Tracks

Send to Playback

This section describes a best practice for sending a sequence containing multi-channel audio tracks to playback when using Direct Out mode.

When using Direct Out mode, keep the multi-channel audio tracks at the bottom of your audio tracks. When you send to playback in Direct Out mode the system expands the stereo tracks to separate mono tracks. If there are single tracks at the bottom of the track list you may get unexpected results after the top tracks expand. For example, a single track that was on track 5 may now be on a different track. If you keep the single tracks at the top you can avoid this kind of problem. See the editing application What’s New documentation or Help for additional information on multi-channel audio.
Limitations

Assist and Instinct

➤ **Bug Number:** UDevC00142943. (Interplay Assist and Avid Instinct) Multichannel audio tracks from Avid editing systems are not supported by Interplay Assist or Avid Instinct. **Workaround:** Avid editors should use the “Split to Mono” command before checking in sequences that will be used in workflows with Interplay Assist or Avid Instinct.

Check in to Pro Tools for Interplay

See “Check in to Interplay for Pro Tools” on page 105.

Final Cut Pro

➤ **Bug Number:** UDevC00142462. Multichannel audio tracks from Avid editing systems are not supported by Final Cut Pro. Final Cut Pro fails to import the audio tracks (through Automatic Duck) and displays the error message “Unknown Audio Container Effect.” **Workaround:** Avid editors should use the “Split to Mono” command before checking in sequences that will be used in workflows with Pro Tools or Final Cut Pro.

Media Indexer Limitations

This section describes limitations for Avid Interplay Media Indexer. For information on installing and configuring Media Indexer on a Macintosh system, see the “Installing Software on Interplay Clients” chapter of the *Avid Interplay Software Installation and Configuration Guide* or the Interplay Help.

Uninstall Program for Media Indexer on Mac OS

**Bug Number:** UDevC00142377. The uninstaller for Media Indexer on Macintosh systems does not use a graphical user interface. Also, the administrator account that you use to uninstall the program must use a password.

**To uninstall Media Indexer:**

1. Navigate to Applications > Avid Uninstallers > Avid Media Indexer and double-click AvidMediaIndexerUninstaller.
   
   A terminal window opens and asks for a password.

2. Enter a password for an administrator account and press Return. Media Indexer is uninstalled.

*If you close the terminal window without uninstalling the program, you can no longer use the terminal window. **Workaround:** Restart the Macintosh system.*
Stopping and Starting Media Indexer on a MacOS X System

To stop Media Indexer:
1. Open a Terminal window (select Applications > Utilities > Terminal).
2. At the prompt, type the following and press Return:
   ```bash
cd /Applications/Avid/Media\ Indexer/bin
   
   sudo ./mi.sh remove
   ```
3. Type the following and press Return:
   ```bash
   sudo ./mi.sh install
   ```

General v2.2 Limitations

The following problems are present in the Interplay v2.2 release.

➤ **Bug Number:** UDevC00142389. (Access, Macintosh) The Tools menu does not show the correct keyboard shortcuts for the following commands. The correct keyboard shortcuts are shown:

- Check In AAF Sequence (Command+Option+I)
- Export QuickTime Reference (Command+Option+G)
- Import as QuickTime Reference (Command+Option+M)

The keyboard shortcuts are correct in the context (right-click) menu.

➤ **Bug Number:** UDecC00143346. In the Property Layout View of the Interplay Administrator, the following resolutions might be listed in the Resolutions tab:

- AVCIBP-BLL2.0 60
- AVCIBP-BLL2.0 50

Do not select these resolutions as available. They are reserved for future use and can cause problems if selected as a working resolution for Interplay Assist. For AVCI proxy use, select the following resolutions:

- AVCIBP-BLL3.0 60
- AVCIBP-BLL3.0 50

➤ **Bug Number:** UDevC00143402. During installation of the Interplay Stream Server, the installation instructions state that you must enter the user name in the form domain\username. However, if you are using a local user, enter the username only.
The user name and password for the Stream Server Execution User must exactly match the user name and password of the Server Execution User that is used to run the Interplay Engine.

➤ **Bug Number:** UDevC00141484. If you want to create a Media Services profile for dual-mixdown operations, make sure to select DUALMIXDOWN as the transcode mode. If you select MIXDOWN as the mode, the dialog box allows you to enter targets for a dual mixdown, but the profile will use only the first target.

➤ **Bug Number:** UDevC00143049. Assist incorrectly allows stories with offline D Tracks to be sent to playback.

➤ **Bug Number:** UDevC00142844. Interplay Access: You cannot add a drop-frame clip to a non-drop-frame shotlist in Interplay Access (or vice versa).

➤ **Bug Number:** UDevC00137852. Telestream FlipFactory TM Plugin fails to notify Interplay TM 2.2 and process a checkin to Interplay.

➤ **Bug Number:** UDevC00142061. (Interplay Access) If you are working with consolidated subclips or consolidated sequences, Access might show that the media files are online, but you cannot delete the media because it is not displayed in the Delete dialog box. For more information, search the Avid Interplay Access User’s Guide or the Interplay Help for “Limitation: Media Files Displayed as Online but Not Available for Deletion.”

➤ **Bug Number:** UDevC00142535. (Interplay Access) If you select a subfolder of the Deleted Items folder, the Filters button remains enabled. You should not be able to change the filter because a Deleted Items subfolder contains only file assets.

**Transcode**

➤ **Bug Number:** UDevC00143164. Minimizing remote window during Transcode service launch results in DSM_SERVER errors.

**Workaround:** If you use the Windows remote desktop feature to launch the Media Services Transcode service, make sure the Transcode service is completely launched before minimizing the window.

**Omneon and K2 Media Servers**

➤ **Bug Number:** UDevC00142012. AVC-Intra resolutions are not supported for send to playback with Generic FTP profile.
Limitations

➤ **Bug Number:** UDevC00126493. Failed K2 transfers leave behind a temp file that must be manually deleted. Temporary OP1-A exported MXF files are not deleted from the shared storage workspace if the transfer fails after the export. These files can accumulate and take up disk space on shared storage.

**Workaround:** To delete the files, navigate to the Temp directory within the workspace that is used to place temporary files. Select the files and delete them. For example, \\

```
\<sharedstorage server name>\<workspace name>\Temp
```

---

**Archive/Restore**

➤ **Bug Number:** UDevC00141961. If you enable the "no spanning" option in SGL FlashNet for a group, jobs will hang in the Archive Provider during the "Backup Cache Fill: phase of the archive. You can cancel the job but if you run it again it will fail again.

**Workaround:** Disable the FlashNet "no spanning" option.

---

**Windows 7**

➤ **Bug Number:** UDevC00140504. Windows 7: Standalone Interplay Transfer cannot perform an FTP ingest if the Firewall is turned on.

**Workaround:** If you have Windows Firewall turned on with Windows 7, you need to allow Interplay Transfer through the firewall. When you start Interplay Transfer, you should get a dialog like the one shown in the following illustration. Make sure to check off allowing Interplay Transfer through the firewall on private networks, such as "home or work", and that will add an exception for Interplay Transfer through the Firewall. This will allow Interplay Transfer to operate normally with Windows Firewall turned on.
Limitations for Interplay v2.1

➤ **Bug Number:** UDevC00135952. An Avid editing application running on a Macintosh system unexpectedly quits if you disconnect the Avid Unity ISIS user. For example, if Media Composer is running, and you want to change the logged in user, open the ISIS Client Manager, and, under Username and Password, click the Disconnect button. A Media Composer error message is displayed ("Bus Error" in thread "Main Thread"…). After you click OK, the application quits.

**Workaround:** Save your work and close the editing application before disconnecting the current Avid Unity ISIS user.

➤ **Bug Number:** UDevC00135035. Under some circumstances, if you try to delete transcoded media in an Avid editing application, an error message is displayed ("Unable to delete database node") and the media is not deleted. This could occur if you transcode a clip, check it into Interplay, delete the transcoded media, transcode the clip again to the same resolution, and try to delete it.

**Workaround:** Delete media for the transcoded resolution in Interplay Access.
➢ **Bug Number:** UDevC00133649. When using FlipFactory v7.0, if you create a TMIngest factory using the DNxHD codec, and submit a file to Interplay Transfer, when using Interplay Access an incorrect frame rate is displayed.

**Workaround:** Use FlipFactory v6.1 to create a TMIngest factory using the DNxHD codec.

➢ **Bug Number:** UDevC00135075. You must disable real-time scanning on Restore and Copy providers or jobs will fail. When anti-virus software has real-time scanning enabled, Restore and Restore jobs fail with "net.nxn.JXDK.CommandFailedException" errors.

**Workaround:** Disable real-time anti-virus scanning on Restore and Copy provider systems.

➢ **Bug Number:** UDevC00135121. SGL Archive job errors: If a job fails in the FlashNet application without an error, the FlashNet software does not log the error and does not return the error to the Archive Provider. In this case the Archive Provider reports that there was a 3rd party error and recommends that you check the 3rd party log. If you do check the log there is no record of the problem. This problem occurs most often with large sequences.

**Workaround:** Try disabling the High Speed Support setting in the FlashNet application and resend the job.

➢ **Bug Number:** UDevC00131721, UDevC00134328. (Avid Low-Res Encoder and Interplay Access) If your workflow includes publishing reference movies for streaming play, do not use the Scene Change option in the Avid Low-Res Encoder. For example, do not create a shotlist using subclips generated through this option. Reloading the shotlist could fail with an error.

➢ **Bug Number:** no number. The *Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide* includes a topic "Using the InterplayRestore Tool to Restore Backups Remotely." Beginning with the Interplay Engine version 2.1, you can no longer run the InterplayRestore tool from another machine. You must run it on the engine on which you want to restore a backup.

➢ **Bug Number:** UDevC00134005. (Interplay Access) If you partially publish a master clip, you might need to reload the clip two or more times before it will play. For example, if you create a subclip from a clip, transcode the subclip to MPEG-4, and then publish the clip, the first time you load the published clip, it will not play and will time out with an error message. If you load it again, the published portion will not be correctly marked, and again the clip will not play. If you load it a third time, the published portion is correctly marked, and the published portion plays correctly.

➢ **Bug Number:** UDev00127524. (Interplay Access) Files of the following formats do not play correctly in the Interplay Access monitor:- m3u, - asf, -avi, - wmv.
Limitations

➤ **Bug Number:** UDevC00132703. In Interplay Engine v1.6.x and Interplay Engine v2.0.x, if you created a shortcut in Interplay Access, and then moved the target, the shortcut no longer worked. This has been fixed for Interplay Engine v2.1.

➤ **Bug Number:** UDevC00133400. Partial Restore of low res with offset: When you partially restore a clip with a low res offset, you cannot restore the offset portion even if you request the highest available resolution. For example, if you start the low res portion of a dual ingest capture two seconds before the high res capture begins, you cannot restore the first two seconds of the low resolution material.

➤ **Bug Number:** UDevC00106348. Configuring Media Indexers in an ISIS environment with Mirrored and RAID storage: If you have some workspaces that use mirrored storage and some that use RAID, put the Mirrored workspaces first in the list when configuring storage locations for Media Indexer. This will ensure that Media Indexer indexes the storage locations with the most bandwidth first.

➤ **Bug Number:** UDevC00133056. Macintosh editors on Interplay: If you are working on a Macintosh system in an Interplay environment, avoid using non-ASCII characters in file names or machine names. For more information, see the topic "Characters to Avoid when Naming Avid Elements" in the Help for your editing application.

➤ **Bug Number:** UDevC00133056. Macintosh editors on Interplay: If you open Workgroup Properties on a Macintosh system, the Services tab does not include options to view the status of the Avid services running on the local computer, or to start, stop, restart, enable, or disable local services. Currently, the only service running on the Macintosh client is Media Indexer.

**Workaround:** In Workgroup Properties, click the Lookup tab. Click edit, then click Apply. The service is stopped and restarted.

➤ **Bug Number:** no number. Macintosh editors on Interplay: The Workgroup Properties System Check tab is not available on a Macintosh system.

### Changing the Name of the Stream Server Execution User

UDevC00133111 (Interplay Stream Server) You might need to change the name of the Stream Server Execution User. There are two methods, depending on the exact problem.

If you added the incorrect user/password combination during installation, you need to uninstall and reinstall the Interplay Stream Server with the correct user, because in this case the Interplay Stream Server service is not added to the Windows Services list. For information about uninstalling and reinstalling the Interplay Stream Server, see the Avid Interplay Software Installation and Configuration Guide.
If the Stream Server was correctly installed, but the Stream Server Execution User is no longer available or needs to be changed for any reason, you can change the name and password in the Log On tab of the Stream Server service:

**To change the name of the Stream Server Execution User:**
1. Right-click My Computer, select Manage, double-click Services and Applications, then double-click Services.
2. From the list of services, double-click Avid Interplay Stream Server.
3. Click the Log On tab.
4. Enter the correct user name and password.
   - For local users, use the format .\<user>
   - For domain users, use the format <domain>\<user>.
5. Click OK.
6. In the Services pane, click “Restart the service”.

### Limitations found in Interplay v2.0.1

- **Bug Number:** UDevC00127906. If you add locators to a clip in Interplay Access, the locators are not displayed in an Avid editing application, Interplay Assist, or Avid Instinct until you load a different clip in the Access Monitor. After loading a different clip in the Access Monitor, load the original clip again in the Avid editing application, Assist, or Instinct. (Refreshing the clip, pressing F5, or restarting the application does not display the locators).

- **Bug Number:** UDevC00127773. Dragging the position indicator along the timeline in the Access Monitor (scrubbing) does not update the monitor for every frame that you scrub through. The number of frames displayed while scrubbing depends on how fast you drag the position indicator.

- **Bug Number:** UDevC00130431. If you mix clips with differently labeled audio tracks in a shotlist in Access, the shotlist might play back the audio tracks on incorrect audio channels. For example, mixing a clip with V1 A1 with V1 A2 in one shotlist results in a shotlist that plays back only one audio track. The playback of the shotlist in Avid editing applications is correct.

- **Bug Number:** UDevC00130484. In some circumstances, Avid editing application users do not receive an error message if a check-in fails. By design, a user cannot check out a sequence from a read-only folder, edit it, and then check in the sequence. If the user uses a menu command to check in the edited sequence, no error message informs the user that the check-in failed. An error message does appear if you drag the sequence to a folder in the Interplay Window, and then appears after that anytime the user tries to check in the sequence.
Limitations

➤ **Bug Number:** UDevC00131769. In the Interplay Administrator, the Select Workgroup option in the Service Configuration view does not work correctly. The Service Configuration view always shows the workgroup that was specified when first opening the view. If you enter information for a different workgroup in the Select Workgroup dialog box, the selected workgroup is not accepted. **Workaround:** Either use the Service Configuration tool in the Framework installation or restart the Interplay Administrator client and log in to the desired workgroup.

➤ **Bug Number:** UDevC00125918. When starting Avid Instinct, you might experience a delay of 20 seconds when connecting to Media Indexer. The message “Initializing Quality Manager” might appear for longer than usual, and in some cases a message “Cannot connect to Media Indexer” is displayed, followed by “Your connection to Media Indexer has been restored” a few seconds later.

➤ **Bug Number:** UdevC00129075. In Interplay Assist, reloading a clip might not refresh the clip. For example, if an Assist user has a clip loaded, and an Avid editing application user adds locators to the clip, reloading the clip in Assist might not display the locators. The Assist user might need to press F5 or refresh the folder containing the sequence.

➤ **Bug Number:** UDevC00131839. When using Capture Manager and Interplay 2.x, changing the duration of a clip after it has started to be ingested could cause two different clips to be created with the same name. For example, you might schedule capture of clips using a template name (Capture.n, such as Capture.10, Capture.11, Capture.12). If you change the duration of Capture.11 while it is ingesting, the completed clip is displayed in Interplay Access as Capture.12 (even though Capture Manager displays the name as Capture.11). The next clip is ingested and stored as Capture.12, which results in two different clips with the same name.

➤ **Bug Number:** UDevC00128659. You cannot use the Update from Media Indexer command to update the media status for a remote workgroup. You receive an error message that the user is not connected to the Lookup service for that workgroup.

**Workaround:** Install the Avid Framework Service on the Interplay Access client. Open the Avid Framework Service Workgroup Properties and configure the remote workgroup’s lookup service in the Workgroup Properties > Lookup tab.

➤ **Bug Number:** UDevC00132006. An Avid editing application earlier than Media Composer 4.0, earlier than Symphony 4.0, or earlier than Avid Newscutter 8.0 might display duplicate restrictions in the following circumstances:

1. Set a restriction on a clip with Interplay Assist (any version).
2. Check out the clip with Media Composer version 4.0.x (or Symphony 4.0.x or NewsCutter 8.0.x) and check it in.
3. Check out the clip with Media Composer earlier than version 4.0.x (or earlier than Symphony 4.0.x or NewsCutter 8.0.x).
The Media Composer Restrictions tool displays two instances of the restriction.

If you check the clip in again, the restriction is duplicated in the database and duplicate restrictions appear in any editing application that checks out the clip.

**Limitations Found in Interplay v2.0**

- **Bug Number:** UDevC00128577. Partial Restore and Partial Delivery will not work with media created by the following versions of the Avid editing applications:
  - Media Composer v2.6.x and earlier
  - Symphony v1.6.x and earlier
  - NewsCutter v6.6.x and earlier

  **Workaround:** Use full restore or full delivery for this media.

- **Bug Number:** UDevC00130628. In a mixed environment (Interplay 2.0 engine with Avid editing applications earlier than Media Composer 4.0, earlier than Symphony 4.0, or earlier than Avid Newscutter 8.0), if an Avid editing application user edits a locator and checks in the clip, duplicate locators might be displayed in Interplay Access.

- **Bug Number:** no number. Interplay v2.0 does not support locators created in Avid Airspeed.

**Mount Workspaces for Long GOP STP (Assist and Instinct)**

- **Bug Number:** UDevC00123047. If your workflow includes sending Long GOP (XDCAM HD or XDCAM EX) media to playback, you need to do the following:
  1. Log in to the ISIS Client Manager with an account that has write access to one or more workspaces.
  2. In the Client Manager, mount at least one of the workspaces to which you have write access as a lettered drive.

When you send to playback, the application searches the workspaces to which you have write access and writes a temporary file to a Temp folder at the top level of the workspace with the most free storage space. If you do not have workspaces mounted as lettered drives, you get an error message “Unable to find a shared storage volume for media transfer.”
Relinking Offline Media for Precomputes

Bug Number: UDevC00116797. The term precomputes refers to the media files created when you render an effect or title. The precomputes associated with a sequence can appear offline in the following cases:

- After restoring the sequence from an archive
- After moving the media files associated with a sequence to a different workspace

To refresh the links for offline precomputes:

1. Select Reset Offline Info from the Bin Fast menu

   The system refreshes the links to all of the precomputes in the project. If a sequence is loaded in the monitor, the system automatically reloads the sequence.

Interplay Access and Force-Delete Locked Media

Bug Number: UDevC00117091. The “Force-delete locked media” option was introduced in Interplay Access version 1.4.2. If you connect Access to an Interplay Engine running a version earlier than 1.4.2, the option is visible in the Delete dialog box but does not work. If you select the option and attempt to delete files, the files are not deleted and “access denied” is displayed in the Delete Summary dialog box.

Workaround: In the Avid editing system, locate the clip you want to delete in a bin. If it is not in a bin, drag and drop it from the Interplay Window. Select the clip in the bin and then select Clip > Unlock Bin Selection. You should then be able to delete the clip and the media from Interplay Access.

Changing Source Information for a Clip in Interplay

There are two types of source information that usually should not be changed for a master clip in an Interplay environment:

- Source tape name
- Timecode format (changing between drop frame and non-drop frame)

The tape name and timecode format are part of the source information for a clip and changing them may cause the clip to become offline whenever Dynamic Relink is activated. Once this happens, the relation of the clip to its media can be permanently lost.

If it is necessary to change the tape name or timecode format for a master clip in an Interplay environment, use the procedure described in this section.
You only need to perform this procedure if both of the following statements apply:

- If your site uses Dynamic Relink. If your site does not use Dynamic Relink there is no need to perform the procedure.
- If you are associating a master clip with a different tape name or timecode format. If you are simply changing the name of an existing tape you don’t have to perform the procedure.

**To change the tape name or timecode format for a clip in an Interplay environment:**

1. Disable Dynamic Relink. See the Avid editing application Help or the Interplay Help for information on Dynamic Relink.
2. Right-click the master clip in the bin and select Modify > Set Source.
3. To change the tape name, do the following:
   a. Select Set Source from the Modify dialog box popup menu. The Select Tape dialog box opens.
   b. Change the source tape name. Use an existing tape name or create a new one.
4. To change the timecode format to drop or non-drop frame, do the following:
   a. Select "Set Timecode Drop/Non-drop" from the Modify dialog box popup menu.
   b. Select the format and click OK.

*The media will remain online at this point because Dynamic Relink is turned off.*

5. Consolidate the clip to generate new media that will be associated with the newly selected tape name. Use the following options:
   - Uncheck “Skip media files already on the target drive”
   - (Option) check “Delete original media files when done”
   - Use the default settings for all other conversion parameters

The system generates new media files that will reference the correct tape name or timecode format. See the Avid editing application Help for additional information on the Consolidate command.

6. Re-enable Dynamic Relink.
7. Double-click the clip in the bin to trigger the relink. The media will be online and linked correctly to the adjusted tape name.

**Automatic Reservation Limitations**

You can set the value for automatic reservations in the Avid Interplay Administration tool using the Editor Database Settings view. This section specifies the behavior of automatic reservations for this release.
Automatic reservations now work correctly for the following situations:

- If you **duplicate metadata** (such as a master clip or sequence) in the Avid editor application bin and then check it into Interplay.
- If you **create new metadata** such as a new sequence, subclip, or title and check it into Interplay.
- If you **create new media** in a bin and then check it in. This includes operations such as import, capture, and consolidate.

## Write Permission in Interplay Applications

➤ **Bug Number:** UDevC00099462. Interplay Access has different rules for allowing a user to modify a clip in a folder that they do not have write permission to. The rules are different from Assist, Instinct, and the Interplay Window. For this discussion, assume the following:

- The user has been given write access in the Instinct/Assist User Settings window of the Interplay Administrator tool. For example, the user is allowed to modify locators or to modify column properties.
- The clip exists in at least one folder that the user has write permission to.

In Access, the system checks whether the user has write permission on the current folder. If the user does not have write permission to this folder, the user cannot modify the asset in that folder.

In Assist, Instinct, and the Interplay Window, the system checks whether the user has write permission to any folder that contains the clip. As long as the user has write permission to at least one folder that contains the clip, the user can modify that clip in any folder.

## Viewing Referenced Assets in Assist

In Assist, you cannot view the master clip associated with a subclip in the same folder. In the Avid editing application and in Access, you have the option of displaying referenced assets in the same bin or folder. You do not have this option in Assist. This is not usually a problem. For example, if you are working with a subclip in Assist, you usually have no need to see the master clip it was created from. You may encounter this problem if you move subclips and their associated masterclips in and out of folders in Access. Masterclips will not be visible in Assist if that folder once held the same clips as referenced assets. Once a subclip goes into an Assist folder, the display for the referenced asset is turned off. You may also receive a message telling you the clip already exists in that folder.

### To view a referenced clip in Assist:

- In the Avid editing application, check the referenced master clip(s) into Interplay, using the "Show Reference Clips" option in the editing application bin.

  Now the master clip is an unreferenced asset and an Assist user can view the master clip.
Limitations

General

See the following ReadMe files for additional information:

- Avid Service Framework
- Interplay Transfer
- Interplay Media Services
- Interplay Assist
- Avid Instinct

Bug Number: UDevC00106180. Interplay and Avid editing systems: If Auto-reservation is enabled (in the Interplay Administrator), but reservations are deactivated for a particular folder ("Allow creation of reservations" is deselected in the Security options for the folder in Interplay Access), a user on an Avid editing system can check an asset into that folder but there is no message to warn the user that the asset is checked in without a reservation. This could be a problem if the user assumes auto-reservation is enabled for the folder but in fact the content of that folder is not protected.

Bug Number: UDevC00119218. Partial restore is not supported when OMF media or MXF media are transcoded using an Avid editing application. A full restore is performed instead.

Bug Number: UDevC00113195. Media Indexer Quarantine: If you use Windows Explorer to copy a large MXF media file (larger than 1 GB) from an external drive to shared storage, the Media Indexer may quarantine the file before it is finished copying. The problem occurs if the Media Indexer starts scanning the drive before the copy operation is completed.

Workaround: When copying large MXF files to shared storage, do not copy the file directly to the Avid MediaFiles\MXF folder. Copy the file to another folder on the workspace (such as the Creating subfolder within the Avid MediaFiles folder) and then move the file into the MXF folder. This way the copy operation will be fast enough so that the Media Indexer won’t move the file into the Quarantine folder.

Bug Number: UDevC00113305. Media Indexer: If you try to use Windows Explorer to copy media from a network share or any folder not indexed by Media Indexer to an indexed folder (OMFI MediaFiles or Avid MediaFiles), you might get an Access Denied message.

Workaround: Copy the media files to the Creating subfolder (within the OMFI MediaFiles or Avid MediaFiles folder) and then move them to the media folder.

Also, if you were able to copy media to an indexed folder and then need to move or delete the files, or if they are quarantined and need to be deleted, you might get an Access Denied message. Workaround: Wait a few minutes and try the operation again.
Bug Number: UDevC00121042. Assist: If you load a clip that is being captured (an Edit-While-Capture or EWC clip), and then modify the Audio/Video Monitoring preferences and click OK, the preferences do not persist. If you then load a completed clip, you can scrub through the clip but you cannot play it, and you need to relaunch the application.

Workaround: Change the Audio/Video Monitoring Preferences before loading the EWC clip. This problem does not occur if you change the Audio/Video Monitoring preferences while the EWC clip is playing.

Bug Number: UDevC00120939. Interplay and Avid editing application): If the working resolution is not set in the Instinct/Assist User Settings in the Interplay Administrator, the following error message appears when you log in to Interplay: “No Working Video Resolution Set, Dynamic Relink will be disabled.” This message is incorrect, because this setting does not apply to an Avid editing application.

Workaround: Close the error message and continue working. To avoid display of the error message, set the working resolution in the Instinct/Assist User Settings in the Interplay Administrator.

Bug Number: UDevC00118842. Edit while capture with AirSpeed Multi-Stream. If you play a currently ingesting HD clip in an editing application, the audio might drop out while the video continues to play. When the dropout occurs depends on the compression of the clip, but it can be up to a minute after the live feed begins.

Workaround: Precut the clip to the head frame in the editing application and restart play.

Bug Number: UDevC00121373. Interplay Assist and Avid editing applications: In Assist, when you apply a locator to an audio-only sequence, or to a sequence without a V1 track, the locator appears on an empty V1 track in the Avid editing application timeline.

Bug Number: UDevC00116644. Interplay Assist and Avid Instinct: If you start the application shortly after quitting, you might see an "Unknown Exception" error message

Workaround: Wait 10 seconds and log in again. If you still see the error message, close the application and relaunch it.

Bug Number: UDevC00118600. Interplay Assist, Avid Instinct, Interplay Window: If you create a subclip from a master clip with the resolution displayed as "XDCam HD 50mb 1080i 60," the resolution of the subclip will be displayed in the Current Video Resolution column as "XDCam HD 50mb."

Workaround: Assist and Instinct: If you need to determine the complete resolution for the subclip, move the mouse pointer over the title of the clip (above the monitor) and the complete resolution is displayed.
➤ **Bug Number:** UDevC00106005. FTP ingest of 1080p 23.97 proxy files fail to import when dragging and dropping the proxy only clip to a bin from FTPClipList.

**Workaround:** You can use a firewire connection to import the 1080p 23.97 proxy file.

➤ **Bug Number:** UDevC00115806. Assist Locators: You can add multiple locators to the same frame in Assist but you cannot view more than one locator in the Avid editing application timeline.

**Workaround:** In the editor, click the Locator and select the Locator window from the Tools menu.

➤ **Bug Number:** UDevC00115457. Assist – You cannot use Assist to play back a sequence with more than 16 tracks.

**Workaround:** Select Preferences > Audio/Video Monitoring and turn off the additional tracks.

➤ **Bug Number:** UDevC00115102. XDCAM EX and FTP Clip List – Ingest via FTPClip List does not work correctly for XDCAM 720p 5994 EX 35Mbit.

**Workaround:** Imports via 1394 firewire works correctly. Also, 720p 5994 50 Mbit works correctly for FTPClip List

➤ **Bug Number:** UDevC00110280. On the Media Indexer server, if you change the language locale option after you install Media Indexer and then restart the server, the MI service might stop and restart constantly. Similarly, if you selected “Install files for East Asian Languages” in the Languages tab of the Windows Regional and Language Options control panel and then reinstall or update Media Indexer with an English locale selected, the MI service might stop and restart constantly.

**Workaround:** Change the language locale before you install or update Media Indexer. If you are going to use an English locale, deselect “Install files for East Asian Languages” before you install or update Media Indexer.

➤ **Bug Number:** UDevC00113671. If you increase the duration of a currently ingesting AirSpeed Multi Stream clip in Capture Manager™, you might not be able to play the clip beyond the original duration and you might see an error message.

**Workaround:** Make sure you set the initial duration of the clip to be longer than what you need.

➤ **Bug Number:** UDevC00111283. When you import P2 media from a virtual volume, the system adds a duplicate storage path for the Media Indexer. The additional path is visible in the Service Framework Service Configuration tool.
Workaround: Open the Service Configuration tool, locate the local Media Indexer on the editing system, and remove the extra storage location.

➤ **Bug Number:** UDevC00116123. In Assist or Instinct, currently ingesting media from IPV playback may stop after a couple a minutes or longer depending on the length of the ingest.

➤ **Bug Number:** UDevC00115587. When archiving a folder which contains a sequence and it's relatives, the job will display the sequence and each relatives as a separate transaction in the Job Status window.

➤ **Bug Number:** UDevC00105694. Custom fields from Assist do not appear in the editor bin.

➤ **Bug Number:** UDevC00117478. The Archive Engine will display the incorrect size of an asset.

➤ **Bug Number:** UDevC00117286. If you import media from a P2 drive and create a sequence with the media that is still on the drive, performing a Send to Playback operation consolidates the media to an incorrect drive.

**Workaround:** Consolidate the media from the P2 drive before you send to playback.

➤ **Bug Number:** UDevC00113856. If you check in a sequence that uses master clips that are currently being ingested, then open Interplay Access, the sequence appears as partially online (blue), although the sequence is actually online. This also applies to .transfer sequences.

**Workaround:** To update the status, select the items, right-click, and select Update Status from Media Indexer.

➤ **Bug Number:** UDevC00112191. Archive Restore: “No resolution found” errors after performing a Restore from Archive operation.

**Workaround:** If you receive this type of error when performing a restore, right-click the clip and select Update Status from Media Indexer, and perform the restore operation again.

➤ **Bug Number:** UDevC00100643. If you connect an NLTEK drive to the same Firewire bus as the Adrenaline hardware, the system competes for resources on the bus and video may stutter when playing back from the NLTEK device.

**Workaround:** When connecting an NLTEK drive to an Adrenaline system, connect the NLTEK drive and Adrenaline hardware to different Firewire buses

➤ **Bug Number:** UDevC00105508. When performing a “Check into Interplay for Pro Tools,” two of the three options for Audio Mixdown do not work correctly if you apply the setting from the Avid editor. Selecting "No Mixdown" results in a Stereo Audio Mixdown and selecting "Stereo Mixdown" results in No Audio Mixdown. Selecting "Mono Mixdown" works properly.
Limitations

**Workaround:** Select the option for the setting in the Interplay Administrator > Editor Export Settings for Pro Tools view.

➤ **Bug Number:** UDevC00096276. (Limitation with Interplay Media Services) Clip names containing more than 255 characters are not supported when using Interplay Media Services.

➤ **Bug Number:** UDevC00096276. (Limitation with Interplay Media Services) Clip names containing more than 255 characters are not supported when using Interplay Media Services.

➤ **Bug Number:** UDevC00099173. (Interplay Media Services) In an Avid editing application, after you deselect and then reselect the Media Services setting "Media Services are Available," the list of providers in the Media Services sub-menu is not accessible.

**Workaround:** To provide access to the list of Media Services providers from the Avid editing application you must exit the Avid editing application and restart it.

➤ **Bug Number:** UDevC00099633. Do not use the Windows “Fast User Switching” feature in an Interplay environment. It can lead to confusion about whether the correct drives are mounted for each user. For example, if an Administrator logs on and mounts all drives and then switches to a user that only has access to one or two drives, all drives will still be mounted.

➤ **Bug Number:** UDevC000999012. Interplay Engine E-mail service might be unreliable if there are too many event notices in a short time frame. Some events might be dropped. **Workaround:** A large number of event notices indicates a problem, so the administrator needs to Investigate the problem in any case.

➤ **Bug Number:** UDevC00099003. Interplay Engine When the Interplay Engine server sends e-mails, it uses the login of the Server Execution User. Make sure the mail server is aware of the username and password of this account (usually a domain account). If not, the mail server might reject the e-mail request. For information on email notification, see the *Interplay Engine and interplay Archive Engine Administration Guide*.

➤ **Bug Number:** UDevC00099458. Interplay Administrator: For best performance, a list of values for a custom property (created in an XML file) should have fewer than 20 entries, and you should not activate more five custom properties that use a list of values. For information on creating custom properties, see the *Interplay Engine and interplay Archive Engine Administration Guide*.

➤ **Bug Number:** UdevC00096607. During AutoArchive any failed archives are submitted continuously and exceed the maximum number set by the retry setting in the Avid Interplay Service Configuration > Service Settings > Configure AutoArchive window.

**Workaround:** Set the maximum number of retries for a failed job to 1. When a job fails it is moved to the failed folder.
Limitations

➤ **Bug Number:** UDevC00089277. VC-1 Resolutions are not supported in Interplay v1.2.x or Interplay v1.4.2. VC-1 support was added to the Avid editing applications at the x.8 release (for example NewsCutter v6.8). However, VC-1 resolutions are not supported in an Interplay environment. VC-1 is a SMPTE 421M video codec standard.

➤ **Bug Number:** UDevC00093731. Limitation When using Frame Chase Editing (EWC), if you try to transcode subclips after the capture is complete, the transcode fails indicating the clip is still being captured even though the master clips display “complete”.

**Workaround:** After the master clip of the subclip is complete, re-checkin the subclip to the Interplay database before you start the transcode.

➤ **Bug Number:** UDevC00096386. Interplay Assist Send to Playback: If you perform a “Send Source to Playback” command on a source clip that contains restrictions, the system does not warn you that the clip contains restrictions. Note that the system does display a restriction message when you load the clip in the Source monitor so you are warned at least one time.

➤ **Bug Number:** UDevC00093002. Installing from shared storage: At large sites it is often useful to copy installers to a central shared storage location and run the installers from there. Sometimes when you do this the installers may display an I/O error or complain of a bad or corrupt file. If this problem occurs, copy the installer locally and run it or run the installer from the Avid Interplay Installer.

➤ **Bug Number:** UDevC00092387. Interplay Access license: When you use up all of your Access licenses and try to log in, the system displays an incorrect error message. The error message states that the evaluation period has expired. It should state that you cannot log in because there are no more licenses available.

➤ **Bug Number:** UDevC00093257. You might receive an access violation error while dragging multiple clips from the Interplay Window into a bin. This occurs if you select an individual clip, drag it to the bin and then repeat the process quickly.

**Workaround:** Select multiple clips and drag them to the bin.

➤ **Bug Number:** UdevC00093580. When performing a partial restore of a large sequence, the Job Status and progress bar displays a percentage of the completed job until the Restore Provider is finished processing the job. The process might appear hung during this time.

**Workaround:** You can monitor the Restore Provider to check the job's activity.
Limitations

➤ **Bug Number:** UDevC00092202. If you have used the NXNServerUser.exe tool to change the Server Execution user, the Interplay Engine installer uses the old value when you upgrade to this release. In this case, if you don’t use Custom install and supply the correct value, you will have problems with the cluster. For example, the cluster will not be able to fail over.

**Workaround:** On a cluster, use the Custom install option and make sure you supply the correct Server Execution user when prompted. See “Checking the Server Execution User Account on a Cluster System” on page 28.

➤ **Bug Number:** UDevC00092128. Checking a Bin into Interplay while a capture is in progress: If you check in a bin while a capture is in progress, the clip associated with the capture may not be checked into the Interplay database.

**Workaround:** Perform an Update Status from Media Indexer command in Interplay Access and the status will be correct.

➤ **Bug Number:** UDevC00086972. Media Services Transcode: If you submit two transcode jobs for the same source file, and each job uses a different provider, the transcode might fail with a DISK FILE NOTE FOUND error.

**Workaround:** Try the operation again. If you get the same error message, check if the source clip is corrupted, that your configuration is correct, and that all Interplay components are running correctly.

➤ **Bug Number:** UDevC00087103. Media Indexer: If the media indexer service does not start after a reboot you will need to manually start it using the Avid Interplay Workgroup Properties tool.

You must use Interplay Service Configuration tool to ensure that the Avid Service Starter Service automatically restarts other services, such as the Interplay Media Indexer service. For more information, see the Interplay Software Installation and Configuration Guide.

➤ **Bug Number:** UDevC00091228. Selecting Check In All Open Bins from the Fast menu in the bin might not check in the open bins.
**Workaround:** To check in all open bins, select Check In All Open Bins from the File menu.

**Bug Number:** UDEV00091445. “Check into Interplay for Pro Tools” command: Automatic renders occurring during command execution appear offline for the Pro Tools editor if the source media is on a local drive.

**Workaround:** If you have a sequence that contains local media and you apply effects to it, render the sequence in to out and explicitly select a shared Unity volume during your manual render. After the render is complete, use the Check into Interplay for Pro Tools command.

**Bug Number:** UdevC00090469. Disconnect mode: If you are working on an editing system that is disconnected from Avid Interplay (using Disconnected Client mode), you cannot create OMF audio. If OMF is selected as the media type in the Media Creation settings, and you open the Audio Project setting, the Audio File format is set to PCM and cannot be changed.

**Bug Number:** UDEVC00090431. In Interplay Assist, if you change the name of a clip and then archive it, the original name (not the new name) appears in the Job tab of the Interplay Media Services window. The name appears correctly in the Archive Manager and is archived correctly.

**Bug Number:** UDevC00090855. In Interplay Access, the Disk Label field does not display the XDCam disk label.

**Bug Number:** UdevC00090905. The Migration Tool supports the default SQL server setup. The tool does not support a SQL server using an instance name or port other than the defaults.

**Workaround:** You can either reinstall the SQL server using the default setup or run the Migration Tool from another SQL server. To use a non-standard port number, you need to enter the hostname in the Migration Tool using one of the following formats:

mySQLserver:4027 or mySQLserver/portNumber=4027

In this example, mySQLserver is the hostname of the SQL server, and the port number used is 4027.

**Bug Number:** . You cannot perform a partial restore operation with OMFI media files. If you want to take advantage of partial restore with material that you have migrated from a MediaManager environment, you must re-archive the material in an Interplay archive.

**Bug Number:** UDevC00088720. Interplay Assist memory problems and sluggishness. If Interplay Assist encounters .pmr files in the Avid MediaFiles folder on shared storage, it will attempt to work with the files. This can interfere with the application’s use of the Media Indexer to locate files and can cause Assist to have memory problems and sluggishness. The .pmr files are used by standalone Avid editing applications (editors that are not connected to Interplay).
**Workaround:** Check the shared storage areas used by Assist for .pmr files. Look in the Avid MediaFiles folder. Either delete the .pmr files or point Assist to another workspace.

- **Bug Number:** UDevC00090952. In Interplay Assist, if you select Media > Mount Volumes, the Scanning for New Volumes window opens and does not close. You can continue to work by clicking in the Assist application, but the Scanning for New Volumes window stays open behind the application.

  **Workaround:** Mount the drives you need before you start Interplay Assist.

- **Bug Number:** UDevC00081178. FTP Ingest of XDCAM HD 24p is not supported.

  **Workaround:** Use the Firewire ingest method. For details, search for “Connecting the XDCAM Device” in the Help for your Avid editing application.

  Avid MediaStream™ native ingest is not supported for this release.

- **Bug Number:** UDevC00090719. Audio clips that are online may display a partially online icon in the bin. You can play and edit the media normally and the clips appear correctly in the Timeline.

- **Bug Number:** UDevC00090212. Clips captured from an Airspeed system through Capture Manager might display the Creation Date as the completion time instead of the start time. This is possible with clips 30 minutes or longer.

- **Bug Number:** UDEVC00090615. Using 720p media with Assist: If Dynamic Relink is turned on for Assist and Instinct, you cannot hear the audio portion of a 720p clip that was captured by AirSpeed.

  **Workaround:** Turn off Dynamic Relink for Assist and Instinct as follows: Open the Interplay Administration tool, open the Editor Database Settings view, and select False to disable Dynamic Relink. Note that this turns off Dynamic Relink for all Assist and Instinct users.

- **Bug Number:** UDEVC00088720. Avid Assist and .pmr files: If there are .pmr files present on a shared storage workspace, Assist can have performance problems because it attempts to use the .pmr files and Media Indexer information at the same time. Note that .pmr files are created by standalone Avid editing applications that are not part of the Interplay environment.

  **Workaround:** Check the workspace for an Avid MediaFiles folder or an OMFI MediaFiles folder containing .pmr files. Determine whether you should delete the folder or have the Assist applications use a workspace that does not contain those folders.

- **Bug Number:** UDevC00089372. In Avid iNEWS, you cannot use the German characters “µ” or its uppercase equivalent “M” in the directory tree for folder or queue names.
Bug Number: UDevC00085343. If you run multimedia third-party software on your Interplay Assist system, you might not be able to play video and audio, even though you can see the video when you shuttle through.

Bug Number: UDevC00088912. If you create locators in Interplay Assist and then update them in an Avid editing application, the locators don't update within Assist even if you press F5 to refresh the application.

Workaround: Reload the shotlist to see the updated locators.

Bug Number: UDevC00086432. Dynamic Relink, FlightPlan, and 720p 59.94 and 50 media: The audio can go offline for these resolutions if you have dynamic relink turned on and set to the default “if no match is found, Relink to Offline”. This only happens when you use FlightPlan to transfer Airspeed-captured media to a bin.

Workaround: If the audio goes offline in this case, change the Dynamic Relink setting to “Closest Media”. Then right-click the clip in the bin and select “Update from Interplay” to update the clip.

Bug Number: UDevC00085624. Checking out a sequence while the original sequence is loaded in the source monitor might crash the Avid editing application. This only happens if you have the sequence loaded and are in either Effects mode or Color Correction mode.

Bug Number: UDEVC00078370. Sequence with Color limiter effect on filler might crash Avid Assist.

Workaround: Render the effect in the Avid editing application.

Bug Number: UDevC00080383. Cannot save Boris Effects templates to bin after checkout from Interplay.

Workaround: Save the template to a bin before checking the sequence into Interplay.

Bug Number: UDEVC00054142. Bin display settings for the Interplay Window do not persist when changing folders.

Workaround: You can select the media search tab and then go to the bin menu and select Set Default Interplay Window Display. However, by doing so, you change all folders views within interplay.

Limitations

**Workaround:** Use the Bin > Consolidate/Transcode command in the Avid editing application.

➤ **Bug Number:** UDevC00079824. AutoArchive: If you attempt to perform an AutoArchive operation with a profile that does not exist, the system returns the following error: “Unable to start job...ProviderException: 20...Parameter missing...” This can happen if you assign a profile to an Autoarchive folder and then delete the profile later on.

**Workaround:** Assign or create a new profile for the autoarchive folder.

➤ **Bug Number:** UDevC00078380. Media Services Transcode: You cannot use Media Services Transcode to transcode a motion effect clip. The system displays the error “Invalid Media Type. Transcode Failed.”

**Workaround:** Do one of the following:

- Use the Bin > Consolidate/Transcode command in the Avid editing application to transcode the motion effect clip.
- Transcode the source master clip that makes up the motion effect using either Media Services or Avid editor transcode.

➤ **Bug Number:** UDEVC00050258. If you restart the Media Services engine while the Archive, Restore, or Transcode providers are running, the services do not start up automatically, even if you have configured them to do so.

**Workaround:** Quit and restart the services.

➤ **Bug Number:** UDEVVC00051583. Checking in a Duplicate clip with a restriction: If you create a duplicate of a clip that contains a restriction, and then check the clip into the Interplay database, the red triangle doesn’t automatically appear on the duplicated clip.

**Workaround:** Click the duplicated clip in the Interplay Window (to set focus to the window) and press F5 (to refresh). The red triangle appears.

➤ **Bug Number:** . Custom Metadata fields: If you create custom metadata fields in the Interplay Administrator, Interplay Access, or Interplay Assist, you cannot delete them or turn them off for this release. However, you can now turn off the display of individual custom metadata fields. See the *Avid Interplay Access User’s Guide* for more information.

➤ **Bug Number:** UDevC00090853. 720p – 220/185x Rolling Crawling Titles and Dynamic Relink: When using 720p – 220/185x, you cannot use the “relink to offline” and “specific resolution/dnx220x” Dynamic Relink settings with a rolling title that is more than two pages long. The system displays a wrong format error when you load the title in the source monitor. The title becomes corrupt and must be recreated.
Workaround: Turn off Dynamic Relink and recreate the title media. The problem does not occur if you use the “Use Closet Media” value in the “if no match is found” setting.

Bug Number: UDEVC0051900. Rendered titles show two resolutions in Interplay Access. This is as designed. When the Avid editing application renders a title, it creates two media files: one in the target resolution, and a second in MXF 1:1 resolution. When you check the title in to Avid Interplay, both media files are checked in. Interplay Access lists the MXF 1:1 resolution as the current video resolution. When you delete a rendered title from Interplay Access, select both resolutions.

Bug Number: UDEVC0025865. If you perform a Bin View Save As operation for a bin that contains resolution columns, the resolution columns are not saved. Any other columns you saved will work correctly. When you apply that Bin View to another bin, the system displays the following error message:

“One or more columns in the view are not relevant in this kind of project and will not be displayed.”

Workaround: Manually add the resolution column to the bin.

Bug Number: UDEVC00052480. Batch Import of files containing Alpha: This problem occurs if you want to batch import files in SD and HD formats and then use Dynamic Relink to switch between the different formats. The problem occurs with QuickTime movies, graphics, and sequences that contain alpha. You can batch import the files and relink to the different formats, but if you exit and then restart the Avid editing application, you can no longer relink to the HD format. The system displays an “Exception: NO Compressed Data Format found” error message.

Workaround: You cannot use Dynamic Relink with HD and SD clips that contain alpha. Import the HD files with alpha as individual clips. When you want to switch to HD format, edit the HD versions into your sequence.

Bug Number: UDEV00230928 UDevC00026052. XDCAM HD imports: If the Avid editing application is using more than 40% of available memory, importing XDCAM HD low-resolution proxy clips into a bin might fail with a bad allocation exception error message.

Workaround: Close some bins to free up memory (especially bins containing many objects). You can view the memory usage in the Bins tab of the Project Window.

Bug Number: In Avid Interplay Assist and iNEWS Instinct, avoid displaying more resolution columns than you need. The system frequently updates the status in the resolution columns and having too many active can affect performance. Sequences can be especially slow to update when there are many resolution columns. Once columns are displayed, they continue to impact
performance for that session even if you hide them. If you reduce the number of resolution
columns and save the column layout, you won’t see a performance improvement until you restart
the application.

➤ **Bug Number:** UDEV00225692 UDevC00024104. Folders containing assets marked with
reservations appear in Interplay Assist, Instinct, and the Interplay Window with the reservation
marker, but the individual asset type icons in the Research panel do not display the marker.

➤ **Bug Number:** UDEV00218247 UDevC00024136. Delete dialog box naming conventions:
Some of the naming conventions in the Interplay Access Delete dialog box do not match the
resolution names in the Avid editing application bin. For example, the following list shows some
differences.

<table>
<thead>
<tr>
<th>Media Composer bin</th>
<th>Delete dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dnx145</td>
<td>DnX HD 6:1</td>
</tr>
<tr>
<td>1:1</td>
<td>Uncompressed</td>
</tr>
<tr>
<td>DVCPro HD</td>
<td>DVCPro HD 9:1</td>
</tr>
<tr>
<td>Dnx220</td>
<td>DnX HD 4:1</td>
</tr>
</tbody>
</table>

**Windows User Account Requirements**

The following limitations exist for Interplay:

➤ **Bug Number:** UDevC00052215. Avid editing applications such as NewsCutter, Media
Composer, and Symphony that are part of an Interplay environment can use a regular Windows
User login. However, when you install the application you must first log in as an Administrator,
install the application, and initially launch the application as an Administrator. See the Avid
editing application Readme for details.

➤ **Bug Number:** UDevC00088970, 89118. Avid Assist and Avid Instinct have similar limitations:
When you install the application, you must first log in as an Administrator, install the
application, and initially launch the application as an Administrator. You may then subsequently
run the application as a regular User.

➤ **Bug Number:** UDEV0098723. Regular Windows user login and Media Creation tool: When
you select Auto-Indexing in the Avid editing application Media Creation tool, the system creates
duplicate storage items in the Media table for the local Media Indexer. This can happen every
time the Media Indexer scans the local storage drives or P2 drives. If it continues to occur the
Media Indexer can become unresponsive and you could get Media Offline messages.
**Workaround:** To determine whether you are experiencing this problem, open the Service Configuration tool, select the editing system, and then select the Media Indexer process. Click Configure, and see whether there are duplicate entries for your local storage locations. If there are duplicate entries, delete the duplicate entries and do one of the following:

- Periodically check the Service Configuration tool and delete the duplicate entries
- Log on as a Windows Power User or Administrator.
- Disable the auto-indexing feature. Instead, click on "Manual scan" every time changes are made to the drives available to the editing system.

---

**Clips from the Same Tape That Have Overlapping Timecode**

➤ **Bug Number:** UDevC00055238, UDevC00055241, UDevC00055244, UDevC00055249. This section describes several limitations that involve clips from the same tape that have overlapping timecode. The problem is most evident when the two clips are captured at different resolutions. This can happen when you do the following:

1. Use the Capture tool to capture a clip.
2. Change the capture resolution.
3. Back up the tape a little, and start capturing again at the new resolution.

Now you have two clips and two separate media files. The end of the first clip and the start of the second clip share the same timecode.

You see the following problems with these clips:

- In the Interplay Access Object Inspector, each clip displays as a separate media file, each at its captured resolution. However, the Avid editing application sees the clips as sharing media. If you display the clips in an editor bin and display column headings for both resolution types, both clips show at least a partially online status for each resolution.

- If you send the low-resolution version of the clip to Media Services Transcode, the system uses the high resolution for the Transcode. This produces a higher-quality result but takes longer than transcoding a low-resolution version.

- If you delete the media from the first clip and then load the clip into the editor Source monitor, you see the media from the second clip. However, if you attempt to Transcode the clip, you get an error message because the actual media for the clip has been deleted. This can be confusing because you see an online version of the clip but can’t transcode it. The clip is linking to a different media file in the editor Source monitor but the media is not associated with the metadata for the clip.

In this last scenario, if you look at the clip in the Interplay Access window, you see a red X that indicates that the media is not available. There is no corresponding display in the editor bin.
Disabling the Onboard NIC on an HP xw8400 Causes System Instability

UDevC00055194 The Avid Interplay Software Installation and Configuration guide contains the following information:

Computers with Multiple Network Interfaces

“If you have multiple network interfaces on a computer and one is not used, use the Device Manager to disable the interface. If not, the computer may have problems communicating with the Service Framework Multicast Repeater.”

The following information should be added to that section regarding the HP xw8400:

Do not use the Device Manager to disable the onboard network interface card on an HP xw8400. Doing so could cause intermittent hard hangs (no keyboard input or mouse movement) or other system instability such as unexpected reboots. Instead, use the following procedure.

To disable the onboard network interface card via the BIOS:

1. Boot, or reboot, the system
2. Press the F10 key when prompted to enter BIOS setup
3. Choose your preferred language when prompted to enter Setup.
4. Once into the BIOS, use the right arrow to navigate to the Security Menu
5. In the Security Menu, select Device Security
6. In the Device Security selection window, use the down arrow to select the Network Adapter.
7. Use the right arrow to change the option to read “Device Hidden” instead of “Device Available.”
8. Press F10 to save your setting change.
9. Press F10 again to get to the Save Changes and Exit prompt.
10. Press Enter to select Save Changes and Exit.
11. Press F10 to Save and Exit.

International Character Support Limitations

Bug Number: UDevC00163794. Receiving workgroup transfers from a remote workgroup to a workspace containing Chinese characters can fail. The transfer fails with a kNetwork error.

Workaround: When using Workgroup transfers, ensure that the name of the receiving workspace does not contain Chinese characters.
Bug Number: UDevC00148244. (Archive) In an SGL archive environment, you cannot archive transcoded media that contains Japanese characters in the name. The .mxf files created have Japanese characters in their names. To archive the files, underscores must replace the Japanese characters.

Workaround: Do not use Japanese characters in the clip name when you transcode. Add Japanese characters to the clip name after you transcode, or use ASCII characters.

Bug Number: UDevC00149617. (Avid editing systems) A sequence name is limited to 128 characters in Chinese.

Bug Number: UDevC00149616. (Interplay Access and Interplay Administrator) Drop-down menus for selecting custom properties do not display multibyte characters after importing an XML file containing multibyte characters.

Bug Number: UDev00089590. Workspace names: Workspace names that contain non-ASCII characters can cause poor performance when working in a bin.

Workaround: Use only ASCII characters in workspace names.

Bug Number: UDevC00089671. Workspace names in Asian characters might appear truncated at the end in any drive-selection list.

Workaround: When using Asian characters, use no more than 10 characters for workspace names.

Bug Number: . Archiving does not support ICS for this release.

Bug Number: UDevC00052231. If you enter Asian characters as restriction information, the characters might appear as question marks when you view that restriction in another Avid application.

Bug Number: UDevC00051060. If you change the font or font size of your input, and see characters rotated 90 degrees, make sure you select the correct font. Do not use any font that begins with the “@” symbol.

Bug Number: UDevC00052541. Do not create a Project using the Euro currency character (ALT 0128). The Project fails to be created and a “Can't Open Project” error message is displayed.

Bug Number: UDevC00022395, 22346. Certain Asian characters might not appear in the correct order in some text boxes in your Avid editing application.
Bug Number: UDevC00078651. Use only ASCII characters in passwords.

Interplay Access Limitations

Bug Number: none. Compatibility with prior versions: The Interplay Engine or Interplay Archive Engine and the Interplay Access client must be updated at the same time. Interplay Access clients will not work with older Interplay Access Engines or Archive Engines and vice-versa.

Bug Number: UDEVC00035172. Multi selection drag and drop issue when one file asset already exists in target folder: When a multi selection is dragged and dropped and one of the file assets exists in the target folder already, no files are moved and the results are not as the user would expect. This is the result of a rollback of the transaction and appears as follows:

- Red check marks (indicating a check out) turn blue. The checkout path has already been moved to the new location, so when the file is moved back to the original location but the checkout path is not updated again, the check mark appears blue. These items can be checked in again safely.
- The local copies of not checked out assets seem to be deleted. The local copy of the asset is not actually deleted, it is just not moved back to the original location.
- The file that exists in the target keeps its local copy.

Bug Number: UDEVC00039014. Working in a folder during an import causes problems: When performing a large import, working in the same folder you are importing to might cause problems with the import. You might be prompted to refresh your view, in which case the import was successful. In other cases, a message indicates that the import failed and you need to perform the import again, without touching the folder.

Bug Number: UDEVC00038766. Get latest on extremely large folder causes problems for user Administrator: When the user Administrator performs a Get Latest on a folder that contains assets in number approaching 50,000, a potential problem might occur; the client slows down, but the operation actually continues. If the client reaches the free memory limit, a corresponding message is shown and the operation is cancelled. This does not occur if another user (not Administrator) has performed a Get Latest on the same machine already.

Workaround: Users should perform a Get Latest on the smallest range of items possible, such as a subfolder.

Bug Number: UDEVC00039061. Internally used file name appears for Avid Assets renamed to blank name: If a blank name or only spaces is entered in the Rename dialog for an Avid asset, the internally used file name (mob id) appears as the name instead (long string of numbers and letters).
Limitations

➤ **Bug Number:** none. Tree state is only remembered on the same machine: The tree state upon logout is remembered the next time you log onto Interplay only on the same machine (stored per user, per machine).

➤ **Bug Number:** UDEVC0007386. Issues with preview of large text files: Text files over 1MB are not shown in the Preview by default, however, if you explicitly click the Show File button for these large files, low memory problems may occur.

**Interplay Administrator Limitations**

➤ **Bug Number:** UDEV00210720, UDEVC00037618. Limited number of clients per user per machine: Only one Interplay Access instance and one Interplay Administrator instance can run at a time on one machine per user. This software will not support terminalserver sessions.

➤ **Bug Number:** none. Low disk space issues: In low-disk-space situations, the Administrator cannot log on and shut down the server, and move databases by normal means. There are tools provided to solve such problems (available in the Installation CD’s Tools directory or installed by default in the Server installation directory):

- NxNServerLock.exe
- NxNServerUnlock.exe
- NxNServerShutdown.exe

**To move databases under low disk space conditions:**

1. Lock the server using NxNServerLock.exe.
2. Shut down the server using NxNServerShutdown.exe, if necessary.
3. Move the databases to another drive or free up some disk space.
4. Unlock the server by doing one of the following:
   - Use the Interplay Administrator’s Lock Server view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details)
   - Use NxNServerUnlock.exe
5. Deactivate any moved databases using the Interplay Administrator’s Manage Databases view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details).
6. Activate any moved databases in the correct location using the Interplay Administrator’s Manage Databases view (see the *Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide* for details).
Limitations

➤ **Bug Number:** UDEV00039474. Passwords should only include ASCII character set: User passwords should only include the ASCII character set. Multibyte passwords might cause logon problems.

**Workaround:** If logon with a multibyte password fails, the administrator should reset the password in the User Management view of Avid Interplay Administrator.

➤ **Bug Number:** UDEV0006908. Limitation: Browse for new data location does not show mounted workspaces on Avid ISIS in the tree: In the Create Database view in the Interplay Administrator, when you click Browse in the New Data Location (Assets) section, the mounted workspaces on a Avid Unity™ ISIS® shared storage might not be shown.

**Workaround:** Type the path manually.

➤ **Bug Number:** UDevC0007123, UDEVC00039984. Voice over target workspace field says “No Items to Show”: An administrator logged in to the Avid Interplay Administrator may see “There are no items to show” in the Editor Database Settings view in the field Voice over target workspace field instead of the drives. This is intended behavior: the administrator must also be a Avid Unity user with the same credentials in order to see the workspaces of the Avid Unity. If the workspaces are not visible, check that:

- The user is a user on the Avid Unity.
- The user has the same password as the user on the Avid Unity.
- The Avid Unity is reachable.
- The user is allowed to see the workspaces.
- There are actually workspaces at all.

**Configuring Remote Workgroups**

➤ **Bug Number:** UDevC00051760. In order to use the Configure Remote Workgroup view in the Interplay Administrator tool, you must have matching Administrator accounts on both workgroups. The accounts must have the same user names and case-sensitive passwords. For more information on user names and passwords, see the *Avid Interplay Software Installation and Configuration Guide*.

**Archive and Restore**

➤ **Bug Number:** UDEV00052832. Archive Provider: Windows Message Queuing software must be enabled on the Archive Provider. If you perform a clean install on a system that will run the SGL FlashNet client, you must enable the Windows Message Queuing software. This applies to
any system running the Interplay Media Services Archive Provider. If the Windows Message Queueing software is not running, jobs fail to archive. For details, see the Interplay Media Services Readme.

➤ **Bug Number:** . Archive Provider: The Archive Provider also requires the SQL Native client software. This is usually installed and configured by your SGL representative. For more information, see the Interplay Media Services Readme.

### Checking in Avid Assets

➤ **Bug Number:** UDevC00092889. When creating and checking in a clip or finding a clip in the Avid editing application's Interplay Window, if the clip name contains a slash (\ or /), the application hangs for about one minute then returns to normal.

**Workaround:** Remove the slash from the clip name.

➤ **Bug Number:** UDevC00089019. Checking in bins with deleted clips: When you check in a bin, the Avid editing application determines whether clips need to be checked in based on whether you have modified them or added them to the bin since the last check in. If clips have been deleted from Interplay since the last check in, checking in the bin will not check in the deleted clips again. You need to force a check in of the deleted clips. To force a check in, select the clips and then select Check In To Interplay from the File menu or bin context menu. To force a check in of an entire bin, select all clips in the bin and select Check In to Interplay.

➤ **Bug Number:** . When you check a large sequence into the Interplay database from the Avid editing application, the check in can take several minutes. The system provides an initial progress bar to let you know that the checkin has initiated and that you can now get back to work with the application. However, there is no additional indication to tell you when the checkin has completed. This can be a problem if you check in a large sequence or a bin with many sequences and you don’t see it appear right away in the Interplay Window.

**Workaround:** If you check in a large sequence and it doesn’t appear right away in the Interplay Window or Access, return to the window in a few minutes to see if the checkin has completed.

### Deleting Files from the Interplay Database

➤ **Bug Number:** UDevC00025736. Try to schedule large file deletions (for example, over 300 GB) during off hours. A large delete operation can slow down the response time on the Avid Interplay Engine. This also slows down the response times on Avid editing applications that are working with the Interplay Window.
Bug Number: If you create shared media using a local bin, and later delete that media without ever checking the clips into the Interplay Window, the clips’ metadata is not deleted from the “Unchecked in Avid Assets” folder. An administrator can delete this metadata as part of normal system maintenance. This only happens to clips that have not been checked in to a folder in the Interplay window.

Dynamic Relink and Clips with Pulldown

Bug Number: Dynamic relink is not currently supported for media that requires pulldown. Therefore, you can only use it with clips where the media has been acquired at the native frame rate (without pulldown).

Dynamic Relink and Mixed Frame Rates

Bug Number: All resolutions that are eligible for dynamic relink must use the same frame rate. For example, you cannot dynamically relink a 30i master clip in the Timeline to 24p media. You can, however, dynamically relink a 30i master clip to a 1080i/59.94 master clip.

Editing

Bug Number: UDevC00083980. Viewing media folders in the Interplay database from Assist, Instinct, and Interplay Window: Occasionally when you launch Assist, Instinct, or one of the Avid editors, the following occurs:

- In Assist and Instinct, no media folders are visible in the Directory panel.
- In the Avid editing application, no project folders are visible in the Interplay Window.

Workaround: Restart Assist or Instinct. For the Avid editing applications, log out of the Interplay Window and log back in.

Bug Number: UDEVC00021278. Transcoding Titles: You cannot transcode the titles in a sequence to another resolution. If you transcode a sequence with a title in it, the sequence is transcoded but the title is not transcoded.

Workaround: Recreate the title in the new resolution or reimport the original matte key.

Bug Number: UDevC00025855. Creating subclips - After you drag a clip to a local bin from the Interplay Window, you cannot use the simple drag-and-drop method to create a subclip. The simple drag-and-drop method involves loading the clip into the monitor and then dragging it from the monitor to the bin.

Workaround: Alt+drag the clip from the monitor to the bin or use the Subclip button.
➤ **Bug Number:** UDevC00036994. Deleting media from a master clip might not update the online/offline status of the associated group clips or subclips in Interplay Access.

**Workaround:** Return to the Avid editing application bin and check the group clip in to Interplay Access again by dragging it into the Interplay Window.

➤ **Bug Number:** UDevC00021148. When you search for non-alphabetic characters in clip names in the Interplay Window of an Avid editing application, the search results might not be accurate.

**Workaround:** Searching in Interplay Access finds the non-alphabetic characters correctly.

➤ **Bug Number:** UDevC00024672. If you drag an unnamed clip into the Interplay Window in an Avid editing application, the clip might appear in the Interplay Window with no name or with its original name and might appear in Interplay Access with a numeric name.

**Workaround:** Name clips before you drag them into the Interplay Window.

➤ **Bug Number:** UDevC00052609. Editing apps If you import a graphic from your local drive into a project in an Avid editing application, change the original name of the clip to a name of your choice, and check that clip into a folder in the Interplay Window, the new name does not appear in the Interplay Window even when you refresh the window. You see only the original name.

➤ **Bug Number:** UDEV00217606 UDevC00023944 Editing Apps. In the Avid editing application, the Record Track monitor buttons might be deselected if the following happens:

1. On System 1, you create a sequence and check it into a folder in the Interplay Window.
2. On System 2, you check out the sequence and load it into the Timeline.
3. On System 1, you edit the sequence and check it into the Interplay folder again.
4. On System 2, you refresh the Interplay window then check out the same sequence again.

**Workaround:** Select the Record Track buttons again.

➤ **Bug Number:** UDEV00216346 UDevC00023435 Editing Apps. If you consolidate a MultiRez master clip at a particular resolution, and either drag it into the Interplay Window or check it into Interplay Access, it might be available at only the resolution you had set when you consolidated the clip.

➤ **Bug Number:**. The Avid editing applications might encounter the following errors using AVX™ plug-ins:

- Running out of memory with AVX plug-ins
- Check-in and check-out errors with sequences containing AVX plug-ins
- Unable to render AVX plug-ins
Limitations

➤ **Bug Number:** UDEV00215167 UDevC00023009 (as designed). Avid editing application: The OMF® option is not available in the Media Creation settings on a system that is part of an Avid Interplay environment.

**Edit While Capture (Frame Chase Editing)**

➤ **Bug Number:** UDevC00086768. You may see the following error message when loading a clip captured by Frame Chase capture in the editor:

“Error encountered during relink process: New track length does not equal original track length.”

**Workaround:** In the editing application, right click the clip and sequence and select Update from Interplay. In Assist, refresh the clip from the Interplay database by selecting the clip and pressing F5.

➤ **Bug Number:** UDevC00080038. When you perform a Frame Chase capture of a DNxHD 45 clip, the master clip displays incorrectly in Interplay Access as 1080 36.

**Workaround:** The clip is still useful as DNxHD 45. Subclips created from the masterclip show as DNxHD 45. The clips show the correct resolution in the Avid editing application.

➤ **Bug Number:** . You cannot perform a Send to Playback operation while capturing from AirSPACE.

**Workaround:** Wait until the capture is complete and then do the Send to Playback.

➤ **Bug Number:** UDevC00035776. Frame Chase Editing: The system returns a Disk Space Error if you attempt to perform a workgroup transfer on a sequence that contains a clip that is currently being captured.

**Workaround:** Wait until the system finishes capturing the clip, and then perform the workgroup transfer operation.

For more information on Frame Chase Editing, see the *Avid Interplay Transfer ReadMe*.

**Folder Limitations for the Interplay Database**

➤ **Bug Number:** none. It is important that you do not store more than 20,000 assets in Interplay database folders. In general, you can keep up to 5,000 assets in a folder without affecting system performance. One of the problems with storing many assets in a folder is the amount of time it takes to list the items in the folder when you open the folder for browsing.
Periodically check that folders do not contain more than 5,000 assets. Delete or move assets to other folders. If a folder must contain a large number of assets it is more efficient to add multiple subfolders for storing the assets. For additional information, see see the Best Practices Guide.

This limitation also applies to ingest folders. If you know that you will have recurring ingests, you could set up folders for those ingests. For example, you could name folders for the days of the week or for specific types of ingest.

**Film Projects**

➤ **Bug Number:** UDEVC00080131. Media Services Transcode does not support progressive film resolutions.

**Workaround:** Use the Consolidate/Transcode command in the Avid editing application.

*You can use Media Services Transcode to transcode progressive HD resolutions 720p and 59.94. Those are not film resolutions.*

➤ **Bug Number:** UDevC00025645. Editing Apps In a film project, if you capture a clip at one resolution and then try to batch capture it at a different resolution, the media is not deleted and the clip links to only one resolution (dynamic relink is not available for film projects). This can cause orphan media files.

➤ **Bug Number:** UDevC00083571. If you have film projects and non-film projects on the same Interplay database, do not check film clips into the non-film projects. For example, the following scenario causes problems:

1. Check a film clip that contains audio and video into an 23.976 NTSC project.
2. Check the clip out and then check it into a 23.976 NTSC 35mm 4 perf project.
3. Check the clip out to the film project.

In this scenario, the system strips away the video.

**Importing File Assets**

➤ **Bug Number:** UDevC00038006. If you check a Marquee™ Settings File (*.mqp) and/or an Image File (e.g., PNG, JPG, PCT, TIFF, PSD) into Avid Interplay Access, you can’t drag the newly created asset into a bin.
**Limitations**

**Workaround:** Do the following:

1. Select the graphics file in Interplay Access and then select Get Latest from the context menu. The file is copied to the working path on the local drive.

2. Use the Avid editing system's Import feature to import the graphic from the working path.

For more information, see the *Avid Interplay Access User's Guide*.

**Media Indexer**

- **Bug Number:** For important installation information, see “Increased Monitoring Capacity for Media Indexer” on page 35.

- **Bug Number:** UDevC00085031. Assist: If you start Interplay Assist while the Media Indexer that monitors shared storage is not available, Assist displays the following error message:

  A program error has occurred. If you need assistance, record the following information and call Avid customer support: Error assertion failed m_pointer.

**Workaround:** Make sure that the Media Indexer is online and correctly identified in the Interplay Administration tool Server Hostname Settings view. Then restart Interplay Assist.

- **Bug Number:** UDevC00017894 as designed. Media Indexers that are part of a redundancy group must all be on the same subnet or VLAN. You can use the Service Framework Unicast Discovery feature to communicate with Media Indexers on different subnets or VLANs. However, if the Media Indexers are part of a redundancy group, they must be on the same subnet or VLAN. See the *Interplay Software Installation and Configuration Guide* for details on Unicast Discovery.

**Migration from MediaManager to Interplay**

The MediaManager to Interplay Migration tools and related documentation are available on a separate CD. See your Avid representative for more information.

- **Bug Number:** UDevC00040002 as designed. Some master clips and subclips imported from a MediaManager environment (also known as Workgroup 4) might appear offline or partially offline.

**Workaround:** Open an Avid editing application, locate the clips in the Interplay Window, and drag the clips to a bin. Then check the files back into the Interplay Window. The clips should now appear online.
**MultiRez**

- **Bug Number:** The following features are not available for this release:
  - Multirez relink by tape name and key number.
  - Multirez support for pre-Interplay precomputes. This means that if you bring existing sequences into an Interplay environment, you must rerender effects.
  - Media files created by rendering effects (precomputes) are not dynamically relinked. If you render effects when they are linked to target settings and then switch back to working settings, the rendered effects will be lost. You can create effects in either mode, but render them only when they are linked to target settings as the last step before output. Render effects in the target resolution only as the last step before output.

**Send to Playback**

- **Bug Number:** UDevC00058307 Limitation. When you send media to playback, the Send to Playback dialog box lists two separate bit depth settings: the Target Audio Resolution Bit Depth in the Relink Settings (Input) area, and the Bit Depth in the Audio Mix Settings (Output) area. The Relink Settings indicate the audio bit depth of your target resolution as set in the Interplay Administrator. The Audio Mix Settings match the bit depth settings of your playback device. Since the audio bit depth used by your media must match the bit depth settings of your playback device, your audio bit depth might be converted twice during the send-to-playback operation, first to the bit depth of your target resolution and then to the bit depth of your playback device.

  For additional limitations and information on Sending to Playback, search for “playback” in this Readme. Also see the Assist ReadMe and the Interplay Transfer ReadMe.

**Send to Workgroup**

- **Bug Number:** UDevC00081706 Limitation. MediaManager to Interplay Transfer: To perform transfers from a MediaManager workgroup to an Interplay v1.1.x environment, you must have MediaManager v4.5.12 or later and the related software versions (referred to as Bundle 10a).

  **Workaround:** On MediaManager v4.5.10 (Bundle 9), you can use the Avid editing applications to perform the transfer. You can’t use Interplay Access to perform the transfer on MediaManager v4.5.10.

- **Bug Number:** UDevC00020533 Limitation. If you select multiple items to transfer to another workgroup, the system might perform more transfers than you expect. For example, if you select three clips and each has two resolutions online, the system performs 6 transfers, one for each resolution.
Workaround: Use the resolution bin columns in the Avid editing application so you can tell how many resolutions are online for clips that you want to transfer. Then you can select all of the clips that you want to transfer at a particular set of resolutions. When you transfer multiple clips in this way, the system displays a dialog box that allows you to choose the resolutions that you want to transfer. If you have performed a lot of transcode or redigitize operations, there might be a large number of resolutions associated with a particular master clip.